4024 Series Spectrum Analyzer

User Manual

4024 Series Spectrum Analyzer

User Manual
AV2.731.1075SSCN

Environment and Safety Instructions

Environment and Safety Instructions
I. Safety Protection
1. Safety precautions for the instrument
1) Adopt designated packing container during handling, prevent instrument from falling down or fierce
collision which may result in damage;
2) Please do use the AC-DC adapter provided accompanying the instrument for power supply, or improper
power adapter will cause damage to the instrument.
3) Supply power to instrument with 220V AC three-core stabilized voltage power, prevent damaging
interior hardware due to high power spike pulse interference;
4) Ensure the good grounding of power supply as poor or wrong grounding may cause damage to the
instrument.
5) Take anti-electrostatic measures in operation, such as anti-electrostatic straps, to prevent electrostatic
damage to this instrument.
6) The DC signal above 16V and signal power above 30dBm are prohibited; otherwise, this instrument
may be damaged.
7) The battery used for powering up this instrument or installed in this instrument should be replaced with
one of the same type or recommended equivalent type; otherwise, explosion may occur.
8) It is not allowed to insert any solids into the instrument from opening of shell or pour any fluids into
inside or outside of shell to prevent interior short circuit and/or electric shock, fire or personal injury.
9) To prevent this instrument from overheating, the slot or opening for internal ventilation must not be
covered. It is prohibited to place the instrument in sofa, blanket or closed housing unless there is good
ventilation.
10) It is prohibited to place this product onto heating equipment such as the heater or heating fan. The
ambient temperature must not exceed the maximum temperature specified in this manual.
11) It is notable that when the instrument is in fire, toxic gas or liquid harmful to human being may be
released.

2. Safety precautions for other instrument & equipment
1) Check the working condition and turn off RF output before connecting the instrument, otherwise it may
output high power signal to damage the equipment to be tested;
2) The output power may be high in the self-test of this instrument. Please disconnect all external devices.
3) If the fault alarm is sent in operation of the spectrum analyzer, reminding the user of status anomaly,
you should turn off the RF switch or power switch and disconnect all external devices, so as to prevent the
influence on the tested equipment.

3. Personal safety precautions
1) It is requested to handle the instrument and packing container with proper tools and put them down
gently to prevent from personal injury due to instrument falling.
2) Ensure that the power supply is well grounded, as poor or wrong grounding may result in personal
injuries.
3) Get the instrument cut off before wiping to prevent electric shock; only wipe the outside of the
instrument with dry or slightly wet soft cloth other than the inside.
4) Instrument operator should have received special training before using the product and should be highly
focused during the using process. This instrument must be operated by physically and mentally appropriate
person. Otherwise, person injury or property loss may be caused.
5) This instrument has potential risks of microwave radiation in the high-power status. Please take
corresponding anti-radiation measures.
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6) Prohibit using the instrument if the power line is found damaged. The power line should be checked on a
regular basis. Take safety precautions appropriately and place power line properly to ensure the power line
will not be damaged and personnel will not stumble over the power line or be shocked by electricity.
7) Prohibit using the instrumention open air in disastrous weather such as lightening to avoid damage to
instrument and human being.
8) It is not allowed to insert any solids into the instrument from opening of shell or pour any fluids into
inside or outside of shell to prevent interior short circuit and/or electric shock, fire or personal injury.
9) Similar to other industrial products, allergic materials (allergens such as aluminum) are unavoidable.
Once allergic reactions (such as rash, repeated sneezing, eye irritation or dyspnea) are detected, see a
doctor immediately and find out the reason. Note that toxic gas or liquid that is harmful to the human body
may be released once the instrument is on fire. In this case, the reasonable fire extinguishing measures
should be taken or the instrument should be taken away from the operation station.
10) The electromagnetic compatibility of the instrument conforms to the requirements of the specifications.
However, electromagnetic radiation may occur to some degree. The operator should check whether there
are special people vulnerable to such radiation in the working environment. If required, appropriate
measures should be taken to avoid hazards.
11) The instrument must be opened by the authorized personnel. The instrument should be powered off
before it is opened or operated in other way. Instrument adjustment, part replacement, maintenance and
repair must be done by the technical personnel of the manufacturer. Parts related to the safety must be
replaced with original parts.

II. Environmental Protection
1. Disposal of packing container
We are sure that pack container of products is harmless waste, please save packing container and liner for
future transportation or dispose them according to local environmental regulations.

2. Treatment of scrapped articles
1) The parts replaced in repair or upgrading should be recycled or dealt with by China Electronics
Technology Instruments Co., Ltd. The scrapped instrument must not be discarded or treated without
permission. Please notify China Electronics Technology Instruments or professional recycling units with
qualifications to recycle or deal with the scrapped instrument.
2) If required, the internal battery may not be discarded without permission after replacement. It should be
separately recycled as chemical waste.
Unless otherwise specified, the above-mentioned operations should abide by Regulations on Recovery
Processing of Waste Electrical and Electronic Products and local environmental laws and regulations.

Foreword

Statement:

This manual is the fourth version of the User Manual of 4024 Series Spectrum
Analyzer.
The information contained in this User Manual is subject to change without
prior notice.
China Electronics Technology Instruments reserves the right of final
interpretation for the contents and terms used in this Manual.
Our company owns the copyright of this Manual. Without prior approval of it,
any unit or individual shall not modify or tamper the content of this Manual, or
reproduce or transmit this Manual for profit. Otherwise, China Electronics
Technology Instruments shall reserve the right to investigate legal liability
against the copyright infringer.

Thank you for choosing 4024 series spectrum analyzers developed and produced by China Electronics
Technology Instruments Co., Ltd.
We take customer demands as our own duty, providing you high-quality measuring instrument and the best
after-sales service. We always adhere to the business philosophy of "superior quality and considerate
service", and are committed to offering satisfactory products and service for our clients. Please contact us
according to the following information:

This manual introduces the purpose, operation method, operation precautions, performance characteristics,
basic operation principle and fault query of the 4024 series spectrum analyzer developed and produced by
China Electronics Technology Instruments Co., so as to help you to get familiar with and master the
operation method and key operation points as soon as possible. In order to skillfully operate this instrument,
please carefully read this manual and properly follow the guidance during operation.
The User Manual includes 13 chapters:
Chapter I briefly introduces the basic information of 4024 series spectrum analyzer, including main
technical characteristics, available or achievable functions and achievable technical specifications.
Chapter II to XI mainly describes the operating instructions. Chapter II describes what should be done after
receiving one new spectrum analyzer and what should be noted in operation. Chapter III mainly introduces
the front panel and external interfaces of the spectrum analyzer. Chapter IV introduces the spectrum
analysis measurement mode; Chapter V introduces the interference analysis measurement mode (optional);
Chapter VI introduces the power measurement mode (optional); Chapter VII introduces the analog
demodulation measurement mode (optional); Chapter VIII introduces the channel scanning measurement
mode (optional); Chapter IX introduces the field strength measurement mode (optional). Chapter X
introduces the Signal Analyzer mode (optional); Chapter XI and XII describe technical specifications. They
briefly describe the working principle of 4024 series spectrum analyzer, and provide the performance
characteristic test method of the main technical specifications.
Chapter XIII describes the maintenance requirements: Including the steps to query faults, error description
and repair procedures.
Due to our limited knowledge, there may be some omissions or errors, and you are welcome to correct any

error. We are sorry for the flaws which may cause your inconvenience.
Editor
Sep. 2018
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Chapter I Overview
The following safety notes are used throughout this manual. Familiarize yourself with each of the notes and
its meaning before operating this instrument.
“Warning” indicates danger. It reminds the user to pay attention to a certain
operation process, operation method or similar situations. Noncompliance with the

! Warning

rules or improper operation may result in personal injuries. You shall fully
understand and meet all the conditions in the warning before proceeding to the next
step.

“Attention” indicates important prompts and no danger. It reminds the user to pay
attention to a certain operation process, operation method or similar situations.

Caution

Noncompliance with the rules or improper operations may result in damage to the
instrument or loss of important data. You shall fully understand and meet all the
conditions in the caution before proceeding to the next step.
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Section 1 Product Overview
1.1.1 Brief Introduction
4024 series spectrum analyzer has the advantages of broad operating band, high performance specifications,
high sweeping speed, multiple test functions, easy operation, etc. From the perspective of performance
specifications, this instrument has low average noise level, low phase noise and high scanning speed. From
the perspective of measurement functions, this instrument has various measurement modes such as
spectrum analysis, interference analysis, analog demodulation, power measurement, channel scanning and
field strength measurement and various intelligent measurement functions such as the channel power,
occupied bandwidth, adjacent channel power, tune listening, emission mask and C/N. Due to integration of
the 8.4-inch LCD and capacitive touch screen, the display definition and operational convenience are
improved. This instrument has a small and light structure, and can be flexibly powered up and easily
operation. Therefore, this instrument is applicable to field operation. The appearance is shown in Fig. 1-1.

Fig. 1-1 4024 Series Spectrum Analyzer

1.1.2 Product features
Based on the highly integrated, modular and standardized design, 4024 series spectrum analyzer has
excellent performance, with main characteristics as follows:
 Broad frequency coverage: 4 models from 9kHz to 44GHz;
 Low average noise level: -157dBm@1Hz RBW;
 Excellent phase noise performance: -106dBm/Hz@100kHz; offset: @1GHz carrier;
 High sweeping speed: Minimum sweeping time within 1GHz span: <20ms;
 Resolution bandwidth: 1Hz~10MHz;
 Tracking Generator:4GHz,6.5GHz,9GHz;
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Full-band pre-amplifier: Standard configuration;
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 Various measurement modes: Spectrum analysis, interference analysis (spectrogram and RSSI),
analog demodulation (AM/FM/PM), channel scanning, high-precision USB power measurement, field
strength measurement, etc.
 Various intelligent measurement functions: Field strength measurement, channel power, occupied
bandwidth, adjacent channel power, audio demodulation, carrier-noise ratio, emission mask, IQ
capture, etc.
 Various auxiliary test interfaces: 10MHz reference input/output interface, GPS antenna interface,
zero-span IF output interface, external trigger input interface, etc.
 Convenient and fast user operation experience: 8.4-inch large-screen high-brightness LCD, large-font
display, convenient capacitive touch screen, LCD and touch screen integration, various display modes,
automatic adjustment of backlight brightness, etc.
 Operating temperature range: -10°C to 50°C this instrument can be powered up with the battery or
adapter.

1.1.3 Functions
4024 series spectrum analyzer has a wide range of measurement functions, mainly including:
 Spectrum analysis, used for basic spectrum analysis of signals, including various intelligent
measurement functions such as the field strength measurement, channel power, occupied bandwidth,
adjacent channel power, emission mask, carrier-noise ratio, audio demodulation and IQ capture;


Listing scanning (optional), used for continuous scanning measurement of multiple bands;



Interference analysis (optional), including spectrogram and RSSI measurement;



Analog demodulation, used for analysis of modulation characteristics of AM/FM/PM signals;



Power measurement, used for high-precision power measurement of the USB interface;



Channel scanning (optional), used for signal power measurement of multiple channels or frequencies;



Field strength measurement (optional), used for CW measurement, frequency scanning measurement
and list scanning measurement;



GPS positioning (optional), realized with the external GPS antenna;



Zero-span IF output (optional), used for output of the IF output interface under zero span;



Tracking Generator(optional),used for output of Generator or Tracking Generator.

1.1.4 Typical application
■ On-site comprehensive performance evaluation of electronic weapon equipment
4024 series spectrum analyzer has the advantages of broad operating band, high performance specifications,
high sweeping speed, multiple test functions, easy operation, etc. In addition, this handheld instrument is
small and light and can be powered up with the battery. Therefore, this instrument can be applied in on-site
installation/commissioning and maintenance/guarantee of various kinds of electronic weapon equipment
such as the radar, communication, electronic countermeasures and reconnaissance and precision guidance.

■ On-site testing and diagnosis of transmitter and receiver
3
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4024 series spectrum analyzer has various measurement modes such as the spectrum analysis, interference
analysis, analog demodulation, power measurement, channel scanning and field strength measurement, and
various intelligent measurement functions such as the channel power, occupied bandwidth, adjacent
channel power, C/N, field strength and emission mask. Therefore, it can be used for comprehensive
spectrum analysis and diagnosis services in on-site testing of transmitters and receivers.

■ Broadband spectrum monitoring and interference identification
4024 series spectrum analyzer can be applied with the external directional antenna in electromagnetic
environment detection, radio interference analysis, electromagnetic environment background evaluation,
spectrum monitoring, identification of illegal channel interference signals, etc.

4
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Section 2 Main Technical Specifications
Technical specifications of 4024 series instruments have been strictly tested before delivery. The user may
test and verify such instruments according to the technical specifications in this manual. Refer to Table 1-1
for main technical specifications of 4024 series.
4024 series spectrum analyzer comply with various performance indicator
requirements within the given operating temperature range after 2h storage and
30min warm-up under the ambient temperature.

Caution

Supplementary features in the form of typical value are only for reference but
not assessment.
Table 1-1 Technical Specifications of 4024 Series Spectrum Analyzer
Inspection items
Model

Frequency range

Frequency reference

Sweep time
Frequency readout accuracy
Frequency span

Indicator requirement
4024A/B/C/D/E/F/G
4024A：9kHz～4GHz
4024B：9kHz～6.5GHz
4024C：9kHz～9GHz
4024D：9kHz～20GHz
4024E：9kHz～26.5GHz
4024F：9kHz～32GHz
4024G：9kHz～44GHz
Nominal frequency:
10MHz
Frequency reference error: (Last calibration date × aging rate +
temperature stability + calibration accuracy)
Aging rate: 5 10-7/year
Temperature stability:
110-7(-10°C  50°C, relative to 255°C)
Initial calibration accuracy: 310-7
Note: The default time elapsed since the last calibration date is one year.
Range: 10μs~600s (Zero Span)
Accuracy: ±2.00% (Zero Span)
(Frequency reading × frequency reference error + 2% × span + 10% ×
resolution bandwidth)
Range: 100Hz～upper frequency limit of corresponding model or 0Hz
Accuracy: ±2.0%

Resolution Bandwidth

Range: 1Hz~10MHz (step by 1-3)

Video Bandwidth

Range: 1Hz~10MHz (step by 1-3)

Single-sideband phase noise
(Carrier wave 1GHz, 20℃
~30℃)

Display average noise level (50Ω
load at the input end, 0dB input
attenuation, average detector
mode, logarithmic Video Type,
RBW normalization to 1Hz,
20-30°C, tracking Generator off)

4024A/B/C：
≤-108dBc/Hz@10kHz Offset
≤-112dBc/Hz@100kHz Offset
≤-118dBc/Hz@1MHz Offset
≤-129dBc/Hz@10MHz Offset

4024D/E/F/G：
≤-102dBm/Hz@10kHz Offset
≤-106dBm/Hz@100kHz Offset
≤-111dBm/Hz@1MHz Offset
≤-123dBm/Hz@10MHz Offset

Preamp off:
≤-138dBm（10MHz～20GHz） ≤-135dBm（20GHz～32GHz）
≤-127dBm（32GHz～40GHz） ≤-120dBm（40GHz～44GHz）
Preamp on:
≤-157dBm（10MHz～20GHz）
≤-154dBm（20GHz～32GHz）
≤-148dBm（32GHz～40GHz）
≤-140dBm（40GHz～44GHz）

5

Chapter I Overview

Total level uncertainty
(frequency range
10MHz~40GHz, input signal 0
dBm~-50dBm, all settings are
auto couple, 20°C ~30°C)
Second harmonic distortion
(attenuation: 0dB; input signal:
-30dBm)
3-order intermodulation
distortion
(-15dBm double-tone signal,
100kHz spacing, 0dB
attenuation, pre-amplifier off)
1dB gain compression
(Double-tone test, 10MHz signal
spacing)
Image response, multiple
response and out-of-band
response.
(mixer level: -10dBm)

Residual response
(RF input match, 0dB
attenuation, tracking Generator
off)

Scale fidelity
Input attenuator

Maximum safety input level

±1.80dB（10MHz~13GHz）
±2.30dB（13GHz～40GHz）

4024A/B/C：
<-65dBc

4024D/E/F/G：
<-60dBc

4024A/B/C：
≥+10dBm

50MHz~9GHz

4024D/E/F/G：
≥+7dBm
≥+6dBm
≥+6dBm

50MHz~9GHz

4024D/E/F/G：
≥-2dBm
50MHz~4GHz
≥-3dBm
4GHz~13GHz
≥-3dBm
13GHz~44GHz

4024A/B/C：
≥+2dBm

≤-65dBc
≤-60dBc

50MHz~4GHz
4GHz~13GHz
13GHz~44GHz

10MHz~20GHz
20GHz~44GHz

4024A/B/C：
(exceptional frequency: 3200MHz)
Preamp on:
≤-95dBm (10MHz～9GHz)
Preamp off:
≤-82dBm (10MHz～9GHz)

4024D/E/F/G：
(exceptional frequency: 3200MHz)
Preamp on:
≤-100dBm (10MHz～20GHz)
≤-95dBm (20GHz～44GHz)
Preamp off:
≤-90dBm (10MHz～13GHz)
≤-85dBm (13GHz～20GHz)
≤-80dBm (20GHz～44GHz)

±1.00dB
4024A/B/C:
Scope of attenuation 0dB~30dB,
5dB step
Conversion uncertainty: ±1.20dB
4024A/B/C:
+27dBm, typical value (≥10dB
attenuation, pre-amplifier off)
+20dBm, typical value (<10dB
attenuation, pre-amplifier off)
+10dBm, typical value
(pre-amplifier on)

4024D/E/F/G:
Scope of attenuation 0dB~50dB,
10dB step
Conversion uncertainty: ±1.20dB
4024D/E/F/G:
+30dBm, typical value (≥10dB
attenuation, pre-amplifier off)
+23dBm, typical value (<10dB
attenuation, pre-amplifier off)
+13dBm, typical value
(pre-amplifier on)

Range:
Reference level

Display scale

Tracking
Generator
(Option)
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Frequency
Range
Amplitude
Range
Minimum
Amplitude Step
Amplitude
Accuracy

logarithmic type: -120dBm~+30dBm 1dB step
linear type: 22.36uV~7.07 V，0.1% step
Conversion uncertainty: ±1.20dB (reference level 0dBm~-60dBm)
Logarithm scale 0.1~10dB per scale, 0.1dB step minimum (10-scale
display)
Linear scale: 10 scale display
Scale unit: V, A, W, dBm, dBW, dBV, dBmV, dBuV, dBA, dBmA, dBuA
4024A：100kHz~4GHz
4024C：100kHz~9GHz

4024B：100kHz~6.5GHz

0dBm~-40dBm
0.1dB
±2.50dB （ Frequency

Range

10MHz~9GHz,

Amplitude

Range
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0dBm~-40dBm ,20℃~30℃）

Sideband Noise

1GHz frequency point，0dBm output:
≤-90dBc/Hz@10kHz frequency offset
≤-95dBc/Hz@100kHz frequency offset
≤-110dBc/Hz@1MHz frequency offset
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Chapter II Operation Guide
Section 1 Unpacking Inspection
2.1.1 Model confirmation
You’ll find the following items after unpacking the carton:
a) 4024 Series Spectrum Analyzer

1 pcs

b) Power adapter

1

c) Three-core power line

1 pcs

d) Quick Operation Guide

1

e) USB cable

1 pcs

f) Built-in rechargeable lithium ion battery

1

g) Product certificate

1

h) Options

Several

i) Packing list

1

Please check the articles above against the order contract and packing list. If you have any questions, please
contact us in line with the contact information in Preface or contact the business center of our company,
we'll tackle problems as soon as possible.

Caution

The instrument is a kind of valuable device and should be handled with care.

2.1.2 Appearance inspection
Checks if instrument is damaged during transportation, if any obvious damage is detected, don’t power it
up. Contact our business center according to the contact information in the foreword. We'll repair or replace
the instrument immediately depending on the situation.

Section 2 Safety Instructions
The safety performance of 4024 series spectrum analyzer complies with the requirements of
GJB3947A-2009. This instrument contains no part to be operated by the user. The instrument shell must not
be opened without permission; otherwise, personal injury may be caused. In order to protect your safety
and properly operate this instrument, please carefully the following safety instruments before operation.

2.2.1 Environmental requirements
In order to guarantee the service life and measurement validity and accuracy, 4024 series should be tested
under the following environmental conditions.
 Temperature range:
10
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Storage temperature range: -40°C to +70°C
Operating temperature range: -10°C to +50°C
Operating temperature range of power supply by Li-ion battery：0℃～+45℃
As the battery storage temperature range is -20°C to 60°C, the battery must
not work continuously in a long time at high temperature, so as to avoid risks

! Warning

arising from high temperature. It is recommended to use the adapter to supply
power.

 Low air pressure:
Low air pressure (altitude): 0-4600m

2.2.2 Selection of power line
4024 series spectrum analyzer is equipped with the three-core power line conforming to international safety
standards. The power line should be inserted into the appropriate power socket with the protective ground
wire so as to make the instrument shell grounded during operation. It is recommended to use the power line
provided with this instrument. The power line should be replaced with one 250V/10A power line of the
same type.

2.2.3 Power supply requirements
4024 series can be powered up in three methods:
 AC power supply and power supply with adapter
The accompanying AC-DC adapter must be used for AC power supply. The adapter input should be
100-240V 50/60Hz AC power.
The AC-DC adapter must not be connected to the test instrument in order to prevent the instrument from
overheating when transported and carried with a knapsack. The voltage input range of the AC-DC adapter
is relatively wide, so you must ensure that the power voltage is within the range specified in Table 2-1
during operation.
The working voltage and frequency ranges are subject to the parameters

Caution

provided on the nameplate of the power adapter.
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Table 2-1 Power Supply Requirements
Power supply parameter

Applicable range

Input voltage

100V-240VAC

Rated input currency

1.7A

Work frequency

50/60Hz

Output Voltage/Current

15.0V/4.0A

 DC power supply
Voltage: 15V
Current: 3A (min.)
 Power supply with built-in battery
4024 series instruments can be powered up with the rechargeable lithium ion battery. The battery will
discharge if it is not used for a long time. Therefore, the battery must be recharged before use. Refer to
Section 3 for battery operation details. Basic parameters of accompanying battery are as follows:
Nominal voltage: 10.8V
Nominal capacity: 7800mAh
The rechargeable battery must not be exposed to fire or high-temperature
environments (above 70°C), or placed in fresh water or salt water, or made
wet. It must be kept away from children.

Caution

The rechargeable battery is reusable and should be stored in proper
container to avoid short circuit. Heavy metals such as nickel and
chromium in the battery can pollute natural environment. Waste battery
shall not be discarded but shall be put into a special battery recycle box.

2.2.4 Electrostatic protection (ESD)
Static electricity is highly destructive to electronic components and equipment, so this instrument must be
powered up on the anti-static table. Attention should be paid to electrostatic protection when using the
device. If condition permits, the following electrostatic protection measures may be taken:
a) Make sure all the instruments are correctly grounded to prevent static generation.
b) The staff must wear anti-static wrist straps before contact with connectors or core wires or any assembly.
c) The center conductor must be grounded before the cable is connected to the instrument in the test. This
can be realized through the following steps: Connect a short-circuiter to one end of the cable to realize
short circuit between the central conductor and outer conductor of the cable. When wearing an anti-static
12
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wrist band, hold on to the casing of the cable connector and connect the casing to the other end of the cable
before removing the short-circuiter.

2.2.5 Input/output port protection
The standard impedance of the RF port of 4024 series spectrum analyzer is 50Ω. Therefore, the appropriate
load impedance for the test signal or port should be applied in strict accordance with the port requirements
during operation, so as to prevent subsequent circuits from damage.

The RF input end of the spectrum analyzer has the requirements for

! Warning

maximum allowable input level. The applied signal must not exceed
the limits; otherwise, this instrument may be damaged.

2.2.6 Cleaning of display of front panel
If required after operation of certain time, the display panel of the instrument can be cleaned according to
the following steps.
a) Shut down the instrument and disconnect the power line.
b) Wipe display panel with clean and soft cotton cloth with detergent.
c) Dry display panel with clean and soft cotton cloth.
d) Do not connect power line until detergent dries out.
There is anti-static coating on display surface, do not use fluoride-bearing

Caution

detergent or acidic/alkaline detergent. Do not spray detergent on display
panel directly, otherwise it may penetrate into and damage the instrument.
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Section 3 Battery Installation and Replacement
2.3.1 Battery description
4024 series spectrum analyzer is equipped with one large-capacity rechargeable lithium ion battery, with
the endurance of about 2.5h. In order to facilitate the long-time field test and prevent the test interruption
caused by insufficient battery capacity, the user may purchase the standby battery. It is recommended to
purchase one of the same model as that provided along with the instrument.

To guarantee service life of the battery, the battery should be removed
from battery holder during the transportation and long-time storage,and try

Caution

not to make the battery power less than 5%,otherwise the battery may not
be able to charge.

2.3.2 Battery installation and replacement
The battery of 4024 series spectrum analyzer can be installed or replaced easily. The user may install or
replace it according to the requirements in Fig. 2-1.

Remove the battery cover

Install the battery cover

Remove the battery

Insert the battery

Fig. 2-1Battery Installation and Replacement Steps

2.3.3 Battery status check
4024 series spectrum analyzer is provided with one battery, of which the standby time is 2.5h under
full-capacity conditions.
The user can view the battery status in the following methods:
14
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Observe the battery icon on the system status bar to roughly know the battery capacity. If only 15%
exists in the battery icon, replace or charge the battery promptly.
 Take out the battery and press the button on the white point at the tail end of the battery. Then the
indicator above the button will be ON, showing the current residual capacity. If only one indicator is ON,
the battery should be charged promptly.

2.3.4. Battery charging

Caution

The power indicator is located in the yellow power ON key.

The battery can be charged when 4024 series spectrum analyzer is OFF or operating. Charging steps:
a) Install the battery to be charged into the machine.
b) Connect the external power supply with the accompanying AC-DC adapter.
c) If the battery is charged in the OFF state, the power indicator in the left lower corner of the front panel
will be yellow and flicker, indicating that the battery is being charged, and after the battery is fully charged,
the indicator will be yellow and normally on. If the battery is charged in the operating state, the power
indicator will be green and flicker, indicating that the battery is being charged, and after the battery is fully
charged, the indicator will be green and normally on. In this case, the battery icon on the right side of the
system status bar of the display will be full.
In addition, the battery power more than 5% should be charged for about 4h in the shutdown status.

Section 4 User Inspection
2.4.1 Start-up of spectrum analyzer
Connect 4024 series spectrum analyzer to the external power supply with the power adapter. Observe the
power indicator on the front panel. If the power indicator is yellow, it indicates that the standby power
supply is normal. Gently press the power switch on the front panel for more than 3s. Observe whether the
power indicator on the front panel turns green and whether the backlight of the display is ON. You should
wait for about 30s for start-up of the display. Then the normal start-up image will appear. The display
screen should include no warming prompt 10min after start warm-up.
Note: “Flicker” of the indicator indicates that the electricity quantity of the internal battery is not full and
the battery is being charged.

2.4.2 Shutdown of spectrum analyzer
Press the yellow power switch [

] in the left lower corner of the front panel for about 3s. The spectrum

analyzer will automatically exit the measurement application program, and the power supply will be shut
down.
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Section 1 Description of front panel
The front panel of 4024 series spectrum analyzer is shown below.
GPS antenna

10MHz reference input/output
IF Output

RF input
Photosensitive
hole
Loudspeaker

Trigger input

Numeric
keypad

Touchscreen
display area

Label display
area

Power button and
indicator

Function key

Reset key

Fig. 3-1 Front Panel
The keys on the front panel are shown in the [XXX] form in this manual,

Caution

where XXX is the key name; Bottom buttons on the touch screen are shown in
the [XXX] form, where XXX is the button name; and buttons of the right
menu are shown in the [XXX] form, where XXX is the menu name.

3.1.1 Display zone
4024 series spectrum analyzer is equipped with one 8.4-inch colorful touch screen. Parameter setting and
information display can be performed by means of touch, thus eliminating the troublesome soft and hard
key menu setting steps and greatly simplifying user operations.
The display zone shows the following information when different functions are active: multiple instrument
windows, in which various settings and measurement data are shown; operating status information; current
input data such as the frequency when required; current operating time of the system; and menu
information corresponding to the current valid operating window. Refer to Fig. 3-2 for the specific
introduction.
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Title

Time and date Signal standard and cursor GPS info

Trace display area

Power identification

Software
menu
display
area

Left
information
display

Bottom
function
key area

Bottom
information
display area

Fig. 3-2 Display Zone
The information display zone in the screen display zone of 4024 series spectrum analyzer shows various
settings and instrument statuses of the current measurement. Based on the information location on the
screen, the information display zone is divided into the top information display zone, marker, signal
standard and title display zone, left information display zone, measurement data display zone, soft key
menu display zone, bottom information display zone and bottom function buttons, 7 in total.
1) Top information display zone
The top information display zone in the top of the screen shows the system date/time and the current power
supply type, battery capacity and GPS status of the spectrum analysis in sequence from left to right.
Setting and modification of the system date and time: Press [System]→[Date/Time].
Modification of the date format: Press [System]→[Date format].
For the battery type and battery status indicator on the right side of the top information display zone,
various symbols are shown depending on the external power supply and battery capacity, the symbols
corresponding to various power supply modes of the spectrum analyzer are described as follows:
 If the spectrum analyzer with no battery is powered up with the external power supply, “

” will

be displayed;
 If the spectrum analyzer is powered up with the fully charged battery and no external power adapter is
connected, “

” will be displayed; and if the battery is fully charged and the external

power adapter is connected, “

” will be displayed. With the battery capacity decreasing

in operation, the green zone of the battery capacity symbol will decrease gradually.
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 If the spectrum analyzer with the battery is connected to the external power adapter but the battery
capacity is less than 100%, the battery will be charged, and the icon “

” will be

displayed.
 If the spectrum analyzer is not connected with any external power supply, and the battery capacity is
less than 20%, the battery is in the undervoltage state, and the icon “

” will be

displayed. In this case, the battery should be charged promptly. If the battery capacity is less than
10%, the spectrum analyzer may further operate for about 10min. In this case, measurement results
should be kept promptly. If the battery capacity is less than 5%, the spectrum analyzer will be shut
down automatically.
2) Marker, signal standard and title display zone
Press [System]→[Tip Off On], and the title information will be displayed in this zone.
Press 【Freq】→[Signal Std], and the current signal standard name will be displayed.
Press [Maker] or 【Peak】, and the frequency and amplitude information of the current active marker will be
displayed.
3) Measurement trace display zone
The measurement trace display zone shows measurement data. The contents displayed in this display zone
vary in different measurement modes.
4) Left information display zone
This information display zone on the left upper part of the screen shows the current measurement
information, such as the reference level, attenuator setting, display scale, resolution bandwidth, video
bandwidth and sweep time, which can be respectively set with corresponding function keys shown in the
table below.
Table 3-1 Functions of Left Display Zone in Spectrum Analysis Mode of 4024 Series
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Label

Description

Corresponding Functional Key

1

Reference level
0.0dBm

2

Attenuation
20dB

3

Scale/Division
10.0dB

4

Resolution Bandwidth
3MHz

5

Video Bandwidth
3MHz

6

Sweep time
441.000ms

7

Average

【BW】 →[Average Off On]

8

Detector
Auto

【BW】 →[Average Detector]

【Ampt】 →[Reference level]
【Ampt】 →[Atten Auto Man]
【Ampt】 →[Scale/Div]
【BW】 →[Res BW Auto Man]
【BW】 →[Video BW Auto

Man]

【 Sweep 】 →[Sweep time Auto
Man]
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5) Bottom information display zone
This information zone located at the bottom of the screen mainly includes two kinds of information:
Local: showing the current operating status of the spectrum analyzer: local or remote control.
The current center frequency and span information are displayed at the bottom of the screen. In the zero
span mode of the spectrum analyzer, the bottom information zone will display the following
information in sequence: starting time, center frequency and stop time.
6) Key menu display zone
In order to improve the operation flexibility of 4024 series spectrum analyzer and fully utilize the excellent
performance of the touch screen, the host software of 4024 series includes 8 gray touch keys on the right
side, of which the corresponding functions are directly displayed in the corresponding key zones.
7) Button function button zone
The bottom function button zone includes 6 function buttons, which have the same functions as hard keys
and are applied to display various menu names in different measurement modes so as to facilitate
measurement.

3.1.2 Number input zone
The number input zone includes the direction keys, knob, number keys, Backspace, Cancel and OK. All the
input can be modified by keys and knob in input area. Details of keys in input area are as below.
 Direction keys: The UP and DOWN key are applied to increase or decrease the value. The leftward
and rightward keys are not provided here. The step value of the UP and DOWN key is set according to
the step of each parameter.
Knob: Increase or decrease the value. When the knob is rotated clockwise, the value will be increased;
otherwise, the value will be decreased. The knob can be used with the UP/DOWN key to change the
value, with the same step as the UP/DOWN key.
 Numeric keys: Set the number (including the negative number).
 Backspace: Cancel the last number one by one according to the number status.
 Cancel: Cancel the current invalid data.
 OK: Confirm the current parameter setting.

3.1.3 Function key zone
The function key zone at the bottom of the screen is used for changing measurement parameter settings,
including six keys.
 【Freq】: Set the center frequency, starting/stop frequency, span, frequency step, etc. of measurement.
 【Ampt】: Set the reference level, attenuator setting, display scale, unit, pre-amplifier control, etc.
 【Bandwidth】: Set the resolution bandwidth, video bandwidth, detector type, average, etc. of
measurement.
 【Marker】: Set specific parameters of the measurement cursor.
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 【Peak】: Obtain the peak parameter.
 【Mode】: Set the measurement mode, including spectrum analysis, interference analysis, analog
demodulation, power measurement, channel scanning and field strength measurement.

3.1.4 Reset button
Press 【Preset】 to shut down the instrument and power up it again.

3.1.5 Power switch
Turn on /turn off the spectrum analyzer. When the instrument powered up with the external power supply
through the adapter is in the “Standby” state, the yellow indicator near the power switch will be ON. If the
power switch is pressed for more than 3s, the indicator will turn green, indicating that this instrument is
“operating”. When the power switch is pressed for more than 3s in the operating state, the spectrum
analyzer will be shut down.
Note: “Flicker” of the indicator indicates that the electricity quantity of the battery is not full at present and
the battery is being charged.
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Section 2 Interface Description
Peripheral interfaces of 4024 series are mainly concentrated on the top panel, as shown in Fig. 3-3,
and can be divided into three parts: power interface, test port and digital interface.
RF Out

External power
supply

USB

Mini USB

10MHz In/Out

RF In

LAN
interface

Headset
jack

Trig In

IF Out
GPS

SD card slot

Fig. 3-3 Interface Description

3.2.1 Power interface
The power interface of the device is for powering the device through DC output of AC-DC adapter or
through external DC power source. The conductor inside the external power interface is positive and the
external conductor is grounded.

3.2.2 Test ports
1.

RF input port: It is used for inputting the signal to be tested. The indicator of the test signal input port
of 4024 series is 50Ω. The N-type female port is applied for 4024D/E and 2.4mm male port for
4024F/G.

2.

RF Output port: This port is for signal output. 50Ω impedance, N-type female port, provided only
when customers need the tracking generator option.

3.

10MHz Input/Output port: This port is for connecting 10MHz signal of other devices as the reference
signal of the analyzer. It can also be used for outputting the internal 10MHz reference signal for other
devices.

4.

IF output port: Under zero span, this port can be used for outputting the IF signal for other devices
through software configuration.

5.

Trigger input port: The external triggering mode of 4024 series is available. The scope of trigger
source should be -5V~+5V when connecting the external trigger source to the trigger input port of the
Spectrum Analyzer. Rising edge trigger or fall edge trigger can be set by the software.

6.

GPS antenna port: This port can be use for connecting GPS antenna device for locating current
position of the Spectrum Analyzer.
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To better protect the Spectrum Analyzer, some identifiers are provided at the
test port of the device. The user must pay attention to the content on these

!

Warning

identifiers when using this device, in order to avoid any permanent damage to
the device.
Refer to 2.4 for details of instrument symbols in the figure.

3.2.3 Digital interface
1) Mini USB interface: It is used for connection of the external PC, which is used for program control or
data transmission of 4024 series through the program control commands or function library.

Caution

Equipment drive should be installed for connecting the device to PC through
USB interface for the first time.

2) USB A type interface: This interface is used for connecting USB peripheral equipment, such as USB
storage device, USB power detector.
3) LAN (network) interface: This 10/100Mbps network interface can be connected by the network cable
to the computer (PC), which is used for program control or data transmission of 4024 series through
the program control commands or function library.
4) SD card slot: This Micro SD card slot can bed used to extend the storage space of the device.
5) Headset jack: This is a standard headset jack for 3.5mm/3 line for audio output of FM/AM/SSB
demodulation. When a headset is not connected to this jack, the audio output will be realized through
the loudspeaker of the device. When a headset is connected to this jack, audio output will be
automatically switched from the loudspeaker to the headset.

3.2.4 Instrument symbols
Instrument symbols (warning labels) in the figure mean that the maximum power of the test port input is
+30dBm, and the maximum input DC level is 16VDC. When the device is in operation, the user is not
allowed to connect signal exceeding this range to the port. Otherwise, the device may be destroyed!
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Chapter IV Spectrum Analysis Mode
This chapter mainly introduces relevant information of the spectrum analysis mode of 4024 series spectrum
analyzer, including some typical measurement functions and methods, so that the user that operates this
instrument for the first time can have a general knowledge on some typical applications and test operations
of the spectrum analysis mode after reading this section and get familiar with the operation of this mode.

Caution

All operations in this chapter are based on the spectrum analysis mode and not
separately described below.

Due to rich measurement functions, the spectrum analysis mode of 4024 series includes a number of
complex parameters. In addition to basic functional parameters such as the frequency, amplitude,
bandwidth average, trace, sweeping and marker parameters, it also includes characteristic functional
parameters such as the signal track, noise marker, peak track, counter, list scanner, trigger, limit, field
strength measurement, channel power, occupied bandwidth, adjacent channel power, C/N, emission mask,
IQ capture, audio monitor, etc.
 Signal Track
If the drift signal is tested, the active marker should be placed onto the peak point of the signal by the signal
tracking function of the spectrum analyzer. In this case, the marker peak will always be displayed at the
center frequency of the spectrum analyzer, thus facilitating measurement.
 Noise marker
The noise marker displays the noise power at which noise near the active marker is normalized to the 1Hz
bandwidth. When the noise marker is enabled, the detector is set into the “RMS” mode, and the amplitude
unit is set as “Log” (dBm, dBmV, dBuV, dBW, dBV, dBA, dBmA, dBuA), the marker reading unit will
automatically change into dBm/Hz. When the amplitude unit is set as “Linear” (V, W, A), the marker
reading unit will automatically change into V(Hz)1/2 or W(Hz)1/2 or A(Hz)1/2.
 Peak Track
When the peak tracking function is enabled, the peak will be searched once by the marker after each
sweeping.
 Counter
When the frequency counter function is enabled, the marker reading will be made more accurate, which can
help to improve the accuracy of frequency measurement. The measurement accuracy is Class Hz, and the
error within 10Hz.
 List Scanner
The list scanner function supports the user to edit the scanning segment, and the spectrum analyzer will
scan the edited list based on the set frequency range and other parameters.
 Trigger
Select the trigger mode under “Sweep” or “Measure”, including [Free Run], [Video], [External], [Slope]
and [Delay]. The user can select the corresponding mode according to needs. When the previous single or
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continuous sweep finishes, the next sweep or measurement is automatically triggered. Set the trigger mode
as [Video]. When the positive slope part of input trigger signal passes through the video trigger level
determined by [Trigger Polarity Positive Negative], the sweep will be triggered. In the [external] trigger
mode, synchronize the “Sweep” or “Measure” with next voltage cycle.
 Limit
The limit function is applied to monitor signals within one band. The spectrum analyzer provides the upper
and lower limit. The user can set the limits. When the amplitude of one signal within one band is more than
the set upper limit or less than the set lower limit, the spectrum analyzer will send the alarm signal.
 Field strength measurement
The spectrum analyzer has the function of field strength measurement, including soft menus such as
[Field Strength Off On], [Recall Antenna], [Edit Antenna] and [Save Antenna]. The field strength can
be rapidly tested with such menus and corresponding test antennas.
 C/N
The C/N function is applied to measure the ratio of the carrier power to noise power, including the carrier
bandwidth, noise bandwidth, offset frequency, span, carrier power, noise power and C/N.
 Emission mask
The emission mask function is applied to recall the limit as the mask to measure whether the signal power
exceeds the mask limit. The mask parameter is one limit, the value of which is determined by means of
limit recalling. The mask can be moved right and left or up and down according to the center frequency and
reference power. In the mask, the limit center is always moved right and left to the center frequency, and
also moved up and down to the reference power point based on the calculated reference power. The
reference power is divided into the peak power and channel power, which are determined by the reference
power.
 IQ capture
The IQ capture function is applied to capture IQ data and save such data into the instrument based on the
capture time, sample rate and capture mode set by the user.
 Audio monitor
The spectrum analyzer has the tune listening function, which can be applied for radio monitoring. The
sound effect can be improved by adjusting the resolution bandwidth during demodulation of the sound
difference. In the demodulation mode, the resolution bandwidth should be preferably set as 300kHz-30kHz.

Section 1 Introduction to Typical Measurements
The spectrum analysis mode of 4024 series is a basic operating mode. The Quick Operation Guide of 4024
Series Spectrum Analyzer has introduces some typical measurement of this mode, including some basic
measurement methods such as basic signal measurement, improvement of frequency measurement
accuracy, measurement of small signals and distinguishing of signals of approximate frequencies.
Additionally, this section introduces the advanced typical measurement functions and methods of the
spectrum analysis mode of 4024 series, mainly including:
a) Channel power measurement;
b) Occupied bandwidth measurement;
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c) Adjacent channel power ratio measurement;
d) Third-order IM distortion measurement;
e) Drift signal measurement;
f) Noise signal measurement;
g) Distortion measurement;
h) Pulse RF signal measurement.
i) Signal source measurement(option).
j) Coverage Map(option)
If 【Preset】 on the front panel is pressed, the spectrum analyzer will operate

Caution

again. Unless specially explained, it starts from pressing 【Preset】 key in the
following examples.

4.1.1 Channel power measurement
Taking the measurement of the channel power of the FM signal for example, this section describes how to
apply the channel power measurement function of 4024 series spectrum analyzer to measure the channel
power of the signal.

1) Definition of channel power
Channel power measurement of one of the most common measurements of the RF transmission system, in
which the channel power refers to the power of the signal within a certain frequency range in the specific
interval. If the specific power is not measured in the power amplifier and filter circuit test, it indicates that
the system is faulty. The channel power measurement is applied to evaluate the communication transmitter,
and determine the quality of RF transmission by comparison with the specific communication protocol.
4024 series spectrum analyzer can be used for measuring the channel power of the FM signal. As the FM
signal is different from the CW signal in several aspects, it can be made more accurate by means of
accurate setting.

2) Measurement procedures
The channel power of one FM signal can be measured with 4024 series spectrum analyzer according to the
following procedures.
a) Set the signal generator to output the FM signal:
Use the signal generator to generate one FM signal. Set the frequency as 1GHz, power as -10dBm, FM
offset as 500kHz and demodulation rate as 10kHz. Connect the output of the signal generator to the RF
input end of the spectrum analyzer through one cable, as shown in Fig. 4-1. Enable the ON state of the
modulation output and radio frequency.
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2.4mm cable

Synthesized signal generator

Adapter

Adapter

Spectrum analyzer

Fig. 4-1 Schematic Diagram of Connection of Signal Generator and Spectrum Analyzer
b) Reset the spectrum analyzer into the default state:
Press 【Preset】.
c) Enable the channel power measurement function:
Press 【Measure】, [Channel Power] and [Channel Power Off On]. Thus the channel power measurement
function is enabled.
d) Set the center frequency:
Press【Measure】, [Channel Power] and [Center Freq] to set the center frequency with number keys. Set the
center frequency of the spectrum analyzer as the frequency of the tested signal, i.e. 1GHz.
e) Set the channel power bandwidth:
Press【Measure】, [Channel Power] and [Channel BW] and set the channel power bandwidth as 1MHz with
number keys.
f) Set the channel power span:
Press 【Measure】, [Channel Power] and [Span] and set the channel power sweeping bandwidth as 2MHz
with number keys.
g) Set the resolution bandwidth and video bandwidth of the spectrum analyzer:
Press 【BW】 and [RBW Auto Man], and set the resolution bandwidth as 30kHz;
Press 【BW】 and [VBW Auto Man], and set the video bandwidth as 30kHz or less.
The channel power bandwidth refers to the frequency width of the power
displayed by the spectrum analyzer within the bandwidth, while the channel

Caution

power span refers to the sweeping frequency range of the spectrum analyzer.
The channel power span should be more than or equal to the channel power
bandwidth; otherwise, the channel span will be automatically set to be equal to
the channel power bandwidth. The ratio of the channel power span to channel
power bandwidth is a constant (the ratio between 1 to 10). When the channel
power bandwidth changes, this ratio will remain unchanged. It can be changed
by changing the channel power sapn. For example, when the channel power
bandwidth is doubled, the channel power sapn will be increased by the same
times.
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h) Enable the average function:
Press 【BW】 and [Average Off On], set the averaging times as 16, and enable the average function.
If the channel power measurement function is enabled, the “Auto” mode of the detector will change into
the “RMS” mode. Two vertical white lines on the screen indicates the channel power bandwidth, and
measurement results are displayed at the bottom of the screen. The channel power measurement interface is
shown in Fig. 4-2.

Fig. 4-2 Channel Power Measurement of FM Signal

4.1.2 Occupied bandwidth measurement
Taking the measurement of the occupied bandwidth of the FM signal for example, this section describes
how to use the occupied bandwidth measurement function of 4024 series spectrum analyzer to measure the
occupied bandwidth of the signal.

1) Definition of occupied bandwidth
The occupied bandwidth refers to the bandwidth including energy of certain proportion to the total
transmitted power, with the center frequency of the specified channel as the center. By using the occupied
bandwidth measurement function of 4024 series spectrum analyzer, measurement results can be given
rapidly, clearly and accurately. Depending on the modulation mode, two methods can be applied to
calculate the occupied bandwidth.
a) Power percentage:
The occupied bandwidth of the signal is obtained by calculating the bandwidth of the frequency of certain
percentage to the total power of the transmitted power. The power percentage can be set by the user.
b) Power drop dBc:
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The occupied bandwidth in this calculation method is defined as follows: spacing between two frequency
points corresponding to signal power drop by dBc on both sides of the frequency point where the signal
peak power is. The signal power drop dBc can be set by the user.

2) Measurement procedures
The occupied bandwidth can be measured with 4024 series spectrum analyzer according to the following
procedures:
a) Set the signal generator to output the FM signal:
Use the signal generator to generate one FM signal. Set the frequency as 1GHz, power as -10dBm, FM
offset as 500kHz and demodulation rate as 10kHz. Connect the output of the signal generator to the RF
input end of the spectrum analyzer through one cable, as shown in Fig. 4-1. Enable the ON state of the
modulation output and radio frequency.
b) Reset the spectrum analyzer into the default state:
Press 【Preset】.
c) Set the center frequency:
Press 【Freq】 and [Center Freq] to set the center frequency with number keys. Set the center frequency of
the spectrum analyzer as the frequency of the tested signal, i.e. 1GHz.
d) Set the resolution bandwidth:
Press 【BW】 and [RBW Auto Man], and set the resolution bandwidth as an appropriate value.
e) Set the video bandwidth:
Press 【BW】 and [VBW Auto Man], and set the video bandwidth as an appropriate value.
In order to improve the measurement accuracy, it is recommended to set the ratio of the resolution
bandwidth to video bandwidth to be more than 10. Press [RBW/VBW] to change this ratio.
f) Enable the occupied bandwidth measurement mode of the spectrum analyzer:
Press 【Measure】, [OBW] and [OBW Off On].
After the occupied bandwidth measurement function is enabled, the spectrum analyzer will change into the
occupied bandwidth measurement interface, and measurement results will be displayed at the bottom of the
screen. Refer to Fig. 4-3 for the schematic diagram of occupied bandwidth measurement. Two vertical
white lines on the screen intuitively indicate the frequency range of the occupied bandwidth. After the
occupied bandwidth measurement function is enabled, the “Auto” mode of the detector will automatically
change into the “RMS” mode. The user can change the measurement method, occupied bandwidth span, etc.
with corresponding menus, so as to obtain more accurate measurement results.
g) Select the measurement method:
Press 【Measure】, [OBW] and [Method % dBc], and select the occupied bandwidth measurement method.
You can set the method as the power percentage or power drop dBc. The underline indicates the current
mode, and the default setting is the percentage.
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Fig. 4-3 Occupied Bandwidth Measurement
h) Change the percentage:
If the percentage method is selected, you can press 【Measure】, [OBW] and [% 99%], and use the number
keys, UP/DOWN keys or knob to change the percentage. The percentage range is 10% to 99.99%, with the
minimum step of 0.01%. The default setting is 99%.
i) Change the dBc value:
If the dBc method is selected, you can press 【Measure】, [OBW] and [dBc -3.00dB] and use the number
keys, UP/DOWN keys or knob to change the dBc value. The dBc range is -0.1dB to -100dB, with the
minimum step of 0.01dB. The default setting is -3dB.
j) Change the occupied bandwidth span:
Press 【Measure】, [OBW] and [Span], and enter the occupied bandwidth span with number keys. Press
corresponding soft keys to enter the unit. The default setting is 3MHz.
k) Disable the occupied bandwidth measurement:
Press 【Measure】, [OBW] and [OBW Off On], and disable the occupied bandwidth measurement. The
interface will change into the spectrum measurement interface.

4.1.3 Adjacent channel power ratio measurement
Taking the measurement of the adjacent channel power ratio of the FM signal for example, this section
describes how to use 4024 series spectrum analyzer to measure the adjacent channel power ratio.

1) Definition of adjacent channel power ratio
The adjacent channel power ratio (ACPR), also known as the adjacent channel leakage power ratio (ACLR)
refers to the ratio of the transmitted power of one channel to the radiation power of the adjacent channel. It
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is generally expressed as the ratio of the power within the specified bandwidth under various offsets of the
adjacent channel to the total power of the channel. The adjacent channel power mainly depends on the
extension of the modulated sideband and noise of the transmitter.
The adjacent channel power ratio measurement can be applied, as a substitute of the traditional dual-audio
IM distortion measurement, in nonlinear system tests. The measurement result of the adjacent channel
power ratio can be expressed in two forms: power ratio and power density.

2) Measurement procedures
In the traditional measurement of the narrow-band signal, the distortion performance of the transmitter is
evaluated generally by means of dual-audio signal IM measurement. The broadband modulation signal
includes both the dense spectrum components and high peak signal (also known as the crest factor). IM
products of spectrum components of the signal are always around the spectrum. The IM measurement of
the broadband FM signal is complex, while ACPR is closely related to IM products arising from nonlinear
distortion. Therefore, ACPR is a better method to measure the nonlinear distortion of the broadband FM
signal.
The ACPR of the broadband FM signal can be measured with the ACPR measurement function of 4024
series spectrum analyzer according to the following procedures.
a) Set the signal generator to output the broadband FM signal:
Use the signal generator to generate one FM signal. Set the frequency as 1GHz, power as -10dBm, FM
offset as 500kHz and demodulation rate as 10kHz. Connect the output of the signal generator to the RF
input end of the spectrum analyzer through one cable, as shown in Fig. 4-1. Enable the ON state of the
modulation output and radio frequency.
b) Reset the spectrum analyzer into the default state:
Press 【Preset】.
c) Set the reference level of the spectrum analyzer:
Press 【Ampt】 , [Ref Level] and -10[dBm];
Press 【Ampt】 and [Scale/Div] and set the scale as 10dB/division.
d) Set the resolution bandwidth and video bandwidth:
Press 【BW】 and [RBW Auto Man], and set the resolution bandwidth as 30kHz;
Press 【BW】 and [VBW Auto Man], and set the video bandwidth as 30kHz or less.
e) Enable the ACPR measurement:
Press 【Measure】, [ACPR] and [ACPR Off On] to enable the ACPR interface.
f) Set the center frequency of the main channel:
Press [Center Freq] and set the center frequency of the main channel with number keys, i.e. 1GHz.
g) Set the bandwidth of the main channel:
Press [Main Ch BW] and set the bandwidth of the main channel with number keys, i.e. 1MHz.
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h) Set the adjacent channel bandwidth:
Press [Adj Ch BW] and set the adjacent channel bandwidth with number keys, i.e. 2MHz.
i) Set the channel spacing:
Press [Ch Spacing] and set the channel spacing as 1MHz with number keys.
j) Enable the ACPR test:
Press [ACPR Off On]. Then the measurement results will be displayed at the bottom of the screen. Refer to
Fig. 4-4 for the schematic diagram of ACPR measurement.

Fig. 4-4 ACPR Measurement
k) Limit setting:
The limit test function can be applied so as to easily observe whether the adjacent channel power is beyond
the set range. Press 【Measure】, [ACPR] and [More 1/2] to enter the ACPR limit test setting menu.
Press [Upper Limit] and enter the upper limit with number keys.
Press [Lower Limit] and enter the lower limit with number keys.
l) Enable the limit test function:
Press [Limit Test Off On] to enable the limit test function. If the adjacent channel power is beyond the set
limits, the screen background will become red for indication.

4.1.4 Third-order IM distortion measurement

1) Definition of third-order IM distortion
Mutual interference between equipment in common in crowd operating environment of the
communications system. For example, second-order and third-order IM distortion is common in
narrow-band systems. When there are two signals (F1 and F2) in one system, they and second harmonic
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distortion signals generated by them (2F1 and 2F2) mix and become third-order IM products 2F2-F1 and
2F1-F2 very close to original signals, thus resulting in high-order IM distortion. Such distortion products are
mostly generated by devices such as amplifiers and mixers in the system.
The measurement of third-order IM distortion is described below. This section provides an example of how
to display two signals at the same time on the screen of the spectrum analyzer, and introduces how to set
the resolution bandwidth, mixer level and reference level, as well as some marker functions.

2) Measurement procedures
a) Connect the tested instrument with spectrum analyzer as shown in Fig. 4-5.
This example involves one 6dB directional coupler, one 1GHz signal generator and one 1.001GHz signal
generator. Of course, the signal generators of other frequencies are allowed. However, the frequency
interval must be approximately 1MHz in this example.

Signal generator 1
50Ω RF input
1GHz

Signal generator 2
Directional
coupler

Spectrum analyzer

1.001GHz

Fig. 4-5 Connection of Third-order IM Distortion Measurement System
Set the output frequency of one signal generator as 1GHz and the output frequency of the other signal
generator as 1.001GHz, so that the frequency interval of two signals transmitted into the spectrum analyzer
is 1MHz.
Set the same output amplitude for both signal generators (-20dBm in this example).
b) Set the spectrum analyzer until both signals are displayed on its screen at the same time.
Press 【Preset】.
Press 【Freq】, [Center Frequency], 1.0005[GHz].
Press 【Freq】, [Span] and 5[MHz].
You can see that both signals are at the center of the screen, as shown in Fig. 4-6. If the applied frequency
interval is different from that in this example, select the span more than three times of the frequency
interval of the signal generators.
c) Reduce the resolution bandwidth until you can see the distortion product:
Press 【BW】 and reduce the resolution bandwidth with the step key 【↓】.
d) Adjust both signal generators until the amplitudes of input signals are the same.
Press [Maker], [Delta], 【Peak】 and [Next Peak] or [Next Pk Left] or [Next Pk Right]. Adjust the signal
generator corresponding to the marker until the amplitude difference is zero. If required, reduce the video
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bandwidth.

Fig. 4-6 Signals at Center of Display of Spectrum Analyzer
e) Set the reference level and make the signal peak at the reference level:
Press 【Peak】 and [Peak Search], and read the peak power.
Press 【Ampt】, [Reference Level].
In order to achieve the best measurement accuracy, the signal peak of the signal generators should be set at
the reference level, as shown in Fig. 4-7.

Fig. 4-7 Signal Peak at Reference Level
f) Set the second marker and measure the distortion product:
Once the marker is activated, the second marker will be generated by the differential marker function, and
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the difference between both markers will be displayed. In this case, relative measurement can be performed
easily.
Press 【Peak】 to activate one marker.
Press [Maker] and [Delta] to activate the second marker.
Press 【Peak】 and [Next Pk Left] or [Next Pk Right] to set the second marker at the peak point of the
distortion product beside the signal generated by the signal generator. As shown in Fig. 4-8, the frequency
and amplitude difference of both markers will be shown in the marker display zone, and the marker
amplitude difference will be the measured value of third-order IM distortion.

Fig. 4-8 Relative Measurement of Internal Modulation Distortion
g) Calculation of third-order interception (TOI) point:
The ratio (in dB) of the distortion component level to signal level has no great significance for system
distortion, unless the signal level is specified. The interception point can be applied to specify and evaluate
the system distortion level. The difference between the third-order distortion component level and
fundamental signal level is twice of that between the fundamental signal level and third-order interception
point. The third-order interception (TOI) point can be calculated by the following formula:
TOI  L in 

dBim 3
2

Where:
L in : Refer to two input signal levels, in dBm.
dB

im 3

: means the difference between the third-order IM product and input signal level, in dB.

As shown in Fig. 4-7, if the differential marker reading is -62.33dB and the signal level is -20.24dBm,
the third-order interception (TOI) point is:
TOI= -20.24- (-62.33/2)=10.925(dBm)
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4.1.5 Drift signal measurement

1) Definition of drift signal
If the drift signal is measured with the spectrum analyzer, the center frequency should be changed in
different period so as to facilitate observation. If the signal tracking function of the spectrum analyzer is
enabled, the marker peak will always be displayed at the center frequency of the spectrum analyzer, thus
facilitating measurement.
This section introduces how to measure the drift signal, in which the signal tracking function, marker
function and maximum holding function of the spectrum analyzer are applied to observe the amplitude
trace and occupied bandwidth of the drift signal.

2) Measurement of frequency drift for signal generator
The spectrum analyzer is able to measure the short-time and long-time stability of the signal generator. By
using the maximum trace holding function, the spectrum analyzer can display the maximum peak
amplitude and frequency drift of the input signal. The max hold function of track may be used to measure
the occupied bandwidth of signal.
In this example, the signal tracking function of the spectrum analyzer is applied to keep the drift signal
always displayed at the center and the maximum trace holding function to capture the drift.
a) Set the output signal of the signal generator:
Set the signal generator to output the 300MHz and -20dBm signal. Connect the output of the signal
generator to the input port of the spectrum analyzer, as shown in Fig. 4-1. Enable the RF output.
b) Set the center frequency, span and reference level of the spectrum analyzer:
Press 【Preset】.
Press 【Freq】, [Center Frequency], 300[MHz].
Press 【Freq】, [Span] and 10[MHz].
Press 【Ampt】 , [Ref Level] and -10[dBm].
c) Set the marker at the signal peak, and enable the signal tracking function.
Press 【Peak】 and [Peak Track Off On].
Press 【Freq】 and [Signal Track Off On].
d) Reduce the span:
Press 【Freq】, [Span] and 500 [kHz]. You can see that the signal is always at the center.
e) Disable the signal tracking function:
Press 【Freq】 and [Signal Track Off On].
f) Use the maximum holding function to measure the signal drift.
Press [Trace] and [Max Hold].
When the signal changes, the max hold will maintain the maximum response to the input signal.
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g) Activate the trace 2 and set it into the continuous clearing and writing mode.
Press [Trace], [Trace 1 2 3] and [Clear Write].
h) Change the output frequency of the signal generator.
Slowly change the output frequency of the signal generator, with the step of 1kHz and the range of ±50kHz.
The spectrum analyzer will display the information shown in Fig. 4-9.

Fig. 4-9 Observation of Drift Signal by Maximum Holding Function

4.1.6 Noise signal measurement

1) Definition of noise signal
In communications systems, signal-to-noise ratio (SNR) is usually used to express noise amplitude. When
the nose level in the system increases, SNR decreases, and it will be harder to demodulate modulated
signals. SNR measurement is also used to indicate measurement of ratio of carrier against noise in
communications systems.
Measurement of the S/N and noise by the marker function of 4024 series spectrum analyzer is described
below. In the example, SNR is measured with the signal (carrier) having only single frequency point. If the
modulation signal is tested, this test process should be modified to correct the level of the modulation
signal.

2) Measure SNR
a) Set the output signal of the signal generator:
Set the frequency of the signal generator as 1GHz and power as -10dBm. Connect the output of the signal
generator to the input port of the spectrum analyzer, as shown in Fig. 4-1. Enable the ON state of the radio
frequency.
b) Set the center frequency, span, reference level and attenuator.
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Press 【Preset】.
Press 【Freq】, [Center Frequency], 1[GHz].
Press 【Freq】, [Span] and 5[MHz].
Press 【Ampt】, [Ref Level] and -10[dBm].
Press 【Ampt】, [Atten Auto Man] and 40[dB].
c) Set the marker at the signal peak and the differential marker at the noise location with the offset of
200kHz.
Press 【Peak】 and [Peak Track Off On].
Press 【Marker】, [Delta] and 200[kHz].
d) Enable the noise marker function and observe the S/N:
Press 【Marker】 and [Marker Noise Off On]. As shown in Fig. 4-10, the S/N reading is in dB/Hz, as the
noise value refers to the noise bandwidth normalized to 1Hz.
This value decreases by 10×log(BW). If you wish to obtain noise values under different channel bandwidth,
the measurement result needs to be corrected based on current bandwidth. For example, if the reading of
the spectrum analyzer is -85dB/Hz and the channel bandwidth is bandwidth, S/N is:
S/N=85dB/Hz - 10×log(30kHz) =40.2dB/(30kHz)
If the differential marker is less than one fourth of the edge distance between the signal peak and response,
errors may occur in noise measurement.

Fig. 4-10 S/N Measurement

3) Noise measurement by noise marker function
In this example, the noise of 1Hz bandwidth is measured by the noise marker function, using the 1GHz
external signal.
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a) Set the output signal of the signal generator:
Set the frequency of the signal generator as 1GHz and power as -10dBm. Connect the output of the signal
generator to the input port of the spectrum analyzer, and enable the ON state of the radio frequency.
b) Set the center frequency, span, reference level and attenuator.
Press 【Preset】.
Press 【Freq】, [Center Frequency], 999.98[MHz]
Press 【Freq】, [Span] and 100[kHz].
Press 【Ampt】, [Ref Level] and -10[dBm].
Press 【Ampt】, [Atten Auto Man] and 40[dB].
c) Activate the noise marker.
Press [Maker] and [Marker Noise Off On].
Note: The “RMS” mode of the detector will be enabled automatically. To obtain the noise power under
different bandwidth, you can correct the current bandwidth based on 10×log(BW). For example, if the noise
power within 1 kHz bandwidth is to be obtained, 10×log (1000) or 30 dB has to be added to the reading.
d) Reduce the measurement error by increasing the sweep time:
Press 【Sweep】, [Sweep Time Auto Man] and 3[s].
In the “Average” mode of the detector, you can increase the sweep time so that the trace data are averaged
in a longer interval, so as to reduce the measurement error.
e) Move the marker to 1GHz.
Press [Maker] and rotate the knob on the front panel until the noise marker reading is 1GHz.
The noise marker value is calculated based on 5% of points on the whole sweep trace, with the marker
location as the center. The noise marker will not be at the signal peak since such position has no enough
trace points for calculation. Therefore, when the resolution bandwidth is narrow, the noise level will
average trace points below the signal peak. As shown in Fig.4-11:

Fig. 4-11 Noise Measurement by Noise Marker Function
f) Set the spectrum analyzer into the zero span mode, with the marker location as the center.
Press 【Peak】 and [Marker→Center].
Press 【Freq】, [Span] and [Zero Span].
Read the [Maker].
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In this case, the amplitude reading of the noise marker is correct, as the averages of all points are at the
same frequency, which is not affected by the shape of the resolution bandwidth filter. The noise marker is
calculated based on the average of the interested frequency points. The power of discrete frequency points
should be measured in the zero span mode, with the spectrum analyzer tuned to the interested frequency
point.

4.1.7 Distortion measurement
Mutual interference between equipment in common in crowd operating environment of the
communications system. For example, second-order and third-order intermodulation distortion is common
in narrowband systems. When there are two signals (F1 and F2) in one system, they and second harmonic
distortion signals generated by them (2F1 and 2F2) mix and become third-order intermodulation products
2F2-F1 and 2F1-F2 very close to original signals, thus resulting in high-order intermodulation distortion.
Such distortion products are mostly generated by devices such as amplifiers and mixers in the system. Most
transmission units and signal generators have harmonics and their components need to be measured.

1) Identification of distortion generated by spectrum analyzer
In the case of large signal input, the spectrum analyzer may be subject to distortion, which will affect the
distortion measurement results of true signals. You can set the attenuator to determine which signal is a
distortion signal generated by the spectrum analyzer. This example shows whether the spectrum analyzer is
subject to harmonic distortion based on the input signal.
a) Set the output signal of the signal generator:
Set the frequency of the signal generator as 200MHz and power as 0dBm. Connect the output of the signal
generator to the input port of the spectrum analyzer, as shown in Fig. 4-1. Enable the ON state of the radio
frequency.
b) Set the center frequency and span of the spectrum analyzer.
Press 【Preset】.
Press 【Freq】, [Center Frequency] and 400[MHz].
Press 【Freq】, [Span] and 500[MHz].
You can see on the trace of the spectrum analyzer that the harmonic distortion of the signal is subject to
200MHz deviation from the original 200MHz signal, as shown in Fig. 4-11.
c) Set the center frequency of the spectrum analyzer at the first harmonic distortion location.
Press 【Peak】 and [Next Peak]
Press 【Peak】 and [Marker→Center].
d) Set the span as 50MHz and reset the center frequency.
Press 【Freq】, [Span] and 50[MHz].
Press [Marker→] and [Marker→Center].
e) Set the attenuator as 0dB.
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Press , [Atten Auto Man] and 10[dB].
Press 【Peak】 and [Peak Track Off On].
Press [Maker] and [Delta].

Fig. 4-12 Observation of Harmonic Distortion
f) Increase the attenuator setting to 10dB:
Press [Atten Auto Man] and 10[dB].
Observe the differential marker reading, as shown in Fig. 4-13. The reading is the distortion difference of
the attenuator at 0dB and 10dB. If the attenuator is changed and the differential marker reading is 1dB or
more, it indicates that the spectrum analyzer is subject to certain distortion. If the differential marker
reading is not obvious, the attenuation may be increased.

Fig. 4-13 Attenuator Setting - 10dB
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The amplitude reading of the differential marker is provided by two sources: 1. If the RF attenuation is
increase, S/N will decrease, and this reading will be positive. 2. If the harmonic distortion of the spectrum
analyzer decreases, this reading will be negative. The larger the reading, the bigger the error of
measurement. In such case, the attenuator setting may be changed to reduce absolute amplitude of such
delta marker reading.

2) Quick harmonic measurement
In this section, harmonic components are measured of a signal with frequency of 1 GHz and power of -10
dBm generated by the signal generator.
a) Set the output signal of the signal generator:
Set the frequency of the signal generator as 1GHz and power as -10dBm. Connect the output of the signal
generator to the input port of the spectrum analyzer, as shown in Fig. 4-1. Enable the ON state of the radio
frequency.
b) Set the starting frequency and stop frequency of the spectrum analyzer.
Press 【Preset】 key.
Press 【Freq】, [Start Freq], 800[MHz], [Stop Freq] and 2.5[GHz].
As shown in Fig. 4-14, the fundamental wave and second harmonic will be displayed on the screen.

Fig. 4-14 Input Signal and Harmonic
c) Set the video bandwidth to smooth noise so as to improve the resolution.
Press [Bandwidth], [Video Bandwidth Auto Man] to enable auto off.
Use 【↓】 key to reduce video bandwidth.
d) In order to improve the measurement accuracy, set the peak level of the fundamental wave as the
reference level.
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Press 【Peak】 and [Peak Search], and read the peak power.
Press 【Ampt】 and [Ref Level], and set it as the peak power. Results are shown in Fig. 4-15.

Fig. 4-15 Setting of Signal Peak as Reference Level for Maximum Accuracy
e) Activate the second marker.
Press [Delta], and [Next Peak].
In this case, the fixed marker is on the fundamental wave, while the mobile marker is on the peak point of
the second harmonic, as shown in Fig. 4-16.

Fig. 4-16 Second Harmonic Measurement based on Marker Difference
f) Measure the harmonic distortion (Method 1).
The fundamental wave and the second harmonic as shown in the figure has am amplitude difference of
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about -60 dB, or a harmonic distortion of 0.1% (see Fig. 4-17).
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Fig. 4-17 Conversion of Percentage of Harmonic Distortion Amplitude
To measure the third harmonic, press [Next Pk Right] and read the amplitude ratio of other harmonics to
the fundamental wave.
g) Measure the harmonic distortion (Method 2).
Press 【Ampt】, [Units] and [Volt].
In this case, the unit of the differential marker will automatically change into volt. An easy way to
determine distortion percentage is to change the unit to volt. Move the decimal of the proportion indicated
by the differential marker rights for two places to obtain the distortion percentage. The minimum ratio that
can be displayed is 0.01 or 1%.

3) Accurate harmonic measurement
It takes more steps to measure in this method, but since measurement is done with smaller span and
resolution bandwidth for each signal, the signal-to-noise ratio is increased and more accurate measurement
result will be obtained. It will be explained below how to measure the harmonic of 1 GHz signals.
a) Set the output signal of the signal generator:
Set the frequency of the signal generator as 1GHz and power as -10dBm. Connect the output of the signal
generator to the input port of the spectrum analyzer, as shown in Fig. 4-1. Enable the ON state of the radio
frequency.
b) Set the starting frequency and stop frequency of the spectrum analyzer.
Press 【Preset】 key.
Press 【Freq】, [Start Freq], 800[MHz], [Stop Freq] and 2.5[GHz].
c) Set the video bandwidth to smooth noise so as to improve the resolution.
Press [Bandwidth], [Video Bandwidth Auto Man] to enable auto off.
Use 【↓】 key to reduce video bandwidth.
d) Reduce the span by the signal tracking function.
Press 【Peak】 to activate the signal peak of marker search.
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Press 【Freq】 and [Signal Track Off On].
Press 【Freq】, [Span] and 100[kHz].
e) Disable signal tracking.
Press 【Freq】 and [Signal Track Off On].
f) Move the signal peak to the top division to obtain the highest amplitude measurement accuracy.
Press 【Peak】 and [Peak Search], and read the peak power.
Press 【Ampt】 and [Ref Level], and set it as the peak power. Results are shown in Fig. 4-18.

Fig. 4-18 Input Signal under 100kHz Span
g) Set the step of the center frequency as the signal frequency of the fundamental wave.
Press 【Freq】 and [CF Step Auto] and enter 1 GHz.
h) Measure the second harmonic.
Press [Maker], [Marker→], [Marker→Center] and step key 【↑】. Change the center frequency of the
spectrum analyzer to second harmonic by stepping operation. Press 【Peak】 and [Peak Search], and read
the peak power.
Press 【Ampt】 and [Ref Level], and set it as the peak power. Adjust the harmonic peak to the reference
level. The second harmonic amplitude is shown in Fig. 4-19.
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Fig. 4-19 Second Harmonic Amplitude
i) Calculate the harmonic distortion.
Change the distortion percentage of the second harmonic to fundamental wave as shown in Fig. 4-17. The
unit can be changed again to volt in order to read the voltage ratio of two signals.
j) Measure other harmonics.
Repeat Step (i) to (j) to other harmonics to be measured. Calculate the distortion percentage of each
harmonic.
Total signal harmonic distortion percentage is also subject to frequent test. In order to test such parameter,
amplitude of each harmonic should be tested with linear unit (such as volt) rather than relative unit dBc.
Press 【Ampt】, [Units] and [Volt] to set the amplitude unit as volt. The measured signal amplitude can be
applied in the following equation to calculate the total harmonic distortion:

Total harmonic distortion 

100 

 A2 2   A3 2       An 2
A1

%

Where:
A1 - refers to fundamental wave amplitude (V)
A2 - refers to second harmonic amplitude (V)
A3 - refers to third harmonic amplitude (V)
An refers to nth harmonic amplitude (V)
If the signal amplitude is carefully measured as shown in the above example, the obtained harmonic
distortion percentage is accurate.
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4.1.8 Pulse RF signal measurement
1) Definition of pulse RF signal
The pulse RF signal refers to a RF pulse string of the same repetition frequency and constant pulse width,
shape and amplitude. This section introduces several methods of measuring pulse RF signal parameters,
including how to measure the center frequency, pulse width and pulse repetition frequency. In addition, the
measurement of peak pulse power is also discussed.
The resolution bandwidth has great influence on pulse RF signal measurement. You must understand the
relationship between the resolution bandwidth and pulse repetition frequency. If the resolution bandwidth is
narrower than the pulse repetition frequency, only individual frequency components of the pulse RF signal
will appear on the screen. This is known as the narrow band mode. The mode in which the resolution
bandwidth is broader than the pulse repetition frequency is known as the broad band mode. In this case,
you can see the spectrum envelope formed by pulse segments that are equalized by the tested pulse
repetition frequency.

2) Center frequency, side lobe ratio and pulse width measurement of pulse RF signal
a) Set the output signal of the signal generator:
Set the frequency of the signal generator as 1GHz and power as -20dBm. Connect the output of the signal
generator to the input port of the spectrum analyzer, as shown in Fig. 4-1. Set the repetition frequency of
pulse modulation as 1kHz and pulse width as 900ns. Enable the pulse modulation and RF output.
b) Set the spectrum analyzer:
The pulse RF signal is generally measured in the broad band mode. In order to prevent the influence of the
video filter on measurement results, the video bandwidth should be set as 3MHz.
Press 【Preset】 key.
Press 【Freq】, [Center Frequency] and 1[GHz].
Press 【Freq】, [Span], 10[MHz], 【Sweep】, [Sweep Time Auto Man] and 60[ms].
Press 【BW】, [RBW Auto Man], 100 [kHz], [VBW Auto Man] and 100 [kHz].
Press 【BW】, [Detector] and 【Peak】 to activate the peak detector.
Enable the center frequency function and adjust the span until the center side lobe and at least one pair of
side lobes appear on the screen, as shown in Fig. 4-20.
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Fig. 4-20 Main Lobe and Side Lobe
Increase the sweep time (decrease the sweeping speed) until the graph is filled into a solid line, as shown in
Fig. 4-21. If the spectrum line cannot be filled, it indicates that the instrument is not in the broad band mode.
In this case, the following steps of measurement of the sidelobe ratio, pulse width and peak pulse power
will not apply. The resolution bandwidth should be more than 1kHz.

Fig. 4-21 Trace Display in Solid Line Form
c) Read the center frequency of the pulse and amplitude of the main lobe.
Press 【Peak】.
The marker reading is the center frequency of the pulse and amplitude of the main lobe.
d) Set the marker at the center frequency of the main lobe, and measure the side lobe ratio:
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Press 【Peak】, [Maker], [Delta], 【Peak】 and [Next Peak].
The amplitude difference between the main lobe and side lobe is the side lobe ratio, as shown in Fig. 4-22.

Fig. 4-22 Side Lobe Ratio Shown by the Marker
e) Measure the pulse width, which is equal to the reciprocal of the frequency difference between the peaks
of two side lobe envelopes.
Press [Maker], [Delta], 【Peak】, [Next Pk Right] and [Next Pk Right].
In this case, the reciprocal of the frequency difference indicated by the differential marker is the pulse
width, as shown in Fig. 4-23. To obtain the most accurate pulse width, you can manually adjust the marker
location and measure the distance between the zero crossing points of two adjacent side lobes. You can also
reduce the resolution bandwidth to make the zero crossing point sharper and measurement accuracy higher.
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Fig. 4-23 Pulse Width Shown by the Marker

3) Pulse repetition frequency (PRF) measurement
The pulse repetition interval (PRI) refers to the time interval between any two adjacent pulse responses.
a) Set the output signal of the signal generator:
Set the frequency of the signal generator as 1GHz and power as -20dBm. Connect the output of the signal
generator to the input port of the spectrum analyzer. Set the repetition frequency of pulse modulation as
1kHz and pulse width as 900ns. Enable the pulse modulation and RF output.
b) Set the spectrum analyzer:
Press 【Preset】 key.
Press 【Freq】 and 1[GHz].
Press 【Freq】, [Span], 10[MHz], 【Sweep】, [Sweep Time Auto Man] and 1.705[s].
Press 【BW】, [RBW Auto Man] and 1[kHz].
Press 【BW】, [VBW Auto Man] and 3[MHz].
Press 【BW】, [Detector] and 【Peak】 to activate the peak detector.
Adjust the span until the main lobe and at least one side lobes appear on the screen.
Readjust the output amplitude of the signal generator until it is shown in the screen. Reduce the sweep time
(i.e. increase the sweeping speed) until the contents similar to those in Fig. 4-24 are displayed.
c) Measure the pulse repetition interval:
Press 【Sweep】 and [ Sweep Cont Single]
Press 【Peak】, [Maker][Delta] and 【Peak】 [Next Peak]. The difference of two markers is the pulse
repetition interval (PRI), and its reciprocal is the pulse repetition frequency (PRF).
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Fig. 4-24 Measurement of Pulse Repetition Frequency

4) Peak pulse power measurement
Now we have obtained the main lobe amplitude and pulse width. In addition, we can easily obtain the
resolution bandwidth of the spectrum analyzer. Therefore, the peak pulse power can be obtained based on
such parameters.
In the broad-band measurement mode of the spectrum analyzer:
Peak pulse power = (main lobe amplitude) -(20 log Teff×BWi)
Where:
Teff -pulse width, in second. Second
BWi - impact bandwidth, in Hz (equal to the resolution bandwidth applied in 1.5 “Pulse width
measurement”)
In the narrow-band measurement mode of the spectrum analyzer:
peak pulse power =(main lobe amplitude) -(20 log Teff/T)
Where:
Teff -pulse width, in second. Second
T——pulse repetition frequency
The phenomenon in which the peak pulse power is not equal to the main lobe amplitude is known as pulse
desensitization. The sensitivity of the spectrum analyzer will not be decreased by the pulse signal.
Accurately, pulse desensitization is caused by distribution of the CW carrier power of pulse modulation to a
number of spectrum components (i.e. carrier and sideband). Therefore, each spectrum only contains part of
the total power.
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In measurement of the main lobe amplitude, you should change the
attenuator of the spectrum analyzer and verify that the main lobe amplitude will

Caution

not change accordingly. If the change exceeds 1dB, it indicates that the
spectrum analyzer is in the gain compression state. In this case, you must
increase the attenuation amount of the attenuator.

4.1.9

Signal source measurement (option)

The signal source measurement mode includes independent source output mode and generator output mode,
of which the independent source mode is point frequency source mode to realize the signal output at single
frequency point and fixed power, and the generator output mode needs to coordinate with spectral analysis
function. Under the generator mode, the signal source will scan synchronously with the frequency under
spectral analysis.

1) Independent source measurement
Under the independent source measurement mode, it is allowed to realize the signal output at fixed
frequency by the following steps:
a)

Press 【Measure】→[Generator]→[Generator Off On], the point frequency source output will be

selected by default after the Generator switch is turned on;
b)

Press 【Measure】→[Generator]→[Output Power 0dBm], it is allowed to set the power of output

signal.
c)

Press 【Measure】→[Generator]→[CW Freq 1GHz], it is allowed to set the frequency of output signal.

The signal with output frequency of 1GHz and output power of 0dBm is as shown in Fig. 4-25:

Fig. 4-25 Schematic diagram of point frequency source output signal
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2) Generator measurement
Under the tracking mode, it is allowed to measure the magnitude-frequency characteristics of measured
piece by using the synchronous frequency scan of signal source and spectral analysis. For details, please
refer to the following setting procedures:
a)

Press【Freq】→[Start Freq], to set the start frequency as 100MHz;

b)

Press 【Freq】→[Stop Freq], to set the stop frequency as 4GHz;

c)

Press 【Measure】→[Generator] →[Generator Off On], to start the source switch;

d)

Press 【Measure】→[Generator] →[Power -20dBm], to set the power of output signal;

e)

Press 【Measure】 →[Generator] →[Mode CW Track], to change the signal source mode to tracking

mode.
The schematic diagram of output signal is as shown in Fig. 4-26:

Fig. 4-26 Schematic diagram of tracking mode

3) Generator normalized measurement
The normalized measurement is to subtract the effect of cable loss from the measuring process. It can
reflect the magnitude-frequency characteristics of measured piece more accurately. For example, to test the
magnitude-frequency characteristics of 2.3GHz~2.4GHz band-pass filter, it is allowed to conduct the
following procedures:
a)

Press 【Freq】→[Start Freq], to set the start frequency as 2.1GHz;

b)

Press 【Freq】→[Stop Freq], to set the stop frequency as 2.6GHz;

c)

Press 【Freq】→[Generator]→[Generator Off On], to start the source switch;
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d)

Press 【Measure】→[Generator]→[Mode CW Track], to change the signal source mode to tracking

mode;
e)

Connect the cable to signal source RF output end and frequency spectrum input end, and press

【Measure】→[Generator]→[Trans Meas]→[Normalize Off On], to start the normalization switch;
f)

After the scanning is completed, it is allowed to add the filter of measured piece and directly observe

the magnitude-frequency characteristics of measured piece.
The magnitude-frequency characteristics diagram of 2.3GHz~2.4GHz band-pass filter is as shown in Fig.
4-27:

Fig. 4-27 Magnitude-frequency characteristics diagram of 2.3GHz~2.4GHz band-pass filter
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Section 2 Structure of Spectrum Analysis Menu
Signal standard
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Fig. 4-30 Overall Block Diagram of Spectrum Analysis Menu
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Fig. 4-31 Overall Block Diagram of Spectrum Analysis Menu (continued)
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Fig. 4-32 Overall Block Diagram of Spectrum Analysis Menu (continued)
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Fig. 4-33 Overall Block Diagram of Spectrum Analysis Menu (continued)
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Fig. 4-34 Overall Block Diagram of Spectrum Analysis Menu (continued)
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Fig. 4-35 Overall Block Diagram of Spectrum Analysis Menu (continued)
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Section 3 Description of “Spectrum Analysis” Menu
4.3.1 Frequency menu
·[Center frequency]: Press →[Center Freq] and set it with the number keys
on the front panel. Then select [GHz], [MHz], [kHz] or [Hz] in the frequency
unit menu, or set the center frequency with the 【↑】 or 【↓】 key or knob.

Frequency
频率

·[Span]: Press 【Freq】→[Span] to enable the span setting menu. Refer to the
[Span] menu description for specific details.

Center
Freq
中心频率

Span
扫宽

>

Start Freq
起始频率

Stop Freq
终止频率
步进频率
CF Step
Auto
Man
自动
手动
Signal
Std
信号标准
>
-Channel
信道号
-More
1 of 2

·[Starting frequency]: Press 【Freq】→ [Start Freq], and set it with number
keys on the front panel. Select [GHz], [MHz], [kHz] or [Hz] in the
frequency unit menu or set the starting frequency with the 【↑】 or 【↓】 key
or knob.
·[Stop Freq]: Press 【Freq】→ [Stop Freq], and set it with number keys on
the front panel. Select [GHz], [MHz], [kHz] or [Hz] in the frequency
unit menu or set the stop frequency with the 【↑】 or 【↓】 key or knob.
·[Step frequency]: Press 【Freq】→ [Step Freq], and set it with number keys
on the front panel. Select [GHz], [MHz], [kHz] or [Hz] in the
frequency unit menu or set the step frequency with the 【↑】 or 【↓】 key or
knob.
·[Signal Std]: Click it and the signal standard menu will pop up, including
soft menus such as [Head], [Tail], [Page Up], [Page Down] and
[Done]. Click [Done] to select the required signal standard file.
·[Channel]: Click it to display the contents and number of the selected signal
standard.
[Special note]: The channel should be set based on the applied signal
standard; otherwise, the prompt that setting is not allowed will pop up.
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Frequency
Signal Track
Off
On
Signal Search
More
2 of 2

·[Signal Track Off On]: Click this menu to enable or disable signal tracking.
After each sweeping, the active marker will be set at the peak point of the
signal by the signal tracking function. The peak frequency will be set as the
center frequency. By selecting [Signal On Off], the signal drifting slowly will
be automatically kept at the center of the screen.
·[Signal Search]: Click this menu to enable signal search. After search the
whole span, the active marker will be set at the peak point of the signal, if no
signal, there will be a tip shown on the screen.
[Special note]: The channel should be set based on the applied signal
standard; otherwise, the prompt that setting is not allowed will pop up.

4.3.2 Span menu
·[Span]: Press 【Freq】→ [Span] and set the span of the current mode with
number keys on the front panel. Select [GHz], [MHz], [kHz] or [Hz]
in the frequency unit menu or set the span with the【↑】or【↓】key or knob.
The span step should be 1, 2 or 5.

Span
Span

·[Full span]: Press 【Freq】→ [Span]→ [Full Span], and set the span of the
current measurement mode as the maximum span. The full span is related to
the instrument mode. For 4024G series spectrum analyzer, the full span is
44.1GHz.

Full span

Zero Span

·[Zero span]: Press 【Freq】→[Span]→[Zero Span], and set the span of the
current measurement mode as the minimum span. Under the full span, it
should be set as 0Hz.

Last span

·[Last span]: Press 【Freq】→ [Span]→ [Last Span], and set the span of the
current measurement mode as the last span.
Zero Span
IF Out

>

·[Zero Span IF Out]: Press 【Freq】→ [Span]→ [Zero Span IF Out] to
activate the IF output menu.
[Special note]: The full span and zero span function will be invalid when
some measurement functions are enabled.

< Back
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[Special note]: The IF output menu, as a functional option, can only be
applied in the zero span mode.
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4.3.3 IF output menu
The zero-span IF output function is optional. The IF signal output can be achieved through the IF output
interface under the zero span to meet the user’s measurement requirements.
[Special note]: The IF output menu, as a functional option, can only be
applied in the zero span mode.
·[IF Out Off On]: Press 【Freq】→ [Span]→ [IF Out]→ [IF Out Off On] and
enable or disable IF output with keys.

IF Out
IF Out
Off

On

IF Select
3IF
4IF
< Back

·[IF Select 3IF 4IF]: Press 【Freq】→[Span]→[IF Out]→[IF Select 3IF
4IF] and select the 3IF or 4IF output with keys.
·[Back]: Press 【Freq】→ [Span]→ [IF Out]→ [Back] to go back to the span
menu.
[Special note]: The IF output function is an option under zero span. If
3IF is selected, the IF output interface will output the third IF frequency,
i.e. 140.25MHz; and if 4IF is selected, the IF output interface will output
the fourth IF frequency, i.e. 31.25MHz.
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4.3.4 Amplitude menu
·[Ref Level]: Press 【Ampt】→ [Ref Level] and set it with number keys on
the front panel. Select [dBm], [-dBm], [mV] or [μ V] in the frequency
unit menu, or set the reference level with the 【↑】 or 【↓】 key or knob.
·[Ref Position]: Press 【Ampt】→ [Ref Position], and select the position of
the reference line in the rectangular coordinate graph by clicking
corresponding number keys.

Amplitude
Ref Level
0.0dBm

·[Atten Auto Man]: Press 【Ampt】→[Atten Auto Man] to adjust the input
attenuation of the spectrum analyzer. In the AUTO mode, the input attenuator
is associated with reference level. Under Man Mode, use number keys,
stepping keys or knob to change the attenuation of the attenuator. The
attenuation range is 0dB to 50dB.

Ref Position
Atten
Auto Man

·[Scale/Div]: Press 【Ampt】→[Scale/Div]. Adjust the size of the vertical
coordinate division on the screen, and set the value with number keys on the
front panel. Select the frequency unit, or set the value with the 【↑】 or 【↓】
key or knob. The setting range is 0.1dB/division to 20dB/division. The
default setting is 10dB/division.

Scale/Div
10.0dB
Scale Type
Log Lin
Units
dBm

>

Pre Amp
Off
On

·[Scale Type Log Lin]: Press 【Ampt】→ [Scale Type Log Lin], and set the
vertical-axis scale as the logarithmic or linear scale. The default logarithmic
scale is in dBm, while the default linear scale is in mV.
·[Amplitude unit]: Press 【Ampt】→ [Units], and select the vertical-axis
unit, including [dBm], [dBmV], [dBuV], [Volt] and [Watt].
·[Pre Amp Off On]: Turn on or off the pre Amp. This function cannot be
activated until the reference level is less than -40dBm.
[Special note]: The level of the input signal must be +13dBm or less
before the pre-amplifier is turned on; otherwise, the instrument will be
damaged.
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4.3.5 Bandwidth menu
·[Res BW Auto Man]: Press 【BW】→[Res BW Auto Man] and adjust the
resolution bandwidth within the range of 1Hz-10MHz. The resolution
bandwidth can be changed with the number keys, step keys or knob in the
manual mode, by the step of 1, 3 or 10. It can be changed with the span
according to the SPAN/RBW value in the auto mode.

BW

·[Video BW Auto Man]: Press 【BW】→[Video BW Auto Man] to adjust the
video bandwidth in the active functional zone. The adjustment range is
1Hz-10MHz. In the manual mode, the video bandwidth can be changed with
the number keys, step keys or knob in the manual mode, by the step of 1, 3 or
10. In the auto mode, it can be changed with the span according to the
RBW/VBW value.

Res BW
Auto Man
Video BW
Auto Man
Video Type
Lin Log

·[Average Off On]: Press 【BW】→ [Average Off On] to enable the
averaging function. traces will be continuously averaged to achieve the
smoothing effects.

Average
Off
On

·[SPAN/RBW]: Press 【BW】→[SPAN/RBW] to set the ratio of the current
span to resolution bandwidth. The value will be displayed in the input zone.
The default setting is 100. This ratio can be applied in the associated mode of
the resolution bandwidth.

SPAN/RBW
100
RBW/VBW
1
Detector
>
Auto
>

·[RBW/VBW]: Press 【BW】→[RBW/VBW] to set the ratio of the current
video bandwidth to resolution bandwidth. The default setting is 1. When the
resolution bandwidth changes, the video bandwidth will automatically
change in the auto mode to meet the ratio requirements. This ratio will be
displayed in the input zone and applied in the associated mode of both
bandwidths. If a new ratio is selected, the video bandwidth will change to
meet the new ratio requirements, while the resolution bandwidth will remain
unchanged.
·[Detector]: Press 【BW】→ [Detector], and the soft menu of detector mode
will pop up. Refer to the [Detector] menu description for details.
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4.3.6 Detector menu
·[Auto]: The default setting of the detector menu is the normal mode.

Detector
Auto

Normal

Peak

Neg Peak

Sample

Average

RMS

< Back

·[Normal]: If noise is detected in this mode, the positive and negative peak
measurement results will be displayed at the same time, so as to achieve the
display effects similar to those of the analog instrument. If the signal is
detected, only the positive peak will be displayed. This is the most commonly
used detector mode. You can see the signal and noise floor at the same time,
with no signal loss.
·[Peak]: Enable the positive peak mode. This mode can ensure that no peak
signal will be missing, thus facilitating measurement of signals close to the
noise floor. The positive peak detector is selected in the [Max Hold] mode.
·[Neg Peak]: Enable the negative peak mode. In this mode, the negative peak
level will be displayed on the trace. This is applied in self-inspection of the
broadband MMW spectrum analyzer in most cases, and rarely applied in
measurement. The modulation envelope of AM signals can be well
reproduced. The positive peak detector is selected in the [Min Hold] mode.
·[Sample]: Enable the sample mode of the detector. This mode is conducive
for noise signal measurement. Compared with the normal mode, noise can be
better measured. This mode is generally applied in the video average and
noise marker function.
·[Average]: Enable the average mode of the detector. The average of sample
data within each sampling interval will be displayed on the trace.
·[RMS]: Enable the RMS mode of the detector. The RMS value of sample
data within each sampling interval will be displayed on the trace.
·[Back]: Go back to the previous menu.
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4.3.7 Marker menu
·[Marker 1 2 3 4 5 6]: Press 【Marker】→[Marker 1 2 3 4 5 6] to select
various markers. Activate one marker and set it at the trace center. The values
will be displayed in the marker display zone in the right upper corner of the
screen.

Marker
Marker
123456
Normal

Delta
Marker Noise
Off
On
Counter Mkr
Off
On
Marker-> >

Off

All Off

·[Normal]: Press 【Marker】→ [Normal] to display the marker frequency and
amplitude. Move the active marker with the knob, step keys or number keys.
The default amplitude is in dB.
·[Delta]: Press 【Marker】→[Delta] to display the amplitude difference and
frequency difference (time difference under zero bandwidth) of two markers.
Move the active marker with the knob, step keys or number keys. The default
amplitude difference is in dB.
·[Marker Noise Off On]: Press 【Marker】→ [Marker Noise Off On] to
enable or disable the noise marker. If the ON state is selected, the noise
marker will be active. Read the noise power at which noise is normalized to
1Hz bandwidth near the active marker. In this case, the “RMS” mode of the
detector is active.
·[Counter Mkr Off On]: Press 【Marker】→[Counter Mkr Off On] to enable
or disable the marker counter function. If no marker is active but the marker
counter function is enabled, one mobile marker will be activated in the
middle of the screen.
·[Marker >>]: Press 【Marker】→[Marker→], and soft menus related to the
marker functions will pop up. Such menus are related to the frequency and
bandwidth of the spectrum analyzer and the normal or differential mode of
the marker. By using such marker functions, the user can change spectrum
analyzer settings with the marker as the reference.
·[Off]: Press 【Marker】→[Off] to disable the current marker and related
marker functions, such as: [marker Noise].
·[All Off]: Press 【Marker】→ [All Off] to disable all markers and related
marker functions, such as: [marker Noise].
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·[Marker→Center]: Press 【Marker】→ [Marker→]→ [Marker→Center].
The marker will move to the center frequency, and the center frequency will
be displayed on the screen.

Marker->
Marker->
Center Freq

·[Marker→CF Step]: Press 【Marker】→ [Marker→]→ [Marker→CF Step]
and set the step of the center frequency. The step is equal to the marker
frequency. If the differential marker function is activated, the frequency step
is equal to the frequency of the differential marker.

Marker->
CF Step
Marker->
Start

·[Marker→Start]: Press 【Marker】→ [Marker→]→ [Marker→Start], and
set the starting frequency as the marker frequency.

Marker->
Stop

·[Marker→Stop]: Press 【Marker】→ [Marker→]→ [Marker→Stop] and set
the stop frequency as the marker frequency.
>

·[Back]: Go back to the previous menu.

< Back

4.3.8 Peak menu

Peak
频率
Peak
Search
中心频率

Next
Peak >
扫宽

·[Maximum Peak]: Press 【Peak】→[Peak Search] to set one marker at the
peak of the trace. The marker frequency and amplitude will be displayed in
the right upper corner of the screen.
·[Next Peak]: Press 【Peak】→[Next Peak] to move the active marker to next
peak associated with the current marker location on the trace. The lower peak
can be rapidly found by repeatedly pressing this key.
·[Next Pk Left]: Press 【Peak】→[Next Pk Left] to find next peak on the left
side of the current marker location.

Next
Pk Left
起始频率

·[Next Pk Right]: Press 【Peak】→[Next Pk Right] to find next peak on the
right side of the current marker location.

Next
Pk Right
终止频率

·[Max Search]: Press【Peak】→[Max Search] to set one marker at the lowest
point of the trace. The marker frequency and amplitude will be displayed in
the right upper corner of the screen.

步进频率
Max Search
自动
手动
信号跟踪
Min Search
关
开
Peak
Track
信号标准
Off -- On
Marker->
信道号
Center
--

·[Min Search]: Press 【Peak】→[Min Search] to set one marker at the lowest
point of the trace. The marker frequency and amplitude will be displayed in
the right upper corner of the screen.
·[Peak Track Off On]: Press 【Peak】→[Peak Track Off On] to enable the
peak tracking function. The current marker will search the peak once after
each sweeping. Any operation will not be allowed if the peak tracking
function is disabled.
·[Marker→]: Press 【Peak】→ [Marker→] to set the marker frequency as the
center frequency. This function can be applied to rapidly move the signal to
the screen center.
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4.3.9 Mode menu
The default functional mode under the mode menu is the spectrum analyzer mode. You can add the
following functional options according to the needs: interference analyzer, AM-FM-PM analyzer, power
meter, channel scanner and field strength.

Mode
频率
Spectrum
Analysis
中心频率
Interference
>
扫宽
Analyzer
AM/FM/PM
起始频率
Analyzer
Power
Meter
终止频率
步进频率
Channel Scanner
自动
手动
Field Strength

·[Spectrum Analyser]: Press 【Mode】→ [Spectrum Analyzer] to enable the
spectrum analyzer mode.
·[Interference Analyzer]: Press 【Mode】→ [Interference Analyzer] to
enable the interference analyzer mode. Refer to Chapter V “Interference
Analyzer Mode” for details.
·[AM-FM-PM Demodulation]: Press 【Mode】→ [AM-FM-PM Analyzer]
to enable the AM-FM-PM analyzer mode. Refer to Chapter VII
“AM-FM-PM Analyzer Mode” for details.
·[Power meter]: Press 【Mode】→ [Power Meter] to enable the power meter
mode. Refer to Chapter VI “Power Meter Mode” for details.
·[Channel Scanner]: Press 【Mode】→ [Channel Scanner] to enable the
channel scanner mode. Refer to Chapter VIII “Channel Scanner Mode” for
details.
·[Field Strength]: Press 【Mode】→ [Field Strength] to enable the field
strength measurement mode. Refer to Chapter IX “Field Strength
Measurement Mode” for details.
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4.3.10 Sweep menu
The sweep time refers to the time required for the LO tuning of the spectrum analyzer within the selected
frequency interval, and directly affects the time of one test. It generally changes with the span, resolution
bandwidth and video bandwidth. In the auto mode, the minimum sweep time will be adopted by the
spectrum analyzer after measurement setting. The sweep time can be increased in the manual mode to meet
specific measurement needs.
The default sweep mode is linear sweeping, while list sweeping is optional. Multiple segment can be swept
continuously. The functions of editing, saving and recalling the list are available, thus facilitating the
operation.
·[Sweep Time Auto Man]: Press 【Sweep】→[Sweep Time Auto Man] to
adjust the sweep time of the spectrum analyzer. Use the number keys, step
keys or knob to adjust the sweep time. If “Man” is underlined, the sweep time
can be set manually. If “Auto” is underlined, the sweep time will be
automatically associated according to the resolution bandwidth, frequency
bandwidth and video bandwidth.

Sweep
Sweep Time
Auto Man
Sweep
Cont Single

·[Sweep Cont Single]: Press 【Sweep】→[Sweep Type] to enable the
continuous or single sweeping mode.

Sweep Once
Triggering
>
[Free Run]
Points
[1001]

>

Sweep
Sweeping Mode
Lin List
>

Save list

Recall list >
More
2 of 2
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·[Triggering]: Press 【Sweep】→ [Triggering] to select the triggering mode,
including [Free Run], [Video], [External], etc. Refer to the trigger menu for
details.
·[Points [1001]]: This is optional. Press 【Sweep】→[Points] to enable the
soft menu of points select. You can use soft keys such as [201], [501], [1001],
[2001], [4001] to set sweep points.

More
1 of 2

Edit list

·[Sweep Once]: Press 【Sweep】→ [Sweep Once] to sweep once again.

·[Sweep Mode Lin List]: Press 【Sweep】→[Sweep Mode] to enable the
linear or list mode. In the linear mode, sweeping will be performed based on
the linear frequency interval, and the frequency intervals of adjacent
measurement points are the same. The list mode is optional, in which
sweeping will be performed based on the set frequency range and other
parameters in the edited list.
·[Edit list]: This is optional. Press 【Sweep】→[Edit List] to enable the soft
menu of list editing. You can use soft keys such as [Add Seg], [Delete Seg]
and [Delete All] to manage and edit the sweep lit. The selected segment will
be in green. After editing the segment, press [Done] and [OK] to go back to
the sweep menu.
·[Save List]: This is optional. Press 【Sweep】→[Save List] to save the
current list into the spectrum analyzer for future recalling.
·[Recall List]: This is optional. Press 【Sweep】→[Recall List], and the list
dialog box will pop up, in which you can recall or delete the required list.
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4.3.11 Triggering menu
It is applied to select the triggering mode under “Sweep” or “Measure”, including [Free Run], [Video],
[External], [Slope] and [Delay]. The user can select the corresponding triggering mode based on the needs.
Triggering
Free Run

Video
External(TTL)
1.50V
Slope
Rising Falling
Delay
1.000us

·[Free Trigger]: When the previous single or continuous sweep finishes, the
next sweep or measurement is automatically triggered.
·[Video]: Set the trigger mode as [Video]. Once the input signal exceeds the
set video triggering level sweeping will be triggered. The trigger level value
can be set by the number keys, stepping keys or knob. The green line on the
screen indicates the selected trigger level.
·[External(TTL)]: Enable the [External] mode. Synchronize “Sweep” or
“Measure” with next voltage cycle.
·[Slope]: Control the positive or negative polarity of level triggering. The
rising edge will be applied for triggering in the case of positive polarity, and
falling edge in the case of negative polarity.
·[delayed]: The level triggering delay can be set. In this case, the spectrum
analyzer will wait for the delay time after receiving the external trigger signal
and before sweeping.

>

< Back
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4.3.12 Trace menu
This is applied to display the trace. You can enable [clear], [max], [min], etc. based on various test needs.
For example, if the maximum holding function of the trace is enabled in drift signal measurement, the
maximum peak amplitude and frequency drift of the input signal will be display.

Trace
频率
Trace
中心频率
1 2 3
Clear
Write >
扫宽

Max
Hold
起始频率

Min Hold
终止频率
步进频率
View
自动
手动
信号跟踪
Blank
关
开

·[Trace 1 2 3]: Press [Trace]→[Trace 1 2 3] to select the trace. Three traces
are available in the spectrum analyzer: 1, 2 and 3. The selected trace number
and status menu will be underlined.
·[Clear Write]: Press [Trace]→[Clear Write] to refresh all data of the
previous trace and continuously display the signal received by the spectrum
analyzer in the sweep mode.
·[Max Hold]: Press [Trace]→[Max Hold] to hold the maximum value of the
points on the selected trace. In addition, the value will be updated based on
the new maximum value detected in each sweeping. In the “Auto” mode of
the detector, the positive peak will be enabled.
·[Min Hold]: Press [Trace]→[Min Hold] to hold the minimum value of the
points on the selected trace. In addition, the value will be updated based on
the new minimum value detected in each sweeping. In the “Auto” mode of
the detector, the negative peak will be enabled.
·[View]: Press [Trace]→[View] to hold and display the amplitude data of the
selected trace. Such data are not updated in the sweeping mode of the
spectrum analyzer.
·[Blank]: Press [Trace]→[Blank] to start background processing, without
display on the screen.
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4.3.13 Limit menu

Limit

·[Limit Upper Lower]: Press 【Limit】→[Limit Upper Lower] to set the
current limit as the upper or lower limit.

Limit
Upper
Lower

·[Display Off On]: Press 【Limit】→ [Display Off On] to enable or disable
the limit function.

Display
Off
On

·[Test Off On]: Press 【Limit】→ [Test Off On] to enable or disable the limit
test.

Test
Off
On

·[Edit Limit]: Press 【Limit】→ [Edit Limit], including [Frequency],
[Amplitude], [Add Point], [Delete Point], [Left Point], [Right Point]
and [Default Limit], to view the frequency and amplitude of the limit point,
and add or delete the limit point.

Edit Limit >
Margin
0.0dB
Alarm
终止频率
Off
On
步进频率
Save Limit
自动
手动
信号跟踪
Recall Limit >
关
开

·[Margin]: Press 【Limit】→ [Margin] to set the offset allowance.
·[Alarm Off On]: Press 【Limit】→[Alarm Off On] to enable or disable the
audio alarm. The enabled audio alarm will be valid when the upper or lower
limit test is ON. The buzzer will utter a short sound if the value is beyond the
upper and lower limit during sweeping of the current screen.
·[Save Limit]: Press 【Limit】→ [Save Limit] to save the limit.
·[Recall Limit]: Press 【Limit】→ [Recall Limit], including [Head], [Tail],
[Page Up], [Page Down], [Done], [Delete] and [Cancel] to recall or delete the
saved limit.
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4.3.14 Measurement menu
·[Field Strength]: Press 【Measure】→[Field Strength] to enable the field
strength measurement function and recall the related functional menu. Refer
to the [Field Strength] menu description for details.

Measure
Field Strength>

Channel Power

OBW

>

ACPR

>

Emission Mask>

C/N
>
终止频率
步进频率
All Meas
自动 Off 手动
信号跟踪
More
>
关1 of 2开

Measure
Tune
Listen

>

IQ Capture >

All Meas
Off
More 2/2 >
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·[Channel Power]: Press 【Measure】→[Channel Power] to enable the
channel power function and recall the related functional menu. Refer to
[Channel Power] menu description for details.
·[OBW]: Press 【Measure】→[OBW] to enable the occupied bandwidth
function and recall the related functional menu. Refer to [OBW] menu
description for details.
·[ACPR]: Press 【Measure】→[ACPR] to select the adjacent channel power
function and recall the related functional menu. Refer to [ACPR] menu
description for details.
·[Emission mask]: Press 【Measure】→[Emission Mask] to enable the
emission mask function and recall the related functional menu. Refer to
[Emission Mask] menu description for details.
·[C/N]: Press 【Measure】→[C/N] to enable the C/N measurement function
and recall the related functional menu. Refer to [C/N] menu description for
details.
·[All Meas Off]: Press 【Measure】→ [All Meas Off] to disable measurement
functions.
·[Tune Listen]: Press 【Measure】→ [More 1/2]→ [Tune Listen] to enable
the tune listening function. Refer to [Tune Listen] menu description for
details.
·[IQ Capture]: Press 【Measure】→ [More 1/2]→ [IQ Capture] to enable the
IQ capture function. Refer to [IQ Capture] menu description for details.
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The spectrum analyzer has the function of field strength measurement, including soft menus such as [Field
Strength Off On], [Recall Antenna], [Edit Antenna] and [Save Antenna]. The field strength can be rapidly
tested with such menus and corresponding test antennas.
Field Strength
Field Strength
Off
On
Recall Antenna

Edit Antenna

Save Antenna

>

·[Field Strength Off On]: Press 【Measure】→ [Field Strength]→ [Field
Strength Off On] to enable or disable the field strength measurement
function.
·[Recall Antenna]: Press 【Measure】→ [Field Strength]→ [Recall Antenna],
and soft menus such as [Head], [Tail], [Page Up], [Page Down],
[Done] and [Delete] will pop up, you can select and recall the saved
antenna factor file in the spectrum analyzer.
·[Edit Antenna]: Press 【Measure】→ [Field Strength]→ [Edit Antenna], and
soft menus such as [Add Point], [Delete Point], [Delete All], [Done]
and [Cancel] will pop up. You can edit the antenna factor.
·[Save Antenna]: Press 【Measure】→ [Field Strength]→ [Save Antenna] to
save the antenna factor.
·[Back]: Press 【Measure】→ [Field Strength]→ [Back] to exit the field
strength menu and go back to the “Measure” menu.

< Back

The spectrum analyzer has the function of channel power measurement. You can measure the channel
power of the signal by setting relevant parameters in the functional menu and selecting the appropriate
resolution bandwidth and span. Refer to the channel power measurement requirements in the first section of
this chapter for specific operations.
·[Channel Pwr Off On]: Press 【Measure】→ [Channel Power]→ [Channel
Pwr Off On] to enable or disable the channel power measurement function.
·[Center Freq]: Press 【Measure】→ [Channel Power]→ [Center Freq] and
set the center frequency with number keys.

Channel Pwr
Channel Pwr
Off
On

·[Channel BW]: Press 【Measure】→ [Channel Power]→ [Channel BW] and
set the channel bandwidth with number keys.

Center Freq

·[Span]: Press 【Measure】→ [Channel Power]→ [Span] and set the channel
span with number keys.

Channel BW

[Special attention]: The channel power bandwidth refers to the
frequency width of the power displayed by the spectrum analyzer within
the bandwidth, while the channel power span refers to the sweeping
frequency range of the spectrum analyzer. The channel power span
should be more than or equal to the channel power bandwidth.
Otherwise, the channel power bandwidth will be automatically set to be
equal to the channel power span. The ratio of the channel power span to
channel power bandwidth is a constant. It remains unchanged when the
channel power span is changed. You can change this ratio by changing
the channel power bandwidth. For example, when the channel power
span is doubled, the channel power bandwidth will be increased by the
same times.

Span

>

< Back
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Results can be rapidly, clearly and accurately in occupied bandwidth measurement of the spectrum analyzer.
Depending on the modulation mode, two methods can be applied to calculate the occupied bandwidth:
power percentage and power drop dBc. The user can select the appropriate occupied bandwidth
measurement method according to the needs. Refer to the occupied bandwidth measurement requirements
in the first section of this chapter for specific operations.
·[OBW Off On]: Press 【Measure】→ [OBW]→ [OBW Off On] to enable or
disable the occupied bandwidth measurement function.

OBW
OBW
Off
On

·[Method]: Press 【Measure】→ [OBW]→ [Method % dBc] to select the
appropriate test method, including percentage and drop dBc. In the
percentage method, the occupied bandwidth of the signal is obtained by
calculating the bandwidth of the frequency of certain percentage to the total
power of the transmitted power, and the power percentage can be set by the
user. In the drop dBc method, the occupied bandwidth is defined as follows:
spacing between two frequency points corresponding to signal power drop by
dBc on both sides of the frequency point where the signal peak power is. The
signal power drop dBc can be set by the user.

Method
%
dBc
%
99.00%
dBc
-3.00dB

·[%]: Press 【Measure】→ [OBW]→ [%] to set the power percentage in the
percentage method.

Span

>

< Back
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·[dBc]: Press 【Measure】→ [OBW]→ [dBc] to set the signal power drop
dBc in the power drop dBc method.
·[Span]: Press 【Measure】→ [OBW]→ [Channel Sweep] to set the sweeping
frequency bandwidth of occupied bandwidth measurement.
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The spectrum analyzer has the function of adjacent channel power ratio measurement. The user can obtain
measurement results by setting relevant parameters of the channel. By using the limit test function, the user
can define the adjacent channel limits so as to easily observe whether the adjacent channel power exceeds
the set range. Refer to the requirements of adjacent channel power ratio measurement in the first section of
this chapter for specific operations.
·[ACPR Off On]: Press 【Measure】→ [ACPR]→ [ACPR Off On] to enable
or disable the ACPR measurement function.

ACPR
ACPR
Off
On

·[Center Freq]: Press 【Measure】→ [ACPR]→ [Center Freq] and set the
center frequency with number keys.
·[Main Ch BW]: Press 【Measure】→ [ACPR]→ [Main Ch BW] and set the
main channel bandwidth with number keys.

Center Freq
Main Ch BW
3.000MHz

·[Adj Ch BW]: Press 【Measure】→ [ACPR]→ [Adj Ch BW] and set the
adjacent channel bandwidth with number keys.

Adj Ch BW
3.000MHz

·[Ch Spacing]: Press 【Measure】→ [ACPR]→ [Ch Spacing] and set the
channel spacing with number keys.

Ch Spacing
3.000MHz

More
1 of 2

>
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ACPR
Limit Test
Off
On
Upper Limit
0.0dB
Lower Limit
0.0dB

·[Limit Test Off On]: Press 【Measure】→ [ACPR]→ [Limit Test Off On] to
enable or disable the upper and lower limit test of the adjacent channel
power.
·[Upper Limit]: Press 【Measure】→ [ACPR]→ [Upper Limit] to set the
upper limit of the power of the adjacent channel test.
·[Lower Limit]: Press 【Measure】→ [ACPR]→ [Lower Limit] to set the
lower limit of the power of the adjacent channel test.
[Special note]: If ACPR exceeds the set limit in the limit test, the screen
background will turn red as the mark.

More
2 of 2
< Back

77

Chapter IV Spectrum Analyzer Mode

The spectrum analyzer has the C/N measurement function, which is applied to measure the ratio of the
carrier power to noise power.
·[C/N Off On]: Press 【Measure】→ [C/N]→ [C/N Off On] to enable or
disable the C/N function.

C/N
C/N
Off

On

Center Freq
Carrier BW
3.000MHz
Noise BW
3.000MHz
Offset
3.000MHz

< Back
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·[Center Freq]: Press 【Measure】→ [C/N]→ [Center Freq] and set the
center frequency of measurement with number keys.
·[Carrier BW]: Press 【Measure】→ [C/N]→ [Carrier BW] and set the
carrier bandwidth with number keys. The default setting is 3MHz.
·[Noise BW]: Press 【Measure】→ [C/N]→ [Noise BW] and set the noise
bandwidth with number keys. The default setting is 3MHz.
·[Offset]: Press 【Measure】→ [C/N]→ [Offset] and set the frequency offset
with number keys. The default setting is 3MHz.
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The emission mask function is applied to measure whether the signal power exceeds the mask limits, where
the limits are recalled as the masks. The mask can be moved right and left or up and down according to the
center frequency and reference power. In the mask, the limit center is always moved right and left to the
center frequency, and also moved up and down to the reference power point based on the calculated
reference power.
Emission Mask
Emission Mask
Off
On
Channel BW
1.000MHz
Recall Limit
>
as Mask
Ref power
Peak Ch
Peak Markers
Off
On
Page Up
终止频率
步进频率
Page Down
自动
手动
信号跟踪
< Back
关
开

·[Emission Mask Off On]: Press 【Measure】→ [Emission Mask]→
[Emission Mask Off On] to enable or disable the emission mask function.
·[Channel BW]: Press 【Measure】→ [Emission Mask]→ [Channel BW] and
set the reference channel bandwidth with number keys.
·[Recall Limit]: Press 【Measure】→ [Emission Mask]→ [Recall Limit], and
relevant soft menus will pop up, including [Head], [Tail], [Page Up],
[Page Down], [Done] and [Delete]. The user can select the limit file to be
recalled.
·[Ref power]: Press 【Measure】→[Emission Mask]→[Ref Power] to set the
reference power setting mode. The peak power or channel power may be
used as the reference power.
·[Peak Markers Off On]: Press 【Measure】→ [Emission Mask]→ [Peak
Markers Off On] to enable or disable the peak marker.
·[Page Up]: Press 【Measure】→ [Emission Mask]→ [Page Up] to view the
information on the previous page.
·[Page Down]: Press 【Measure】→ [Emission Mask]→ [Page Down] to
view the information on the following page.
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By using the IQ capture function, the original IQ data can be captured according to the capture time,
sample rate and capture mode set by the user, and data files can be saved for data analysis.
IQ Capture

·[IQ Capture Off On]: Press 【Measure】→ [More 1/2]→ [IQ Capture]→
[IQ Capture Off On] to enable or disable the IQ capture function.

IQ Capture
Off
On

·[Start Capture]: Press 【Measure】→ [More 1/2]→ [IQ Capture]→ [Start
Capture] to start IQ capture.

Start Capture

·[Capture time]: Press 【Measure】→ [More 1/2]→ [IQ Capture]→ [Capture
Time] to set the IQ capture time.

Capture time
1.000ms
Capture Mode
Single Cont
Sample Rate
5.000MHz
Triggering
>
[Free Run]

·[Sample Rate]: Press 【Measure】→ [More 1/2]→ [IQ Capture]→ [Sample
Rate] to set the sample rate of IQ capture.

Save Name
IQCapture

·[Triggering]: Press 【Measure】→ [More 1/2]→ [IQ Capture]→
[Triggering] to set the triggering mode, including [Free Run] and
[External]. In the [External] mode, [Slope] and [Delay] can be set.

< Back

·[Save Name IQCapture]: Press 【Measure】→ [More 1/2]→ [IQ
Capture]→ [Save Name] to save the captured data.

Tune & Listen
Tune & Listen
Off
On
Demod type
>
FM
Listen Time
100.00ms

Volume
95
>
信号跟踪
< Back
关
开

·[Tune Listen Off On]: Press 【Measure】→ [More 1/2]→ [Tune Listen]→
[Tune Listen Off On] to enable or disable the tune listening function.
·[Demod type]: Press 【Measure】→ [More 1/2]→ [Tune Listen]→ [Demod
Type] to set the demodulation type. The following demodulation types are
available: [FM], [AM], [USB] or [LSB].
·[Demod Time]: Press 【Measure】→ [More 1/2]→ [Tune Listen]→ [Demod
Time] to set the listening time.
·[Listen Mode]: Press 【Measure】→ [More 1/2]→ [Tune Listen]→ [Listen
Mode] to set the listening mode. The default setting is the intermittent
listening mode, in which the data will be listened for the set listening time
after sweeping of one screen, and the above cycle is repeated. In the
continuous mode, data will not be swept but will be continuously listened
after sweeping of one screen.

Listen Mode
Int Cont
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·[Capture Mode]: Press 【Measure】→ [More 1/2]→ [IQ Capture]→
[Capture Mode] to enable the single or continuous IQ capture. In the single
mode, the data will be captured once only. In the continuous mode, the data
will be captured once after each sweeping of the stroke, and capturing will
not be stopped until otherwise set by the user.

·[Volume]: Press 【Measure】→ [Tune Listen]→ [Volume] to set the
loudspeaker volume in the tune listening mode.
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4.3.15. Signal source menu (option)
·[Signal

Source

Off

On]:

press

【 Measure 】 → [More

1

of

2]→[Generator]→[Generator Off On], to activate or deactivate the signal source.
·[Tracking Mode Off On]: press 【Measure】→[More 1 of 2] →[Signal Source]
→[Mode CW Track], to activate or deactivate the signal source tracking mode.
·[Special Notice]: the tracking mode switch is effective when the signal
source switch is started. In case of Off, the independent source mode and the
point frequency source output will be activated independent of spectral
analysis. At this time, the set point frequency and output power menus will
be effective but the transmission measurement, power offset and frequency
offset menus are ineffective; in case of Track, the tracking mode will be
activated, the synchronous scanning will be done at signal source frequency
and spectral analysis mode frequency, the set point frequency menu will be
infective, and the output power, power offset, frequency offset and
transmission measurement will be effective.

Generator
Generator
Off On
Mode
CW Track

·[power 0.0 dBm]: press 【Measure】→[More 1 of 2] →[Generator] →[Power
0.0dBm], to change the output power by using number key or key 【↑】 or

Power

【↓】.

0.0dBm

·[Special Notice]: the output power range is -40dBm~0dBm with step size of
1dB.

CW Freq
1.000GHz
Trans
Meas
Power Offset
0.0dB
Freq Offset
0.000Hz
<

Back

>

·[CW Freq 1.000GHz]: press 【Measure】→[More 1 of 2] →[Generator] →
[CW Freq 1.000GHz], to change the CW frequency by using number key or key
【↑】 or 【↓】.
·[Trans Meas]: press 【Measure】→[More 1 of 2]→[Generator]→[Trans Meas], to
activate the sub-menu of transmission measurement. For details, please refer to
the instructions of transmission measurement menu.
·[Power Offset 0.0dB]: press【Measure】→[More 1 of 2]→[Generator] →[Power
Offset 0.0dB]. When there is gain or loss between generator output and
peripheral equipment, it is allowed to use this parameter to set the signal source
power offset so as to indicate the actual power of system. This parameter cannot
change the actual output power of generator but its power reading.
·[Special Notice]: The parameter range is -200dB~200dB with default value
of 0dB and step size of 1dB, which is effective when the tracking mode is
activated.
·[Freq Offset 0.000Hz]: press【Measure】→[More 1 of 2] →[Generator] →
[Freq Offset 0.000Hz], to set the offset value of generator output signal frequency
and current spectrometer scan frequency.
·[Special Notice]: The parameter range is -300MHz~300MHz with default
value of 0Hz, which is effective when the tracking mode is activated. The
frequency offset must be set to ensure that the generator can reach the
maximum frequency at 100kHz.
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Trans Meas
Normalize
Off On

·[Normalize Off On]: press【Measure】→[More 1 of 2] →[Generator] →[Trans
Meas] → [Normalize Off On], to activate or deactivate the normalized
measurement.
·[Ref Level 0.0dB]: press【Measure】→[More 1 of 2] →[Generator] →[Trans
Meas] →[Ref Level 0.0dB], to activate the normalized and adjust the ref level so
as to adjust the vertical position of trace on screen.

Ref Level

·[Special Notice]: The parameter range is -200dB~200dB with default value
of 0dB and step size of 1dB, which is effective when the tracking mode and
normalized are activated.

0.0dB

·[Ref Position 0]: press【Measure】→[More 1 of 2] →[Generator] →[Trans

Ref Position

Meas] →[Ref Position 0], to activate the normalized and adjust the ref position
so as to adjust the vertical position of normalized ref level on screen.

0
Scale/Div
10.0dB
Store
Mem Trace
Mem Trace
Off On

·[Special Notice]: The parameter range is 0~10 with default value of 5 and
step size of 1, which is effective when the tracking mode is activated.
·[Scale/Div 10.0dB]: press【Measure】→[More 1 of 2] →[Generator] →[Trans
Meas] →[Scale/Div 10.0dB], to activate the normalized and adjust the scale/div
so as to adjust the Y-axis precision of trace on screen.
·[Special Notice]: The parameter range is 0~10 with default value of 5 and
step size of 1, which is effective when the tracking mode is activated.
·[Store Mem Trace]: press【Measure】→[More 1 of 2] →[Generator] →[Trans
Meas] →[Store Mem Trace]. It is allowed to save the data of current mem trace.
·[Mem Trace Off On]: press【Measure】→[More 1 of 2] →[Generator] →

<
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[Trans Meas] →[Mem Trace Off On]. Set whether the mem trace is displayed or
not.
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4.3.16 File menu

File
Save State

Recall state >

·[Save State]: Press [File]→[Save State] to save the current sweeping
parameters.
·[Recall state]: Press [File]→ [Recall State], and the state file list will pop
up, including relevant soft menus such as [Head], [Tail], [Page Up],
[Page Down], [Done] and [Delete]. You can read the saved state file and
recall the corresponding state parameters into current sweeping.
·[Save Data]: Press [File]→ [Save Data] to save the trace data.

Save Data

Recall Data >

Save Pic

·[Recall Data]: Press [File]→ [Recall Data], and the data file list will pop,
including relevant soft menus such as [Head], [Tail], [Page Up], [Page
Down], [Done] and [Delete]. You can read the saved data file and recall
the corresponding state parameters into current sweeping.
·[Save Pic]: Press [File]→ [Save Pic] to capture the current screen picture.
·[Default State]: Press [File]→[Default State] to recover the default setting.

Default State

File Manager >
Location
>
[Internal]

·[File Manager]: Press [File]→ [File Manager] and the file manager menu
will pop up, including relevant soft menus such as [Src File], [Dst File],
[Copy] and [Delete File]. You can copy and delete the file.
·[Location]: Press [File]→[Location] to select the saving location.
“Internal” means the internal memory, while “Others” means the memory
with the USB interface and SD card. If the security characteristics are
selected, the internal memory will not be available.

4.3.17 System menu
The system menu lists the system-related settings of 4024 series spectrum analyzer. In addition to the
date/time, date format, system language, network setting and frequency reference, characteristic menus
such as the LO nulling alignment, GPS positioning (optional) and power saver are available.
4024 series spectrum analyzer has the function of LO nulling alignment, which is conducive for LO null
calibration when required. To accurately measure the amplitude of the signal with the frequency below
5MHz, attention should be paid to the zero-frequency signal. If the zero-frequency signal is
above >-20dBm, LO null calibration should be performed so as to prevent gain compression caused by too
large amplitude of the zero-frequency signal.
The optional GPS positioning function of 4024 series can be achieved with the external GPS antenna. The
user can view the number of current satellites in service and the longitude, latitude and altitude information.
This function is applicable to accurate positioning in fields.
In the power saver mode, the spectrum analyzer will enter the sleep state in the case of no operation within
the sleep time, including shutdown of the LCD, internal module power, etc. If any key is pressed again, the
spectrum analyzer will exit the sleep state and change into the normal operating mode.
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·[AliLO Nulling]: Press [System]→[AliLO Nulling] to enable the LO
nulling alignment function. The user can easily apply this function when
required. Alignment results will be saved in the internal memory of the
instrument.

System
Align LO Nulling
Date
Time

>

Display

>

GPS

>

LAN

>

·[Date]: Press [System]→ [Date/Time] to set the date and time.
·[Display]: Press [System]→ [Display] to set the display mode, including
relevant settings of [Default], [Black & White], [Night Vision] and
[Brightness].
·[GPS]: Press [System]→ [GPS] and soft menus related to GPS will pop up,
including [GPS Off On], [GPS Info] and 【Preset】. You can enable or
disable the GPS function, view GPS details and reset GPS.
[Special note]: The GPS positioning function is optional.
·[LAN]: Press [System]→ [LAN] to set the network setting of the spectrum
analyzer, including [Prev], [Next], [IP], [Mask] and [Gateway].

Freq Ref
Int
Ext

·[Freq Ref Int Ext]: Press [System]→[Freq Ref Int Ext] to select the internal
or external frequency reference according to the needs.

RF Out
Off
On

·[Ref Output Off On]: Press [System]→[Ref Output Off On] to enable or
disable the interval reference according to the needs in the internal reference
mode.

More
1 of 2

>

[Special note]: The external reference frequency must be 10MHz±100Hz,
and the amplitude must be 0dBm (range: -2dBm to +10dBm). The
external reference frequency must be applied through the “10MHz
reference input” of the cover.
·[language]: Press [System]→ [Language] to set the language, including
[simplified Chinese] and [English].

System
Language >

Power Saver >

·[Power Saver]: Press [System]→ [Power Saver] to set the auto sleep and
auto shutdown mode, including [Sleep Off On], [Sleep], [Shut Down
Off On] and [Shut Down], so as to minimize power loss.
·[System Info]: Press [System]→[System Info] to view the system
information, including the application software version, custom image
version, etc.

System
information

·[Date Format]: Press [System]→ [Date Format] to set the date format.
Error Log >

Date Format >
Title
Off
On
Admin
More
2 of 2
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·[Error Log]: Press [System]→ [Error Log] and relevant soft menus will
pop up, including [Head], [Tail], [Page Up], [Page Down] and
[Delete All]. You can view relevant error information.
·[Tip Off On]: Press [System]→ [Tip Off On] to select the current title of the
name.
·[Admin]: Press [System]→[Admin] and enter the administrator password to
perform system administration and setting.
[Special note]: The administration function is only available to the
factory commissioning personnel or technical support personnel when
required, and must not be applied by the user; otherwise, the instrument
may be damaged.

Chapter V Interference Analyzer Mode (optional)

Chapter V Interference Analyzer Measurement Mode (optional)
Section 1 Introduction to Typical Measurements
The interference analyzer mode is an extension of the spectrum analyzer mode. In 4024 series spectrum
analyzer, the interference analyzer mode is divided into the following three modes:
Spectrum measurement (refer to the relevant chapter of spectrum analysis requirements for specific
operations, not repeated here);
Spectrogram measurement;
Received signal strength indicator (RSSI) measurement.
All operations in this chapter are based on the interference analyzer mode,

Caution

which will not be described separately below.

5.1.1 Spectrogram measurement
The cyclic or intermittent signal can be easily observed in the 3D spectrogram display, i.e. frequency,
amplitude and time. The time signal amplitudes are reflected by various colors in the spectrogram display.
In order to better observe the measured signal, the following steps can be taken:
a)

Press【Freq】→[Span]→[Full Span] and 【Peak】 to obtain the maximum value of the current signal.
Then press [Marker→Center] and set the current peak as the center frequency. In this case, the
maximum value will be displayed at the center of the trace zone.

b)

Press 【BW】→[RBW Auto Man] and set the appropriate resolution bandwidth with the number keys,
【↑】, 【↓】 or knob. Similarly, set the appropriate video bandwidth.

c)

Press 【Ampt】→[Ref Level] and set the current maximum point close to the top of the display zone.
Press [Scale/Div] and set the appropriate scale/division to facilitate viewing

d)

Press [Record]→ [Sweep Interval Auto] and set the sweep interval.
If the sweep interval is more than 0, the trace will be in the maximum holding

Caution

state, so as to ensure that the maximum value of the signal in each sweeping
will be displayed on the screen.

e)

Press 【Sweep Time】 and set the record time. Then press [Auto Save Off On] to enable the auto
saving mode. In this case, the data will be saved automatically after sweeping of one screen.

f)

Press 【Record】→[Time Cursor] and move the horizontal line with the number keys, 【↑】, 【↓】
or knob in the vertical direction of the spectrogram. The following spectrogram will display the trace
information on the line.
If the time marker value is more than 0, the trace and spectrogram will not be

Caution
g)

refreshed.

The interference analyzer mode of 4024 series spectrum analyzer involves six independent markers,
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which are used for reading the amplitude and frequency corresponding of the marker. Specific
operations are as follows: [Maker]→[Marker 1 2 3 4 5 6].
h)

Press [File]→[Save Pic] to save the current spectrogram information in the picture form.

The spectrogram test structure is in Fig. 5-1 (the displayed contents vary from parameter settings, and Fig.
5-1 only show an example).

Fig. 5-1 Interference Analyzer Spectrogram

5.1.2 RSSI measurement
RSSI measurement is mainly applied to measure the strength changes of one CW signal within a certain
period.
In order to better observe the measured signal, the following steps can be taken:
a)

Press [Record]→[Sweep Interval] to set the sweep interval, which represents the sweep time between
two adjacent points in each sweeping.

b)

Press [Record]→[Sweep Time] to set the span record time. After reaching the set span time, the
display interface will not be refreshed.

c)

Press [Record]→[Auto Save Off On] to enable the auto saving function. The data will be
automatically saved into the file after sweeping of each screen.
If the span time is set, only the latest data points on the screen will be recorded,

Caution

instead of all data points within the whole span.

The RSSI test structure is shown in Fig. 5-2 (the displayed contents vary from parameter settings and Fig.
5-2 only show an example).
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Fig. 5-2 RSSI Test Diagram of Interference Analyzer
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Section 2 Structure of Interference Analyzer Menu
Frequency

Span

Amplitude

BW

Detector

Center Freq

Full span

Ref
Level
0.0dBm

Res BW
Auto
Manual

Auto

Span >

Zero Span

Ref Position

Video BW
Auto
Manual

Normal

Start Freq

Last span

Atten
Auto Man

Average
Off
On

Peak

Stop Freq

< Back

Scale/Div
20.0dB

SPAN/RBW
100

Neg Peak

Units
dBm

RBW/VBW
1

Sample

CF Step
Auto
Man
Signal Std
>
--

Pre Amp
Off
On

Detector >
Auto

Average

Channel
--

RMS

< Back

Signal Std

Marker

Marker->

Peak

Sweep

Header

Marker
123456

Marker->
Center

Peak Search

Sweep Time
Auto
Man

Tail

Normal

Marker->
CF Step

Next Peak

Page up

Delta

Marker->
Start

Next Pk Left

Page down

Noise Marker
Off
On

光标->
Marker->
Stop
终止频率

Next Pk Right

Done

Marker >

< Back

Max Search

>

Cancel

Off

Min Search

All Off

Marker->
Center

Fig. 5-3 Overall Block Diagram of Interference Analyzer Menu
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Record

Measure

Sweep Interval
Auto

Spectrum

Sweep Span
Auto
Record
Off
On

File

File Manager

Header

Save State

Src File

Spectrogram

Footer

Recall state >

Dst File

RSSI

Page up

Save Data

Copy

Page down

Recall Data >

Delete Src File

Immediately call

Save Pic

< Back

Delete

Default State

Delete all

File
Manager

Cancel

Location
Internal

Time Cursor
0
>
Trace
Restart
Clear Write

Max Hold

Min Hold

Location
>
Internal
>
SD

USB

Fig. 5-4 Overall Block Diagram of Interference Analyzer Menu (continued)
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Section 3 Description of Interference Analyzer Menu
5.3.1 Frequency menu
·[Center Freq]: Press 【Freq】→[Center Freq], and set it with number keys
on the front panel. Select [GHz], [MHz], [kHz] or [Hz] in the frequency unit
menu or set the center frequency with the 【↑】or 【↓】key or knob.
[Special note]: When the 【↑】or 【↓】 key or knob is applied, the
frequency step should be the same as the set value of [Step Freq]. You
can set the step frequency with the number keys or 【↑】 or 【↓】 key or
knob after changing [CF Step Auto Man] into [CF Step Auto Man].
Frequency

·[Span]: Press →[Span] to activate the span menu. Set the span with the
number keys, and select the frequency unit, or set the span with the 【↑】 or

Center Freq

【↓】 key or knob. Refer to [Span] menu description for details.

Span >

Start Freq

[Special note]: When the span is changed with the 【↑】 or 【↓】 key or
knob, the step should be 1-2-5 (the RSSI mode must be set under zero
span).
·[Start Freq]: Press 【Freq】→[Start Freq], and set it with number keys on
the front panel. Select the frequency unit, or set the value with the 【↑】 or

Stop Freq
CF Step
Auto
Man
Signal Std
>
-Channel
--

【↓】 key or knob.
·[Stop Freq]: Press 【Freq】→[Stop Freq], and set it with number keys on the
front panel. Select the frequency unit, or set the value with the 【↑】 or 【↓】
key or knob.
·[Signal Std]: Press【Freq】→[Signal Std] and select the signal standard with
the 【↑】 or 【↓】 key or knob, recall the signal standard by [Done] or [OK]
in the dialog box. Refer to the dialog box for details.
[Special note]: When the signal standard is applied, the center frequency
and span will be set as those defined in the signal standard.
·[Channel ]: Press 【Freq】→[Channel], and the channel setting dialog box
will pop up. Set the channel with the number keys or 【↑】 or 【↓】 key or
knob.
[Special note]: The channel should be set based on the applied signal
standard; otherwise, the prompt that setting is not allowed will pop up.
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5.3.2 Span menu
·[Span]: Press 【Freq】→[Span] to activate the span menu. Set the span with
the number keys, and select the frequency unit, or set the span with the 【↑】
or 【↓】 key or knob. Refer to [Span] menu description for details.
Span
Full span

[Special note]: When the span is changed with the 【↑】 or 【↓】 key or
knob, the step should be 1-2-5.

Zero Span

·[Full span]: Press 【Freq】→ [Span]→ [Full Span] and set the current span
as 44.1GHz.

Last span

·[Span]: Press 【Freq】→ [Span]→ [Zero Span] and set the current span as
0Hz.

< Back

·[Last span]: Press 【Freq】→ [Span]→ [Zero Span] and recover the last
span.
·[Back]: Press 【Freq】→ [Span]→ [Back] to go back to the 【Freq】 menu.
[Special note]: The RSSI mode must be enabled under zero span.

5.3.3 Amplitude menu

Amplitude
Ref
Level
0.0dBm

·[Ref level]: Press 【Ampt】→ [Ref Level] and set it withe number keys on
the front panel. Select [dBm], [-dBm], [mV] or [uV] in the frequency
unit menu, or set the value with the 【↑】 or 【↓】 key or knob.
[Special note]: When the 【↑】 or 【↓】 key or knob is applied, the step
should be 10dB.
·[Ref position]: Press 【Ampt】→ [Ref Position], and set the reference

Ref Position
Atten
Auto Man
Scale/Div
20.0dB
Units
dBm
Pre Amp
Off
On

position with the number keys or 【↑】 or 【↓】 key or knob.
·[Atten Auto Man]: Press 【Ampt】→[Atten Auto Man] to enable the auto or
manual mode of the attenuator. You can change the mode with the number
keys or the 【↑】 or 【↓】 key or knob.
[Special note]: The attenuation range is 0dB - 60dB, with the step of
10dB.
·[Scale/Div]: Press 【Ampt】→[Scale/Div] and set it with the number keys or
the 【↑】 or 【↓】 key or knob. The scale/division setting range is
0.1dB-20dB.
·[Units]: The amplitude unit is dBm in the interference analyzer mode.
·[Pre Amp Off On]: Press 【Ampt】→[Pre Amp Off On] to turn on or off the
pre-amplifier.
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5.3.4 Bandwidth menu
·[Res BW Auto Man]: Press 【BW】→ [Res BW Auto Man], and set it with
the number keys on the front panel or the 【↑】 or 【↓】 key or knob.

BW

[Special note]: The resolution bandwidth depends on the bandwidth of
the IF filter, while the trace shape depends on the filter of IF bandwidth.
This instrument supports variable resolution bandwidth settings from
1Hz to 10MHz, with the step of 1-3-10.
·[Video BW Auto Man]: Press 【BW】→ [Video BW Auto Man] and change

Res BW
Auto
Manual

it with the number keys or the 【↑】 or 【↓】 key or knob.

Video BW
Auto
Manual

[Special note]: The video bandwidth filter is used for smoothing the trace
so as to improve the ability to detect weak noise signals. This instrument
supports variable resolution bandwidth settings from 1Hz to 10MHz,
with the step of 1-3-10.

Average
Off
On
SPAN/RBW
100

·[Average Off On]: Press 【BW】→ [Average Off On]. The averaging
function can be used smoothing the displayed trace without changing the
video bandwidth filter. It can be changed with the number keys or the【↑】or
【↓】 key or knob.

RBW/VBW
1
Detector >
Auto

·[SPAN/RBW]: Press 【BW】→ [SPAN/RBW] to set the ratio of the span to
resolution bandwidth. In the auto mode, the resolution bandwidth will change
automatically with the span. This ratio can be changed with the number keys
or the 【↑】 or 【↓】 key or knob.
·[RBW/VBW]: Press 【BW】→ [RBW/VBW]. In the auto mode, the video
bandwidth will change automatically with the resolution bandwidth. This
ratio can be changed with the number keys or the 【↑】 or 【↓】 key or knob.
·[Detector]: Press 【BW】→ [Detector] to enable the detector function menu.
Refer to [Detector] menu for details.
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·[Auto]: Press 【BW】→ [Detector] → [Auto] to enable the spectrum
Detector
Auto

Normal

Peak

Neg Peak

Sample

Average

RMS

< Back

analyzer mode of the detector.
·[Normal]: Press 【BW】→ [Detector] → [Normal] to enable the most
commonly used detector mode. You can see the signal and noise floor at the
same time, with no signal loss.
·[Peak]: Press 【BW】→ [Detector] → 【Peak】 to prevent missing of any
peak signal. This function can be applied to measure the signal close to the
noise floor.
·[Neg Peak]: Press 【BW】→ [Detector] → [Neg Peak]. This function is
used in self-inspection of the MMW integrated test instrument in most cases
and rarely in tests. By using this function, the modulation envelope of AM
signal can be well reproduced.
·[Sample]: Press 【BW】→ [Detector] → [Sample]. This function is
conducive for noise signal measurement. Compared with the normal mode of
the detector, noise can be better measured.
·[Average]: Press 【BW】→ [Detector] → [Average] to average the data
within the sampling interval.
·[RMS]: Press 【BW】→ [Detector] → [RMS] to obtain the RMS value of
the data within the sampling interval.

5.3.5 Marker menu

Marker
Marker
123456
Normal

·[Marker 1 2 3 4 5 6]: Press 【Marker】→ [Marker 1 2 3 4 5 6] to change
various markers. The selected marker will be underlined.
·[Normal]: Press 【Marker】→[Normal] to enable the normal mode of the
current marker.
·[Delta]: Press 【Marker】→[Delta] to display the amplitude difference and
frequency difference (time difference under zero bandwidth) of two markers.
Move the active marker with the knob, step keys or number keys. The default
amplitude difference is in dB.

Delta
Noise Marker
Off
On
Marker >

Off

·[Marker Noise Off On]: Press 【Marker】→[Marker Noise Off On]. The
noise marker will indicate the noise power normalized to 1Hz bandwidth near
the active marker. In this case, the “RMS” mode of the detector will be
enabled.In default state, if the noise marker is enabled, the unit of the marker
reading will automatically change into dBm/Hz.
·[Marker→]: Press 【Marker】→ [Marker→] to open the marker function
menu. By using such marker functions, the user can change the instrument
display, with the marker as the reference. Refer to [Marker→] menu for
details.

All Off

·[Off]: Press 【Marker】→ [Off] to disable the current active marker.
·[All Off]: Press 【Marker】→ [All Off] to disable all active markers.
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[Special note]: Marker functions are not available in the RSSI mode.
Marker->
Marker->
Center
Marker->
CF Step
Marker->
Start
光标->
Marker->
Stop
终止频率
< Back

·[Marker→Center]: Press 【Marker】→ [Marker→]→ [Marker→Center].
The marker will move to the center frequency, and the center frequency will
be displayed on the screen.
·[Marker→CF Step] Press 【Marker】→ [Marker→]→ [Marker→CF Step]
and set the step of the center frequency. The step is equal to the marker
frequency. If the differential marker function is activated, the frequency step
is equal to the frequency of the differential marker.
·[Marker→Start] Press【Marker】→ [Marker→]→ [Marker→Start], and set
the starting frequency as the marker frequency.
·[Marker→Stop]: Press 【Marker】→ [Marker→]→ [Marker→Stop] and set
the stop frequency as the marker frequency.
·[Back]: Go back to the previous menu.
(not available in the RSSI mode)

5.3.6 Peak menu

Peak

·[Max Search]: Press 【Peak】→[Max Search] to set the current active
marker at the maximum peak of the measured trace. The frequency and
amplitude of the marker will be displayed in the middle upper part of the
screen.

Peak Search

·[Next Peak]: Press 【Peak】→[Next Peak] to set the active marker at next
peak associated with the current marker location on the trace.

Next Peak

·[Next Pk Left]: Press 【Peak】→[Next Pk Left] to find next peak on the left
side of the current marker location.

Next Pk Left

·[Next Pk Right]: Press 【Peak】→[Next Pk Right] to find next peak on the
right side of the current marker location.

Next Pk Right

Max Search

Min Search
Marker->
Center

·[Max Search]: Set one marker at the highest point of the trace. The
frequency and amplitude of the marker will be displayed in the right upper
corner of the screen. The active functions will not change when this key is
pressed.
·[Min Search]: Press 【Peak】→[Min Search] to set one marker at the lowest
point of the trace. The frequency and amplitude of the marker will be
displayed in the right upper corner of the screen. The active functions will not
change when this key is pressed.
·[Marker→Center]: Press 【Peak】→[Marker→Center] and set the center
frequency as the marker frequency. By using this function, the signal can be
rapidly moved to the screen center.
(not available in the RSSI mode)
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5.3.7 Sweep menu

Sweep
Sweep Time
Auto
Man

Cont

Sweep
Single

Sweep Once

·[Sweep Time Auto Man]: Press 【Sweep】→[Sweep Time Auto Man] to
switch the sweep time between the auto and manual modes. The current state
is underlined. In the auto mode, the minimum sweep time will be set
automatically by the integrated test instrument based on the current state and
displayed on the screen. In the manual mode, you can enter the sweep time
with the number keys and select the time unit with corresponding soft keys.
When RBW and VBW are changed in the auto mode, the sweeping speed
will change accordingly. The larger the RBW and VBW values are, the
higher the sweeping speed is; and vice versa. Based on the compliance with
minimum sweep time constraints, the maximum sweep time of 4024 series
spectrum analyzer can be set as max. 800s under the non-zero span and max.
600s under zero span.
·[Sweep Cont Single]: Press 【Sweep】→[Sweep Cont Single]. The sweep
type is decisive to the sweeping mode of the integrated test instrument and
the time to stop sweeping and start holding. Two options are available in the
interference analyzer mode: continuous and single.
·[Sweep Once]: Press 【Sweep】→[Sweep Once] to sweep once again.

5.3.8 Auto Save menu

Record
Sweep Interval
Auto

·[Sweep Interval]: Press 【Record】→[Sweep Interval Auto], and set the
sweeping interval. In the default mode, the trace will be in the maximum
holding state, so that all signals measured within the sweeping interval can be
recorded.

Sweep Span
Auto

·[Sweep Span]: Press 【Record】→ [Sweep Span Auto]. The span time will
be the whole sweeping period. After reaching the span time, recording will be
stopped.

Record
Off
On

·[Record Off On]: Press 【Record】→ [Record Off On] to enable or disable
the “Auto Save” mode.

Time Cursor
0

[Special note]: This function cannot be enabled until the span time is set.
·[Time Cursor]: Press 【Record】→ [Time Cursor] to view historical data.
>

[Special note]: This must be applied in the spectrogram mode.
·[Restart]: Press 【Record】→ [Restart] to restart sweeping.

Restart

[Special note]: This is not available in the spectrum analyzer mode.
The time cursor function is not available in the RSSI mode.
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5.3.9 Measurement menu
Measure

·[Spectrum]: Press 【Measure】→ [Spectrum] to enable the spectrum
measurement mode.

Spectrum

·[Spectrogram]: Press 【Measure】→ [Spectrogram] to enable the
spectrogram measurement mode.

Spectrogram

·[RSSI]: Press 【Measure】→ [RSSI] to enable the RSSI measurement mode.

RSSI

5.3.10 File menu
Refer to the introduction to the spectrum analyzer measurement mode for file menu details.
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Chapter VI Power Meter Mode (optional)
Section 1 Introduction to Typical Measurements
In the power meter mode of 4024 series spectrum analyzer, the USB interface is connected with an external
USB power probe through the USB cable to test the power. Using 8723X USB power probe provided by
China Electronics Technology Instruments Co., Ltd., RF/microwave signals up to 40GHz can be tested, and
the true average power with high dynamic range from -60dBm to +20dBm can be measured. The
measurement reading will be shown on the display interface of the USB power meter mode of 4024 series.
The block diagram of the test is shown in Fig. 6-1. The attenuator can be added according to the needs.
All operations in this chapter are based on the power meter mode, which will

Caution

not be separately described below. This mode can be selected as follows:
【Mode】 →[Power Meter].
Atten (optional)
8723X

Tested
device
DUT

Fig. 6-1 Power Meter Structure
The power meter interface is shown in Fig. 6-2 (an example).

Fig. 6-2 Power Meter Interface
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It is recommended to purchase the USB-based high-performance microwave power probe, which is
developed by China Electronics Technology Instruments Co., Ltd. The following models are mainly
available, and you can purchase the power probe according to test needs.
At first, observe the maximum input power range identified on the USB power

Caution

probe, and ensure that the input is within the specified range, so as to prevent
the probe from damage as a result of over high power.
Table 6-1 8723XUSB Power Probe

Model

Frequency range

Input power range

Input connector
mode

87230

9kHz-6GHz

-50dBm to +20dBm

N(m)

87231

10MHz~18GHz

-60dBm to +20dBm

N(m)

87232

50MHz~26.5GHz

-60dBm to +20dBm

3.5mm(m)

87233

50MHz~40GHz

-60dBm to +20dBm

2.4mm(m)

Connection of power probe
a) Connect the small end of the USB cable to 8723X USB power probe.
b) Connect the large end of the USB cable to the USB interface of the spectrum analyzer. The green
indicator of the power probe will be ON a moment later.
c) The USB power probe can be shut down after the USB cable is removed. In this case, the green LED
indicator will be OFF.

Caution
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8723X USB power probe is provided with a USB cable. You can use your own
USB cable conforming to international safety standards.

Chapter VI Power Meter Mode (optional)

Section 2 Structure of Power Meter Menu
Frequency

Amplitude

Average

Calibrate

Frequency

Auto Scale

Average
Off
On

Zero

Resolution
0123

Max Value

Upper Limit

Min Value

Lower Limit

Relative
Off
On

Limit
Limit
Off

On

Alarm
Off

On

Offset
Off

On

Max Hold
Off
On

Header

Tail

File

File Manager

Storage positions

Save State

Src File

Internal

Recall state >

Dst File

SD

USB

Page up

Save Pic

Copy

Page down

Default State

Delete Src File

Done

File
Manager

>

Delete

Location
Internal

>

< Back

Delete All

Cancel

Fig. 6-3 Overall Block Diagram of Power Meter Menu
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Section 3 Description of Power Meter Menu
6.3.1 Frequency menu

Frequency

·[Freq]: Press 【Freq】→[Frequency] and set the frequency with the number
keys. Then select the corresponding frequency menu, or change the
frequency with the 【↑】 or 【↓】 key or knob, with the step of 10MHz.

Frequency

[Special note]: The frequency setting range is related to the selected USB
power probe. Refer to Table 6-1 for details.

Resolution
0123

·[Resolution 0 1 2 3]: Press 【Freq】→[Resolution 0 1 2 3] and change the
display accuracy of measurement data. 0 indicates the integer, 1 indicates one
decimal, 2 indicate two decimals, and 3 indicate 3 decimals.

6.3.2 Amplitude menu
·[Auto Scale]: Press 【Ampt】 →[Auto Scale] and make the measurement
signal displayed within 10dB.
·[Max Value]: Press 【Ampt】 →[Max Value] to set the maximum value of
the current signal. You can change the maximum value with the number keys
or 【↑】 or 【↓】 key or knob. The default step is 1dB.
Amplitude
Auto Scale

Max Value

Min Value
Relative
Off
On
Offset
Off

On

Max Hold
Off
On

·[Min Value]: Press【Ampt】→[Min Value] to set the minimum value of the
current signal. You can change the minimum value with the number keys or
【↑】 or 【↓】 key or knob. The default step is 1dB.
·[Relative Off On]: Press 【Ampt】 →[Relative Off On]. The relative
measurement function reflects the power change of the set reference signal,
in dB and %. When the relative measurement function is enabled, the current
power level will be measured and saved. At the same time, one power level
relative to the saved value will be displayed.
·[Offset Off On]: Press 【Ampt】 →[Offset Off On]. If the power of the
tested part is higher than the maximum power that can be measured by the
instrument, the attenuator can be connected to reduce the tested power to be
within the normal measurement range. The power offset function can be used
for setting the offset of the added attenuator or connecting cable so as to
balance the attenuation amount or cable loss. At the same time, the amplifier
gain can be increased by setting the power offset. If the value is positive, the
loss will be compensated; and if the value is negative, the gain will be
compensated.
·[Max Hold Off On]: Press 【Ampt】→ [Max Hold Off On] to enable the
maximum holding function. In this case, the measured maximum value of the
signal will be displayed.
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6.3.3 Bandwidth menu
·[Average Off On]: Press 【BW】→[Average Off On]. Change the average
with the number keys or 【↑】 or 【↓】 key or knob, with the step of 1.
Average
Average
Off
On

[Special note]: The averaging function is generally applied to smooth the
trace in measurement of the low-power signal or signal close to the noise
power, so as to reduce the influence of random noise on measurement,
and improve the measurement accuracy. However, the measurement
speed will be reduced at the same time. The averaging frequency is
decisive to the average reading frequency. The higher the averaging
frequency is, the more noise will be reduced.

6.3.4 Calibrate menu
·[Zero]: Press 【Calibrate】→ [Zero].

Calibrate
Zero

[Special attention]: To improve measuring precision of the instrument,
zero calibration of the instrument is necessary before small signal power
measuring of 8723X Series USB Power Probe. Zero calibration refers to
measurement and saving of noise of the whole measurement channel.
Deduct zero correction value, i.e. the noise of the whole measurement
channel during the measurement to obtain input signal level of the
channel. The USB power probe is calibrated in the same way as the
ordinary power probe. The calibration here refers to internal calibration
of the USB power probe, in which the switch is added at the front end of
the measurement channel. The user can measure and save the channel
noise without disconnecting the sensor from the tested part. The RF
signal should be always applied on the power probe during internal zero
calibration, so as to reduce the wear of the probe connector and shorten
the test time.

6.3.5 Limit menu
·[Limit Off On]: Press 【Limit】→[Limit Off On] to enable the limit.

Limit

·[Upper Limit]: Press 【Limit】→[Upper Limit]. Change the upper limit with

Limit
Off

On

the number keys or 【↑】 or 【↓】 key or knob, with the step of 1dB.
·[Lower Limit]: Press【Limit】→[Lower Limit]. Change the lower limit with

Upper Limit

Lower Limit
Alarm
Off

the number keys or 【↑】 or 【↓】 key or knob, with the step of 1dB.
·[Alarm Off On]: Press 【Limit】→[Alarm Off On]. The limit alarm should
be enabled when the limit is ON. If the measured data exceed the set limits,
the instrument will send alarm prompts.

On
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6.3.6 File menu
Refer to the file menu description in the spectrum analyzer mode.

Caution
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The functions of saving and recalling the data file are not available in the
power meter mode!
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Chapter VII AM-FM-PM Analyzer Mode (optional)
Section 1 Introduction to Typical Measurements
The AM-FM-PM analyzer mode is used for displaying the spectrum of AM, FM and PM signals and
analyzing relevant parameters. The main spectrum and relevant parameters are shown below:
RF spectrum: Similar to the spectrum analyzer mode, the frequency spectrum of the modulation signal will
be displayed, and the occupied bandwidth can be measured.
Audio spectrum: Display the frequency spectrum of the demodulated audio signal.
Audio waveform: Display the waveform of the demodulated audio signal within the time domain.
Parameter analysis: Measure and analyze the carrier power, modulation rate, carrier offset, modulation
depth (AM), modulation frequency offset (FM), modulation phase deviation (PM), S/N, modulation
distortion and total harmonic distortion of the modulated signal.

Caution

All operations in this chapter are based on the AM-FM-PM analyzer mode,
which will not be separately described below.

Three spectrograms can be displayed at the same time or respectively in the AM-FM-PM analyzer mode.
Press 【Measure】 and select [RF Spectrum], [Audio Spectrum], [Audio Waveform] and [Summary] to
display one or all spectrum(s).
In order to better observe the measured signal, the following steps can be taken:
1)

Press 【Measure】→[Demod Type AM FM PM] to select the type of the analog signal to be
demodulated.

2)

Press 【Freq】→ [Center Freq] and set the center frequency of the measured signal.

3)

Press 【BW】→[IFBW], and set the appropriate IF bandwidth with the number keys or 【↑】 or 【↓】
key or knob.

4)

Press 【Ampt】→[Ref Level] and set the reference level of the RF spectrum. Press [Scale/Div] and set
the appropriate scale/division to facilitate the viewing of RF spectrum.

5)

Press [Audio Spectrum]→ [Span] and set the appropriate span. Press [Scale/Div] and set the
appropriate scale/division to facilitate the viewing of the frequency spectrum of the audio signal.

6)

Press [Audio Waveform] → [Sweep Time], and set the display time of the audio signal waveform.
Press [Scale/Div] and set the appropriate scale/division to facilitate the viewing of the frequency
spectrum of the audio signal.
Set the appropriate IF bandwidth. The IF bandwidth should be more than the
width of the modulation signal, so as to accurately demodulate the signal. You

Caution

can observe the bandwidth in the RF spectrum. At the same time, noise may be
produced in the case of too large IF bandwidth, which will affect the accuracy
of parameter measurement.
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Taking the FM signal measurement for example, the AM-FM-PM analyzer mode is introduced as follows.
At first, input the FM signal generated by one signal source to the RF input end of the instrument. Set the
signal frequency as 6GHz, amplitude as -10dBm, modulation rate as 3kHz and modulation offset as 30kHz.
Measurement procedures are as follows:
1) Press 【Measure】→ [Demod Type AM FM PM] and select FM.
2) Press 【Freq】→ [Center Freq] and set the center frequency of the measured signal as 6GHz.
3) Press 【BW】→ [IFBW] and set the IF bandwidth as 100kHz.
4) Press [Audio Spectrum]→ [Span], and set the span as 50kHz.
5) Press [ [Audio Waveform] → [Sweep Time] and set the sweep time as 2ms.
Measurement results are shown in Fig. 7-1.

Fig. 7-1 FM Demodulation Analysis Results
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Section 2 Structure of AM-FM-PM analyzer Menu
Freq

Span

Amplitude

BW

Signal Std

Center Freq

Span

Ref level
0.0dBm

IFBW

Head

Span >

Last span

Ref Position

Average
Off
On

Tail

>

Start Freq

Stop Freq

< Back

CF Step
Auto
Man

Atten
Auto
Man

Page Up

Scale/Div
10.0dB

Page Down

Pre Amp
Off
On

Done

Signal std
>
--

>

Channel
--

Cancel

Marker

Select Trace

Peak

Marker
123456

RF Spectrum

Peak Search

Normal

Audio
Spectrum

Next Peak

Method
% dBc

Scale/Div
10.0dB

Delta

Audio
Waveform

Next Pk Left

%
99.00%

Ref Position

Next Pk Right

dBc
-3.00dB

Select
Trace

>

>

>

< Back

RF Spectrum
OBW
Off

On

Audio Spectrum
Span

Max Search

Off

Min Search

All Off

Marker ->
Center

Fig. 7-2 AM-FM-PM Analyzer Menu
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Audio Waveform

Measurement

Sweep Time

Demod type
AM FM PM

Scale/Div
20.0%

File

File Management

Head

Save State

Src File

RF Spectrum

Tail

Recall
State

Audio
Spectrum

Page Up

Save Data

Audio
Waveform

Page Down

Recall
Data

Summary

Done

Save Pic

Sweep
Cont Single

Delete

Default State

Sweep Once

Delete All

File
Manager

>

Dst File

Copy

>

Delete
Src File
< Back

Location
>
Internal

Cancel

Location
>
[Internal]
SD

USB

Fig. 7-3 AM-FM-PM Analyzer Menu (continued)
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Section 3 Description of AM-FM-PM Analyzer Menu
7.3.1 Frequency menu
·[Center Freq]: Press 【Freq】→[Center Freq] and set it with the number
keys on the front panel. Then select [GHz], [MHz], [kHz] or [Hz] in the
frequency unit menu, or set the center frequency with the 【↑】 or 【↓】 key
or knob.

Freq
Center Freq

[Special note]: When the 【↑】 or 【↓】 key or knob is applied, the
frequency step should be the same as the set value of [Step Freq]. You
can set the step frequency with the number keys or 【↑】 or 【↓】 key or
knob after changing [CF Step Auto Man] into [CF Step Auto Man].
·[Span]: Press 【Freq】→[Span] to activate the span menu. Set the span with
the number keys, and select the frequency unit, or set the span with the 【↑】
or 【↓】 key or knob. Refer to [Span] menu description for details.

Span >

[Special note]: When the span is changed with the 【↑】 or 【↓】 key or
knob, the step should be 1-2-5.
Start Freq

Stop Freq
CF Step
Auto
Man
Signal std
-Channel
--

·[Start freq]: Press 【Freq】→[Start Freq], and set the starting frequency with
the number keys on the front panel. Select the corresponding frequency unit
or set the starting frequency with the 【↑】 or 【↓】 key or knob.
·[Stop Freq]: Press 【Freq】→[Stop Freq], and set the stop frequency with
the number keys on the front panel. Select the corresponding frequency unit
or set the stop frequency with the 【↑】 or 【↓】 key or knob.
·[Signal Std]: Press 【Freq】→[Signal Std], and relevant soft menus will pop
up, including [Head], [Tail], [Page Up], [Page Down] and [Done]. Select the
related signal standard, and recall it with [Done] or [ok] in the menu.
[Special note]: When the signal standard is applied, the center frequency
and span will be set as those defined in the signal standard.
·[Channel]: Press 【Freq】→[Channel], and the channel setting dialog box
will pop up. Set the channel with the number keys or 【↑】 or 【↓】 key or
knob.
[Special note]: The channel should be set based on the applied signal
standard; otherwise, the prompt that setting is not allowed will pop up.

107

Chapter VII AM-FM-PM Analyzer Mode (optional)

7.3.2 Span menu
Span
Span

Last span

< Return

·[Span]: Press 【Freq】→[Span] to activate the span menu. Set the span with
the number keys, or change the span by selecting the frequency unit or with
the 【↑】 or 【↓】 key or knob.
[Special note]: When the span is changed with the 【↑】 or 【↓】 key or
knob, the step should be 1-2-5.
·[Last span]: Press 【Freq】→ [Span]→ [Last Span] and recover the last
span.
·[Back]: Press 【Freq】→ [Span]→ [Back] to go back to the 【Freq】 menu.

7.3.3 Amplitude menu
·[Reference level]: Press 【Ampt】→ [Ref Level] and set it withe number
keys on the front panel. Select [dBm], [-dBm], [mV] or [uV] in the
frequency unit menu, or set the value with the 【↑】 or 【↓】 key or knob.
Amplitude
Ref level
0.0dBm

[Special note]: When the 【↑】 or 【↓】 key or knob is applied, the step
should be 10dB.
·[Reference position]: Press 【Ampt】→ [Ref Position], and set the reference
position with the number keys or 【↑】 or 【↓】 key or knob.

Ref Position
Atten
Auto
Man
Scale/Div
10.0dB

·[Atten Auto Man]: Press 【Ampt】→[Atten Auto Man] to enable the auto or
manual mode of the attenuator. You can change the mode with the number
keys or the 【↑】 or 【↓】 key or knob.
[Special note]: The attenuation range is 0dB to +60dB, with the step of
10dB.
·[Scale/Division]: Press 【Ampt】→[Scale/Div] and set it with the number

Pre Amp
Off
On

keys or the 【↑】 or 【↓】 key or knob. The scale/division setting range is
0.1dB-20dB.
·[Pre Amp Off On]: Press 【Ampt】 to control the ON/OFF state of the
pre-amplifier. This function cannot be activated until the reference level is
less than -40dBm.
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7.3.4 Bandwidth menu
·[IF bandwidth] Press 【BW】→ [IFBW] and set the IFBW with the
number keys on the front panel. Select the corresponding frequency unit,
i.e. [GHz], [MHz], [kHz] or [Hz], or set the IFBW with the 【↑】 or
【↓】 key or knob.
BW
IFBW
Average
Off
On

[Special note]: The IF bandwidth should be more than the bandwidth
of the modulated signal so as to accurately demodulate the signal. You
can observe the bandwidth of the modulated signal in the RF spectrum.
Noise may be generated in the case of too large IF bandwidth, which
will affect the accuracy of parameter measurement. The IF bandwidth
range is from 10kHz to 300kHz, with the step of 1-3-10.
·[Average Off On]: Press 【BW】→[Average Off On]. The averaging
function is used for smoothing the displayed trace. When the averaging
function is enabled, the averaging frequency can be selected with the
number keys or 【↑】 or 【↓】 key or knob.
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7.3.5 Marker menu
Marker
Marker
123456
Normal

Delta
Select
Trace

·[Marker 1 2 3 4 5 6]: Press 【Marker】→ [Marker 1 2 3 4 5 6] to change
various markers. The selected marker will be underlined.
·[Normal mode]: Press 【Marker】→[Normal] to enable the normal mode of
the current marker.
·[Delta mode]: Press 【Marker】→[Delta] to enable the delta mode of the
current marker. In this case, the frequency difference and amplitude
difference (time difference under zero span) between the differential marker
and reference marker will be displayed. The amplitude will be displayed in
dB.
·[Select Trace]: Press 【Marker】→ [Select Trace], and soft menus related to
the trace will pop up, including [RF Spectrum], [Audio Spectrum] and
[Audio Waveform]. Refer to the [Select Trace] menu for details.
·[Off]: Press 【Marker】→ [Off] to disable the current active marker.

Off

·[All Off]: Press 【Marker】→ [All Off] to disable all active markers.

All Off

Select Trace

·[Select Trace]: Press 【Marker】→ [Select Trace].

RF Spectrum

·[RF spectrum]: Press 【Marker】→ [Select Trace]→ [RF Spectrum] to
select the trace in the RF spectrum. In this case, the marker can only be
operated on this trace.

Audio
Spectrum
Audio
Waveform

·[Audio Spectrum]: Press 【Marker】→ [Select Trace]→ [Audio Spectrum],
and select the trace in the audio spectrum. In this case, the marker can only
be operated on this trace.
·[Audio Waveform]: Press 【Marker】→ [Select Trace]→ [Audio
Waveform], and select the trace in the audio waveform. In this case, the
marker can only be operated on this trace.

< Back
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7.3.6 Peak menu
·[Maximum Peak]: Press 【Peak】→[Max Peak] to set the current active
marker at the maximum peak of the measured trace. The frequency and
amplitude of the marker will be displayed in the middle upper part of the
screen.
Peak
Peak Search

Next Peak

Next Pk Left

Next Pk Right

Max Search

Min Search
Marker ->
Center

·[Next Peak]: Press 【Peak】→[Next Peak] to set the active marker at next
peak associated with the current marker location on the trace.
·[Next Peak Left]: Press 【Peak】→[Next Pk Left] to find next peak on the
left side of the current marker location.
·[Next Peak Right]: Press【Peak】
→[Next Pk Right] to find next peak on the
right side of the current marker location.
·[Maximum value]: Set one marker at the highest point of the trace. The
frequency and amplitude of the marker will be displayed in the right upper
corner of the screen. The active functions will not change when this key is
pressed.
·[Minimum value]: Press 【Peak】→[Min Search] to set one marker at the
lowest point of the trace. The frequency and amplitude of the marker will be
displayed in the right upper corner of the screen. The active functions will not
change when this key is pressed.
·[Marker→Center]: Press 【Peak】→[Marker→Center] and set the center
frequency as the marker frequency. By using this function, the signal can be
rapidly moved to the screen center, which is only effective for the RF
spectrum.
[Special note]: Each peak, maximum value and minimum value will be
searched on the selected trace. Refer to [Select Trace] menu for details.
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7.3.7 RF spectrum menu
[Special note]: The occupied bandwidth measurement in the RF
spectrum is similar to that in the spectrum analyzer mode. The RF
spectrum is only applied in the AM-FM-PM analyzer mode.
RF Spectrum
OBW
Off

On

Method
% dBc
%
99.00%
dBc
-3.00dB

·[OBW Off On]: Press [RF Spectrum]→ [OBW Off On] to enable or disable
the occupied bandwidth measurement.
·[Method % dBc]: Press [RF Spectrum]→ [Method % dBc] and select
various measurement methods: percentage or drop dBc. In the percentage
method, the occupied bandwidth of the signal is obtained by calculating the
bandwidth of the frequency of certain percentage to the total power of the
transmitted power, and the power percentage can be set by the user. In the
drop dBc method, the occupied bandwidth is defined as follows: spacing
between two frequency points corresponding to signal power drop by dBc on
both sides of the frequency point where the signal peak power is. The signal
power drop dBc can be set by the user.
·[%]: Press [RF Spectrum]→ [%] and set the percentage.
·[dBc]: Press [RF Spectrum]→ [dBc] and set the dBc value.

7.3.8 Audio spectrum menu

Audio Spectrum
Span
Scale/division
10.0dB
Reference position
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·[Span]: Press [Audio Spectrum]→ [Span], and set the span of the audio
spectrum. The span should be large enough to display the audio signal and
related harmonics. You can change the span with the number keys and select
the frequency unit, or with the 【↑】 or 【↓】 key or knob.
·[Scale/Division]: Press [Audio Spectrum]→ [Scale/Div], and set the scale of
the audio spectrum, so as to facilitate the observation of the audio spectrum
trace. You can change the scale unit with the number keys and select the
power unit [dB] or [-dB], or use the 【↑】 or 【↓】 key or knob.
·[Reference position]: Press [Audio Spectrum]→ [Ref Position], and set the
reference position of the audio spectrum to facilitate the observation of the
audio spectrum line. You can change the reference position with the number
keys and click [OK], or with the 【↑】 or 【↓】 key or knob.
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7.3.9 Audio waveform menu
·[Sweep time]: Press [Audio Waveform]→ [Sweep Time] and set the audio
waveform sweeping time. The longer the sweep time is and the more points
are sampled, the stabler the measurement results will be.
Audio Waveform
Sweep Time
Scale/Div
20.0%

·[Scale/Division]: Press [Audio Waveform]→ [Scale/Div] and set the scale
of the audio waveform to facilitate the observation of the audio spectrum
trace. You can change the scale unit with the number keys and select [%] or
click [OK], or with the 【↑】 or 【↓】 key or knob.
[Special note]: The scale unit changes with the type of the modulation
signal. The scale unit should be percentage (%) in AM signal
measurement, frequency unit (Hz, kHz or GHz) in FM signal
measurement and radian (Rad) in PM signal measurement.

7.3.10 Measurement menu
Measurement
Demod type
AM FM PM
RF Spectrum
Audio
Spectrum
Audio
Waveform
Summary
Sweep
Cont Single

·[Demo Type AM FM PM]: Press【Measure】→ [Demod Type AM FM PM]
and select the type of the modulation signal.
·[RF Spectrum]: Press 【Measure】→ [RF Spectrum] to display the RF
spectrum only.
·[Audio Spectrum]: Press 【Measure】→ [Audio Spectrum] to display the
audio spectrum only.
·[Audio Waveform]: Press 【Measure】→ [Audio Waveform] to display the
audio waveform only.
·[Summary]: Press 【Measure】→[Summary] to display the RF spectrum,
audio spectrum and audio waveform at the same time.
·[Sweep Cont Single]: Press 【Measure】→[Sweep Cont Single] to enable
continuous or single sweeping.
·[Sweep Once]: Press 【Measure】→[Sweep Once] to trigger sweeping once.
Sweeping can only be performed once again in the single mode.

Sweep Once

7.3.11 File menu
Refer to the file menu description in the spectrum analyzer mode.
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Chapter VIII Channel Scanner Mode (optional)
Section 1 Introduction to Typical Measurements
The channel scanner mode can be applied to measure the signal power of multiple channels. The signal
power is displayed in the bar graph or list form. At most, the signal power of 20 channels can be displayed.
This can be divided into three modes according to the channel setting: channel scanner, frequency scanner
and list scanner.
Channel scanner: Set the measured channel by setting the signal standard, starting channel and channel
step.
Frequency scanner: Set the measured channel by setting the starting frequency and frequency step.
List Scanner: Set the measured channel by setting the list.
The bandwidth and number of measured channels can be set in the above three modes.

Caution

All operations in this chapter are based on the channel scanner mode, which
will not be separately described below.

8.1.1 Channel Scanner
Below is an example of the Channel Scanner mode, mainly involving the following procedures.
1) Press 【Sweep】→ [Channel Scanner] → [Signal Std], and set the signal standard of measurement.
2) Press 【Sweep】→[Channel Scanner]→[Start Channel] and set the starting channel of measurement. In
this case, the starting channel should meet the requirements of the selected signal standard.
3) Press 【Sweep】→[Channel Scanner] →[Number of Channels], and set the number of measured
channels. At most 20 channels can be measured at the same time.
4) Press 【Sweep】→[Channel Scanner] →[Channel Step] and set the channel step of measurement. A
certain number of channels will be measured with the starting channel as the initial channel, based on
the set channel step.
5) Press 【Sweep】→ [Display Graph Table] and enable the graph display mode.
6) Press【Sweep】→[Power Display Curr Max] and enable the maximum option. Set the maximum power
of each displayed channel.
The power cannot be set as the maximum value until the maximum holding

Caution

function is enabled.
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Fig. 8-1 Schematic Diagram of Channel Scanner

8.1.2 Frequency Scanner
Below is an example of the Frequency Scanner mode, mainly involving the following procedures.
1) Press 【Sweep】→ [FScan] → [Start Freq], and set the center frequency of the starting channel.
2) Press 【Sweep】→ [FScan]→ [Step Freq], and set the frequency step of the measured channel.
3) Press 【Sweep】→ [FScan] → [Bandwidth], and set the bandwidth of the measured channel.
4) Press 【Sweep】→ [FScan] → [Number of Channels], and set the number of measured channels. At
most 20 channels can be measured at the same time.
5) Press 【Measure】→ [Display Graph Table] and enable the graph display mode.
6) Press 【Measure】→ [Power Display Curr Max], and enable the “Current” option. Set the current power
of each channel.
7) Press 【Measure】→ [Color Code Single Dual] and enable the dual color mode.
8) Press 【Measure】→ [Orientation Vert Hori] and enable the horizontal mode.
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Fig. 8-2 Schematic Diagram of Frequency Scanner

8.1.3 List scanner
Below is an example of the Frequency Scanner mode, mainly involving the following procedures.
1) Press 【Sweep】→ [MScan] → [Edit List] and edit the channel list to be swept. The information of each
channel can be set by setting the signal standard and channel number or setting the frequency and
bandwidth in the list.
2) Press 【Sweep】→ [MScan] →[Number of Channels], and set the number of measured channels. At
most 20 channels can be measured at the same time.
3) Press 【Sweep】→ [Display Graph Table] and enable the graph display mode.
4) Press【Sweep】→[Power Display Curr Max], and enable the “Current” option. Set the current power of
each channel.

Fig. 8-3 Schematic Diagram of List Scanner
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Section 2 Structure of Channel Scanner Menu
Amplitude

Scanner

Refer level
0.0dBm

Channel
Scanner >

Scale/Div
10.0dB

Freq
Scanner >
List
Scanner >

Ch Scanner
Freq Scanner

Signal Std

Signal Std
>
--

Start Freq
890.000MHz

Start Channel
--

Step Freq
200.000kHz

Number of
Channels

Bandwidth
200.000kHz

Done

Channel Step
1

Number of
Channels

Bandwidth
200.000kHz
>
>

>

< Back
< Back

Measure

List Scanner

Edit list

Display
Graph
Table

Edit list >

Signal
Std

Max. Hold
Off
On

Number of
Channels

Channel

Channel Unit
Ch Freq

Frequency

Power Display
Curr Max

Bandwidth

Color Code
Single
Dual
Orientation
Vert
Hori

Signal Std
>

Done

>

Done

Cancel

Fig. 8-1 Channel Scanner Menu
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Section 3 Description of Channel Scanner Menu
8.3.1 Scanner menu

Scanner
Channel
Scanner >
Freq
Scanner >
List
Scanner >

·[Channel Scanner]: Press 【Sweep】→ [Channel Scanner], set the channel
scanner mode and activate [Channel Scanner] menu. You can the channel
parameters in [Channel Scanner] menu. Refer to [Channel Scanner] menu.
·[Freq Scanner]: Press 【Sweep】→ [Freq Scanner], set the frequency
scanner mode and activate [Freq Scanner] menu. You can the channel
parameters in [Freq Scanner]. Refer to [Freq Scanner] menu.
·[List Scanner]: Press 【Sweep】→ [List Scanner], set the list scanner mode
and activate [List Scanner] menu. You can the channel parameters in [List
Scanner]. Refer to [List Scanner] menu.

8.3.2 Channel Scanner menu
Ch Scanner
Signal Std
-Start Channel
-Number of
Channels
Channel Step
1
Bandwidth
200.000kHz

·[Signal standard]: Press 【Sweep】→ [Channel Scanner]→ [Signal Std],
and the existing signal standard list will pop up, including relevant menus
such as [Head], [Tail], [Page Up] and [Page Down]. Click [Done],
and select the corresponding signal standard.
·[Start Channel]: Press 【Sweep】→[Channel Scanner]→[Start Channel],
and set the number of the starting channel. In this case, the starting channel
will be the initial channel of measurement and cannot be set until the signal
standard is selected.
·[Number of Channels]: Press 【Sweep】→ [Channel Scanner]→ [Number
of Channels], and set the number of measured channels. At most 20 channels
can be measured.
·[Channel Step]: Press 【Sweep】→ [Channel Scanner]→ [Channel Step],
and set the step between the measured channels.
·[bandwidth]: Press 【Sweep】→ [Channel Scanner]→ [Bandwidth], and set
the bandwidth of the measured channel.

< Back
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8.3.3 Frequency Scanner menu
Freq Scanner
Start Freq
890.000MHz
Step Freq
200.000kHz
Bandwidth
200.000kHz
Number of
Channels

·[Start frequency]: Press 【Sweep】→ [Freq Scanner]→ [Start Freq], and set
the center frequency of the starting channel.
·[Step Freq]: Press 【Sweep】→ [Freq Scanner]→ [Step Freq], and set the
frequency step between channels.
·[bandwidth]: Press 【Sweep】→ [Freq Scanner]→ [Bandwidth], and set the
bandwidth of the measured channel.
·[Number of Channels]: Press 【Sweep】→[Freq Scanner]→[Number of
Channels], and set the number of measured channels. At most 20 channels
can be measured.

< Back

8.3.4 List Scanner menu
List Scanner
Edit list >
Number of
Channels
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·[Edit list]: Press 【Sweep】→ [List Scanner]→ [Edit List], and the
corresponding [Edit List] menu will pop up. Refer to [Edit List] menu for
details.
·[Number of Channels]: Press 【Sweep】→ [List Scanner]→ [Number of
Channels], and set the number of measured channels. At most 20 channels
can be measured.
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Edit list
Signal
Std
Channel

·[Signal Std]: Press [Edit List] → [Signal Std] and the signal standard list
will pop up, including [Head], [Tail], [Page Up] and [Page Down]. Select the
required signal standard and click [Done].
·[Channel]: Press [Edit List]→ [Channel] to display the selected signal
standard, channel range, etc. The user can also emit channel and click [Done]
to save the setting.

Frequency

·[Center Freq]: Press [Edit List]→ [Center Freq], edit the center frequency
of the selected channel, and click [Done] to save the setting.

Bandwidth

·[bandwidth]: Press [Edit List]→ [Bandwidth], edit the bandwidth of the
selected channel, and click [Done] to save the setting.
·[Done]: Press [Edit List]→ [Done] to save the modified settings and go
back to the List Scanner menu.

Done

·[Cancel]: Press [Edit List]→ [Cancel] to cancel the modified settings and go
back to the List Scanner menu.

Cancel

8.3.5 Measurement menu
Measure
Display
Graph
Table
Max. Hold
Off
On
Channel Unit
Ch Freq
Power Display
Curr Max
Color Code
Single
Dual
Orientation
Vert
Hori

·[Display Graph Table]: Press 【Measure】→[Display Graph Table] and
select the graph/table mode, as shown in Fig. 8-7 and 8-8.
·[Max Hold Off On]: Press 【Measure】→ [Max Hold Off On] to enable or
disable the maximum holding function.
·[Channel Units Ch Freq]: Press【Measure】→[Channel Units Ch Freq] and
set the channel or frequency display mode.
·[Power Display Curr Max]: Press 【Measure】→[Power Display Curr Max]
and set the current or maximum display mode. The maximum power cannot
be set until the maximum holding function is enabled.
·[Color Code Single Dual]: Press 【Measure】→[Color Code Single Dual],
and set the single or dual display mode.
·[Orientation Vert Hori]: Press 【Measure】→[Orientation Vert Hori] and
set the vertical or horizontal display mode.

8.3.6 File menu
Refer to the description of the file menu in the spectrum analyzer mode.
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Chapter IX Field Strength Measurement Mode (optional)
Section 1 Introduction to Typical Measurements
The field strength measurement is indispensable in radiation strength measurement of the tested equipment and
can be divided into three modes: PScan, FScan and MScan.
PScan: Observe the offset, amplitude and field strength of the current point by setting the point frequency.
FScan: Observe the amplitude and field strength changes within a certain frequency range by setting the starting
frequency, step frequency and number of points.
MScan: Observe the amplitude and field strength of frequency points in the list by recalling the edited or saved
list.

Caution

All the operations in this chapter are based on the Field Strength mode, which
will not be separately described below.

9.1.1 PScan
Main operation procedures of [PScan]:
1) Press 【Measure】→ [PScan] to enable the point frequency measurement mode.
2) Press 【Freq】→ [Pot Freq] and set the point frequency within the range of [1MHz, 44.1GHz].
3) Press 【BW】→ [BW] and set the bandwidth as 150Hz, 300Hz, 600Hz, 1.5kHz, 2.4kHz, 6kHz, 9kHz,
15kHz, 30kHz, 50kHz, 120kHz or 150kHz.
4) Press 【Swp/Ant】→ [Recall Antenna], and select the antenna factor file.
5) Press [Demod] and set the demodulation type and volume.
The schematic diagram of PScan mode is shown in the figure below (example).

Fig. 9-1 Schematic Diagram of PScan Mode
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9.1.2 FScan
Main operation steps of FScan:
1) Press 【Measure】→ [FScan] to enable the frequency sweeping mode.
2) Press 【Freq】→ [Stt Freq] and set the starting frequency of sweeping.
3) Press 【Freq】→ [Step Freq] and set the step frequency of sweeping.
4) Press 【Freq】→ [Points] and set the number of sweeping points.
5) Press 【BW】→ [BW] and set the bandwidth as 150Hz, 300Hz, 600Hz, 1.5kHz, 2.4kHz, 6kHz, 9kHz,
15kHz, 30kHz, 50kHz, 120kHz or 150kHz.
6) Press 【Swp/Ant】→ [Recall Antenna], and select the antenna factor file.
7) Press 【Swp/Ant】→ [Dwell Time +∞ Man], and set the dwell time.
8) Press 【Swp/Ant】→ [Dwell Time Off On] to enable or disable the dwell time.
9) Press 【Marker】→ [Marker Off On] to enable or disable the marker.
10) Press 【Peak】 to directly set the marker at the maximum point

Caution

The dwell time refers to the time of dwelling at the frequency point exceeding
the set limit in the ON state.

The schematic diagram of FScan mode is shown in the figure below (example).

Fig. 9-2 Schematic Diagram of FScan Mode

9.1.3 MScan
Main operation steps of MScan:
1) Press 【List Edit】→ [Edit List] and edit the current list.
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2) Press 【Measure】→[MScan] to enable the MScan mode.
3) Press 【List Edit】→ [Edit List]→ [Freq] and set the step frequency of sweeping.
4) Press 【List Edit】→ [Edit List]→ [BandWidth] and set the bandwidth as 150Hz, 300Hz, 600Hz, 1.5kHz,
2.4kHz, 6kHz, 9kHz, 15kHz, 30kHz, 50kHz, 120kHz or 150kHz.
5) Press 【Swp/Ant】→ [Recall Antenna], and select the antenna factor file.
6) Press 【Swp/Ant】→ [Dwell Time +∞ Man], and set the dwell time.
7) Press 【Swp/Ant】→ [Dwell Time Off On] to enable or disable the dwell time.
8) Press 【Marker】→ [Marker Off On] to enable or disable the marker.
9) Press 【Peak】 to directly set the marker at the maximum point.

Caution

The MScan mode can be changed only the list is not empty.

The schematic diagram of MScan mode is shown in the figure below (example).

Fig. 9-3 Schematic Diagram of MScan Mode
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Section 2 Structure of Field Strength Menu
Frequency

Frequency

Amplitude

Unit

Demod

Pot Freq
500MHz

Stt Freq
500MHz

Ref Level
107dBuV

dBm

CW

Freq Step
Auto
Man

Step Freq
10MHz

Atten
Auto
Man

dBmV

FM

Freq Track
Off
On

point
58

Scale/Div
20.0dB

dBuV

AM

Volt

USB

Watt

LSB

Limit
BW

Detector

BW
30kHz

Peak

Off

On
Alarm

Detector

>

Off

On

Speaker
Off
On

Average

Unit
dBuV

Real Time

Marker

Peak

Max Search

Max Search

Marker
Off
On

Marker
Off
On

>

Volume
95

Measurement
>
PScan
Back

>
FScan

MScan

Fig. 9-4 Overall Block Diagram of Field Strength Menu
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Swp/Ant

Edit List

List Edit

Add Point

Sweep Type
Cont
Single

Header

Add Point

Edit list

Delete Point

Sweep Once

Tail

Delete Point

Save list

Delete All

Dwell Time
+∞
Man

Page up

Delete All

Recall list

Dwell Time
Off
On

Page down

Done

Recall Antenna>

Done

Done

Done

Cancel

Edit Antenna >

Delete

Cancel

Delete

>

Save Antenna

>

Tail

>

>

Page up

Page down

Delete All

Delete All

Cancel

Cancel

Fig. 9-5 Overall Block Diagram of Field Strength Menu (continued)
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Header

Tail

File

File Manager

Save State

Src File

Recall state >

Dst File

Page up

Save Data

Copy

Page down

Recall Data >

Delete Src File

Done

Save Pic

< Back

Delete

Default State

Delete All

File
Manager

Cancel

Location
[Internal]

Location
>
Internal
>
SD

USB

Fig. 9-6 Overall Block Diagram of Field Strength Menu (continued)
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Section 3 Description of Field Strength Menu
9.3.1 Frequency menu ([PScan] mode)
·[Pot Freq]: Press 【Freq】→ [Freq] and set the frequency with the number
keys on the front panel. Select [GHz], [MHz], [kHz] or [Hz] in the
frequency unit menu, or change the point frequency with the 【↑】 or 【↓】
key or knob.
Frequency
Pot Freq
500MHz
Freq Step
Auto
Man
Freq Track
Off
On

[Special note]: The point frequency setting range is 1MHz to 44.1GHz.
·[Freq step]: Press 【Freq】→[Freq Step Auto Man] and set the point
frequency step with the 【↑】 or 【↓】 key or knob. The frequency step should
be set as 1MHz in the auto mode.
·[Freq Track Off On]: Press 【Freq】→[Freq Track Off On] to enable or
disable frequency tracking. When the frequency tracking is enabled, the
instrument is able to automatically track the frequency of the peak point, and
the tracked frequency will be displayed on the current frequency display zone
of the screen.
[Special note]: The peak point in frequency tracking refers to the peak point
of the amplitude signal searched within the current bandwidth range.

9.3.2 Frequency menu ([FScan] mode)

Frequency
Stt Freq
500MHz
Step Freq
10MHz
point
58
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·[Stt Freq 500MHz]: Press 【Freq】→[Stt Freq 500MHz] and set the starting
frequency with the number keys on the front panel. Select [GHz], [MHz],
[kHz] or [Hz] in the frequency unit menu, or set the starting frequency with
the 【↑】 or 【↓】 key or knob.
[Special note]: The setting range of the starting frequency is 1MHz to
44.1GHz.
·[Step Freq 10MHz]: Press 【Freq】→[Step Freq 10MHz], and set the
sweeping frequency step with the 【↑】 or 【↓】 key or knob.
·[Point 58]: Press 【Freq】→[Point 58] and set the number of frequency
sweeping points between 2 and 58.
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9.3.3 Amplitude menu
·[Ref Level 107dBuV] : Press 【Ampt】→ [Ref Level 107dBuV] and set the
reference value with the number keys on the front panel. Select [dBuV],
[-dBuV], [mV] or [uV] in the frequency unit menu, or set the reference
value with the 【↑】 or 【↓】 key or knob.

Amplitude

[Special note]: The setting range of the reference value is -43dBuV to
147dBuV.

Ref Level
107dBuV
Atten
Auto
Man
Scale/Div
20.0dB

·[Scale/Div 20.0dB]: Press 【Ampt】→ [Scale/Div 20.0dB] and set the
scale/division with the number keys on the front panel. Select [dB] or
[-dB] in the frequency unit menu, or set the reference value with the 【↑】 or

Limit
Off

On

【↓】 key or knob.

Alarm
Off

On
Unit
dBuV

·[Atten Auto Man]: Press 【Ampt】→[Atten Auto Man]. In the auto mode,
the attenuation amount of the attenuator will be adjusted automatically
according to the reference value. In the manual mode, the set attenuation
amount will always be applied in the attenuator.

·[Limit Off On]: Press 【Ampt】→ [Limit Off On] to enable or disable the
limit.
>

·[Alarm Off On]: Press 【Ampt】→ [Alarm Off On] to enable or disable the
audio alarm.
·[Units dBuV]: Press 【Ampt】→ [Units] to enable the unit menu, including
[dBm], [dBmV], [dBuV], [Volt] or [Watt].
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9.3.4 Bandwidth menu
·[BW 30kHz]: Press 【BW】→ [BW 30kHz] and set the bandwidth with the
number keys on the front panel. Select [GHz], [MHz], [kHz] or [Hz]
in the frequency unit menu, or set the reference value with the 【↑】 or 【↓】
key or knob.

BW
BW
30kHz
Detector

>

[Special note]: The bandwidth must be set as 150Hz, 300Hz, 600Hz, 1.5kHz,
2.4kHz, 6kHz, 9kHz, 15kHz, 30kHz, 50kHz, 120kHz or 150kHz.
·[Detector]: Press 【BW】→ [Detector] to enable the detector menu,
including: Peak, Average and Real Time.

9.3.5 Marker menu
Marker
Max Search
Marker
Off
On

·[Max Search]: Press 【Marker】→[Max Search] to set the marker at the
maximum point.
·[Marker Off On]: Press 【Marker】→ [Marker Off On] to enable or disable
the marker display.
[Special note]: The marker menu will be valid only in the FScan and
MScan mode.

9.3.6 Peak menu
Peak
Max Search
Marker
Off
On
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·[Max Search]: Press 【Peak】→[Max Search] to set the marker at the
maximum point.
·[Marker Off On]: Press 【Peak】→[Marker Off On] to enable or disable the
marker display.
[Special note]: The peak menu will be valid only in the FScan and
MScan mode.
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9.3.7 Sweep/Antenna menu
·[Sweep Cont Single]: Press 【Swp/Ant】→[Sweep Cont Single] to enable
the continuous or single sweeping mode.
·[Sweep Once]: Press 【Swp/Ant】→ [Sweep Once] to sweep once again.
Swp/Ant
Sweep Type
Cont
Single

·[Dwell Time +∞ Man]: Press 【Swp/Ant】→[Dwell Time +∞ Man] to set
the dwell time. The dwell time refers to the time of dwelling at the point with
the amplitude beyond the limits in the ON state. The default setting is
infinite, and the manual setting range is 1ms to 40s.
[Special note]: The dwell time will be valid only when the limits are in
the ON state.

Sweep Once
Dwell Time
+∞
Man
Dwell Time
Off
On

·[Dwell Time Off On]: Press 【Swp/Ant】→[Dwell Time Off On] to set the
dwell time. The dwell time refers to the waiting time at each point in
sweeping. The default setting is the OFF state, and the manual setting range
is 1ms to 40s.

Recall Antenna>

[Special note]: The dwell time will be valid only in the FScan and MScan
mode.

Edit Antenna >

·[Recall Antenna]: Press 【Swp/Ant】→ [Recall Antenna] and soft menus
such as [Head], [Tail], [Page Up], [Page Down], [Done] and
[Delete] will pop up. You can select and recall the saved antenna factor file.

Save Antenna

·[Edit Antenna]: Press 【Swp/Ant】→ [Recall Antenna], and soft menus such
as [Add Point], [Delete Point], [Delete All], [Done] and [Cancel]
will pop up. This menu is applied to edit the antenna factor.
·[Save Antenna]: Press 【Swp/Ant】→[Save Antenna] to open the antenna
saving dialog box, where the antenna factor file can be saved.

9.3.8 Edit List menu
List Edit
Edit list

>

·[Save List]: Press [Edit List]→[Save List] to open the list saving dialog box,
where the list file can be saved.

Save list

Recall list

·[Edit list]: Press [Edit List]→ [Edit List], and soft menus such as [Add
Point], [Delete Point], [Delete All], [Done] and [Cancel] will pop up,
by which the list can be edited.

>

·[Recall List]: Press [Edit List]→ [Recall List] and soft menus such as
[Head], [Tail], [Page Up], [Page Down], [Done] and [Delete] will
pop up, by which the saved list can be selected and recalled.
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9.3.9 Demodulation menu
Demod

·[CW]: Press [Demod]→ [CW] to disable the demodulation mode.
·[FM]: Press [Demod]→ [FM] to enable the FM mode.

CW

·[AM]: Press [Demod]→ [AM] to enable the AM mode.
·[USB]: Press [Demod]→ [USB] to enable the upper sideband mode.

FM

·[LSB]: Press [Demod]→ [LSB] to enable the lower sideband mode.
AM

·[Speaker Off On]: Press [Demod]→[Speaker Off On] to enable or disable
the audio alarm function.

USB

[Special note]: If the audio alarm is enabled, the demodulation mode
such as [FM], [AM], [USB] and [LSB] will not be available.

LSB

·[Volume 95]: Press [Demod]→[Volume 95] to set the demodulation volume.
Set the required volume with the number keys or 【↑】 or 【↓】 key or knob.

Speaker
Off
On
Volume
95

9.3.10 Measurement menu
Measure

·[PScan]: Press 【Measure】→[PScan] to enable the MScan mode of field
strength.

PScan

·[FScan]: Press 【Measure】→[FScan] to enable the FScan mode of field
strength.

FScan

·[MScan]: Press 【Measure】→[MScan] to enable the MScan mode of field
strength.

MScan

[Special note]: Ensure that the list exists before enabling the MScan
mode. You can view it by clicking [Edit List]- [Edit List].

9.3.11 File menu
Refer to the description of the file menu in the spectrum analyzer mode.
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Chapter X Signal analyzer mode (option)
Section 1 Introduction to typical measurement
The signal analysis measurement mode is to provide the rapid analysis of interference signal, realize the
display and playback of historical data by waterfall chart, quickly realize the modification of center
frequency and span parameters by shortcut menu and quickly realize the audio output and IQ Capture
function.

Caution

All operations of this chapter are based on that the signal analysis mode has been
selected. This will not be separately described below.

The main interface of signal analysis measurement mode will measure by reference to interference analysis
waterfall chart for the convenience of observing the periodic or jumped interference signal. The signal
analysis is specially designed with shortcut menu to quickly set the center frequency and span parameters,
activate the audio output and IQ Capture and improve the rapid analysis of interference signal. The main
interface display of signal analysis is as shown in Fig. 10-1:

Fig. 10-1 Main interface display of signal analysis measurement mode
The signal analysis includes signal list menu to view the frequency, amplitude, capture time and other
parameters of captured interference signal, as shown in Fig. 10-2.
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Fig. 10-2 Interface of signal list
IQ Capture function can directly save IQ data of interference signal and its interface is as shown in Fig.
10-3:

Fig. 10-3 Schematic diagram of IQ Capture function
Under the signal analysis mode, the current test task can be saved quickly as an automatically generated file
as per current intermediate frequency and test time.
The storage task of signal analysis is as shown in Fig. 10-4:
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Fig. 10-4 Schematic diagram of signal analysis storage task
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Section 2 Structure of signal analysis menu
Freq

Span

Amplitude

BW

Detector

Center Freq

Span

Ref Level
0.0 dBm

Res BW
Auto
Man

Auto

Full Span

Ref Position

Video BW
Auto
Man

Normal

Start Freq

Zero Span

Atten
Auto
Man

Video Type
Lin
Log

Peak

Stop Freq

Last Span

Scale/Div
20.0dB

Average
Off
On

Neg Peak

Alarm

Span/RBW
100

Sample

Units
dBm

RBW/VBW
1

Average

Pre Amp
Off
On

Detector
Auto

Span

>

CF Step
Auto
Man
>

>

Signal Std
--

>

Back

Channel
--

Off

On

>

RMS

>
Marker

Marker->

Peak
频率

Marker
123456

Marker->
Center Freq

Peak
Search
中心频率

Normal

Marker->
CF Step

Delta

Marker->
Start

Marker Noise
Off
On

Marker->
Stop

Counter Mkr
Off
On

Back

Sweep

Points

Sweep Time
Auto Man

201

Sweep
Cont Single

501

Sweep Once

1001

Next
Peak >
扫宽

Next
Pk Left
起始频率

Next
Pk Right
终止频率

>

步进频率
Max Search
自动
手动

Points
[1001]

>

2001

4001
Marker-> >

< Back

信号跟踪
Min Search
关
开
>

Off

Peak
Track
信号标准
Off -- On

All Off

Marker->
信道号
Center
--

Fig. 10-5 Block diagram of signal analysis menu
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Fig. 10-6 Block diagram of signal analysis menu (continued)
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Section 3 Description of signal analysis menu
10.3.1

Frequency menu
·[Center Freq]: press 【Freq】→[Center Freq], to select [GHz], [MHz], [kHz] or

Freq

[Hz] by number key on front panel or 【↑】 or 【↓】 key and spinning wheel in
frequency menu.

Center Freq

Span

>

·[Special Notice]: in case of using 【↑】 or 【↓】 key and spinning wheel, the
frequency step is same with the set value of [Step Freq]. After pressing [Step Freq
Auto Man] to switch to [Step Freq Auto Man], it is allowed to use the number key
or 【↑】 or 【↓】 key and spinning wheel to set the step frequency.

Start Freq

·[Span]: press 【Freq】→[Span], to activate the span sub-menu by using number

Stop Freq

key, frequency unit or 【↑】 or 【↓】 key and spinning wheel. For details, please
refer to the description of [Span].
·[Special Notice]: use 【↑】 or 【↓】 key and spinning wheel to change span as
per the step size of 1-2-5.

CF Step
Auto
Man
Signal Std
-Channel
--

·[Start Freq]: press 【Freq】→[Start Freq], to use the number key on front panel,
frequency unit or 【↑】 or 【↓】 key and spinning wheel to set the Start Freq.
>

·[Stop Freq]: press 【Freq】→[Stop Freq], to use the number key on front panel,
frequency unit or 【↑】 or 【↓】 key and spinning wheel to set the Stop Freq.
·[Signal Std]: press 【Freq】→[Signal Std], to select a signal standard by using
【↑】 or 【↓】 key and spinning wheel and call it by [Done] menu or [Enter] key.
For details, please refer to the dialog box menu.
·[Special Notice]: after the signal standard is loaded, the center frequency and
span will be set as defined in signal standard.
·[Channel]: press 【Freq】→[Channel], to pop up the channel number dialog box
and set the channel number by using number key or【↑】or【↓】key and spinning
wheel.
·[Special Notice]: the channel number shall be set after the signal standard
has been loaded. Otherwise the message of failure to set will be given.
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10.3.2

Span menu
·[Span]: press 【Freq】→[Span], to activate the span sub-menu by using number

Span

key, frequency unit or 【↑】 or 【↓】 key and spinning wheel. For details, please
refer to the description of [Span].

Span

·[Special Notice]: use 【↑】 or 【↓】 key and spinning wheel to change span as
per the step size of 1-2-5.

Full Span

·[Full Span]: press 【Freq】→[Span] →[Full Span], to set the current span as
44.1GHz.

Zero Span

·[Zero Span]: press 【Freq】→[Span] →[Zero Span], to set the current span as
0Hz.

Last Span

·[Last Span]: press 【Freq】→[Span] →[Zero Span], to recover the span to last
value.
>

·[Back]: press 【Freq】→[Span] →[Back], to return to [Freq] sub-menu.

>

Back

10.3.3

Amplitude menu

Amplitude
Ref Level
0.0 dBm
Ref Position
Atten
Auto
Man
Scale/Div
20.0dB
Alarm
Off

On

·[Ref Level]: press 【Ampt】→[Ref Level], to set the ref level by using the number
key on front panel, [dBm], [-dBm], [mV] or [uV] or 【↑】 or 【↓】 key and
spinning wheel.
·[Special Notice]: in case of using 【↑】 or 【↓】 key and spinning wheel, the
step is 10dB.
·[Ref Position]: press 【Ampt】→[Ref Position], to change the ref position by using
the number key or 【↑】 or 【↓】 and spinning wheel.
·[Atten Auto Man]: press 【Ampt】→[Atten Auto Man], to use the menu to
activate the automatic or manual mode of attenuator by number key or 【↑】 or
【↓】 key and spinning wheel.
·[Special Notice]: the setting range of attenuator is 0dB - 50dB with step size of
10dB.
·[Scale/Div]: press 【Ampt】→[Scale/Div], to set the scale/div as 0.1dB～20dB by

Units
dBm

number key or 【↑】 or 【↓】 key and spinning wheel.
·[Units]: the amplitude unit shall be taken as dBm.

Pre Amp
Off
On

·[Pre Amp Off On]: press 【Ampt】→[Pre Amp Off On], to activate or deactivate
the preamplifier.
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10.3.4

Bandwidth menu
·[Res BW Auto Man]: press 【BW】→[Res BW Auto Man], to set the RBW by

BW

using the number key on front panel or 【↑】 or 【↓】 key and spinning wheel.

Res BW
Auto
Man
Video BW
Auto
Man

·[Special Notice]: the RBW depends on the bandwidth of intermediate
frequency filter while the shape of trace depends on the intermediate
frequency bandwidth filter. This apparatus can change the RBW within
1Hz~10MHz and at the step size of 1-3-10.
·[Video BW Auto Man]: press 【BW】→[Video BW Auto Man ], to change the

Video Type
Lin
Log

video bandwidth by using the number key or 【↑】 or 【↓】 key and spinning
wheel.

Average
Off
On

·[Special Notice]: the video bandwidth filter is used to smooth trace so as to
improve the ability of detecting weak signal in noise signal. This apparatus
can change the RBW within 1Hz~10MHz and at the step size of 1-3-10.

Span/RBW
100

·[Video type Lin Log]: press 【BW】→[Video type Lin Log], to set the data
processing of video bandwidth filter.

RBW/VBW
1
Detector
Auto

·[Average Off On]: press 【BW】→[Average Off On], to smoothen the trace by
>

using the number key or 【↑】 or 【↓】 key and spinning wheel when the video
bandwidth filter is not changed.
·[SPAN/RBW]: press 【BW】→[SPAN/RBW], to set the ratio between span and
RBW by using the number key or 【↑】 or 【↓】 key and spinning wheel. Under
the automatic mode, the RBW will vary with span.
·[RBW/VBW]: press 【BW】→[RBW/VBW], to set the ratio between RBW and
VBW by using the number key or 【↑】 or 【↓】 key and spinning wheel. Under
the automatic mode, the video bandwidth will vary with RBW.
·[Detection]: press 【BW】→[Detector], to open the detection sub-menu. For
details, please refer to [Detector] menu.
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Detector
Auto

·[Auto]: press 【BW】→[Detector] →[Auto]. The detection is same with spectral
analysis mode.
·[Normal]: press 【BW】→[Detector] →[Normal]. This is a most common
detection mode, through which the signal and noise floor can be displayed without
signal loss.

Normal

·[Peak]: press【BW】→[Detector] →[Peak], to ensure no loss of any peak signal.
This is used to measure the signal which is very close to the noise floor.

Peak

·[Neg Peak]: press 【 BW 】 → [Detector] → [Neg Peak], to reproduce the
modulation envelope. This is used in self-inspection of integrated bandwidth
millimeter wave tester in most circumstances but it is rarely used in test.

Neg Peak

Sample

·[Sample]: press 【BW】→[Detector] →[Sample]. This is helpful to measure the
noise signal. Compared with standard detection, it can measure the noise in a
better way.

Average

·[Average]: press 【BW】→[Detector] →[Average], to conduct the average
processing of data within sampling interval.

RMS

·[RMS]: press 【BW】→[Detector] →[RMS], to conduct the RMS processing of
data within sampling interval.

>

Back

10.3.5

Marker menu
Marker

·[Marker 1 2 3 4 5 6]: press 【Marker】→[Marker 1 2 3 4 5 6], to activate the
different marker display. The selected marker will be underlined.

Marker
123456

·[Normal]: press 【Marker】→[Normal], to set the current marker display mode as
normal.

Normal

Delta
Marker Noise
Off
On
Counter Mkr
Off
On
Marker-> >

·[Delta]: press 【Marker】→[Delta], to set the current marker display mode as
delta. The delta shows the frequency difference and amplitude difference between
difference marker and reference marker (or time difference under zero span). If
amplitude, the show value is expressed in dB.
·[Marker Noise Off On]: press 【Marker】→[Marker Noise Off On], to show the
noise power which is used to normalize the noise adjacent to the activated marker
to 1Hz bandwidth. At this time, the detector is set as sampling detection mode.
After the marker noise is activated, the unit of marker reading is automatically
switched to dBm/Hz.
·[Marker->]: press 【 Marker 】 → [Marker->], to open the marker function
sub-menu. This function enables that user can use the marker to change the
apparatus display. For details, please refer to [Marker→] function menu.

Off

·[Marker Off]: press 【Marker】→[Marker Off], to deactivate the current marker.
·[All Off]: press 【Marker】→[All off], to deactivate all activated markers.

All Off
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·[Marker->Center Freq]: press 【 Marker】 → [Marker->] → [Marker->Center
Freq], to move the marker to the center frequency place and display the reading of
center frequency on screen.

Marker->
Marker->
Center Freq

·[Marker->Step Freq]: press 【Marker】→[Marker->]→[Marker->Step Freq], to
set the step size of center frequency, namely, the frequency step is equal to marker
frequency. When the difference marker function is activated, the frequency step is
equal to the frequency of difference marker.

Marker->
CF Step
Marker->
Start

·[Marker->Start Freq]: press 【Marker】→[Marker->]→[Marker->Start Freq], to
set the start frequency as marker frequency.

Marker->
Stop

·[Marker->Stop Freq]: press 【Marker】→[Marker->]→[Marker->Stop Freq], to
set the stop frequency as marker frequency.
>

·[Return]: return to the previous menu.

< Back

10.3.6

Peak menu
Peak
频率

Peak
Search
中心频率

Next
Peak >
扫宽

Next
Pk Left
起始频率

Next
Pk Right
终止频率
步进频率
Max Search
自动
手动
信号跟踪
Min Search
关
开
Peak
Track
信号标准
Off -- On
Marker->
信道号
Center
--
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·[Peak Search]: press 【Peak】→[Peak Search], to set the current marker at the
maximum peak point of measuring trace and indicate the frequency and amplitude
of the marker.
·[Next Peak]: press 【Peak】→[Next Peak], to move the marker to next peak point
on trace which is linked with current marker.
·[Next Pk Left]: press 【Peak】→[Next Pk Left], to search the next peak on the left
of current marker position.
·[Next Pk Right]: press 【Peak】→[Next Pk Right], to search the next peak on the
right of current marker position.
·[Max Search]: this is used to place a marker at the highest point of trace and
display the frequency and amplitude of the marker in the top right corner of screen.
When this key is pressed, the activated function will not change.
·[Min Search]: this is used to place a marker at the lowest point of trace and
display the frequency and amplitude of the marker in the top right corner of screen.
When this key is pressed, the activated function will not change.
·[Marker→Center]: press 【Peak】→[Marker→Center], to set the center frequency
as marker frequency. This function can quickly move the signal to the center of
screen.
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10.3.7

Sweep menu
Sweep

Sweep Time
Auto Man
Sweep
Cont Single
Sweep Once
Points
[1001]

>

·[Sweep Time Auto Man]: press 【Sweep】→[Sweep Time Auto Man], to switch
the sweep time between automatic and manual modes. The current state will be
underlined. When the sweep time is automatic, the integrated tester will
automatically set the fastest sweep time as per the current apparatus state and the
fastest sweep time will be displayed on screen. When the sweep time is manual, it
is allowed to enter the sweep time by using number key and select the time unit to
complete setting by using relevant soft key. In case of automatic sweep time, the
scan frequency speed will vary with RBW and VBW. The bigger RBW and VBW
are, the quicker the scan speed is; the less RBW and VBW are, the slower the scan
speed is. When the minimum sweep time limit is met, the sweep time of AV4024
series spectrum analyzer can set up to 800s for non-zero span and 600s for zero
span.
·[Sweep Type Cont Single]: press 【Sweep】→[Sweep Type Cont Single], to select
the sweeping mode. The setting of sweep type can decide the scanning direction of
an integrated tester and the time when it can stop scanning and enter the hold
mode. Under the interference analysis mode, there are two sweeping modes,
continuous sweeping and single sweeping.
·[Sweep Once]: press 【Sweep】→[Sweep Once], to start single again.
·[Points]: press 【Sweep】→[Points], to select the scan points as [201], [501],
[1001], [2001] and [4001].

10.3.8

Record menu
Record

Sweep Interval
Auto
Sweep Span
Auto
Record
Off
On

·[Swp Interval]: press 【Record】→[Swp Interval Auto], to set the scan interval.
After the sweep time is set, the trace will switch to the maximum hold mode by
default to ensure that all measured signals within scan interval can be recorded.
·[Sweep Span]: press 【Record】→[Sweep Span Auto]. The span time means the
whole sweep time. When the span time is reached, the record will stop.
·[Record Off On]: press 【Record】→[Record Off On], to switch the auto save
switch by menu.
·[Special Notice]: the auto save function can be activated after the span time is set.
·[Time Cursor]: press 【Record】→[Time Cursor], to view the historical data.

Time Cursor
0

·[Special Notice]: it can be used only under the waterfall chart measurement
mode.
>

·[Restart]: press 【Record】→[Restart], to restart the scanning.

Restart
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10.3.9

Configuration menu
·[Tune&Listen]: press 【Config】→[Tune&Listen], to activate the Tune Listen
function. For details, please refer to the description of [Tune Listen] menu.

Config
Tune&Listen >

·[IQ Capture]: press 【Config】→[IQ Capture], to activate IQ Capture function.
For details, please refer to the description of [IQ Capture] menu.

IQ Capture >

·[Threshold 15.0]: press 【Config】→[Threshold 15.0], to set the threshold value
by using number key, spinning wheel or up or down key.

ThresHold
15.0
List
Detail
Brief

·[List Detail Brief]: press 【Config】→[List Detail Brief], to select the signal list
display mode by menu. Under the brief mode, display the frequency, bandwidth
and amplitude of capturing the interference signal; under the detail mode, display
the capture time and capture frequency of signal.

10.3.10 Tune Listen menu
Tune & Listen

·[Tune&Listen Off On]: press 【Config】→[Tune&Listen]→[Tune&Listen Off
On], to activate or deactivate the Tune Listen function.

Tune & Listen
Off
On

·[Demod type]: press 【Config】→[Tune&Listen]→[Demod type], to set the
demodulation type. It is allowed to select [FM], [AM], [USB] or [LSB].

Demod type
FM

·[Listen Time]: press 【Config】→[Tune&Listen]→[Listen Time], to set the listen
time.

Listen Mode
Int Cont

·[Listen Mode]: press 【Config】→[Tune&Listen]→[Listen Mode], to set the
listen mode. the default state is intermittent listen mode, under which the data will
be first scanned for one screen and then be demodulated as per listen time and
such cycle will recirculate; the continuous mode is to scan the data for one screen
and then demodulate continuously till that the data is not scanned.

Volume
95

·[Volume]: press 【Config】→[Tune&Listen]→[Volume], to set the sound volume
of loudspeaker under listen mode.

Listen Time
100.00ms

>
信号跟踪
< Back
关
开
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10.3.11 IQ Capture menu
IQ Capture

·[IQ Capture Off On]: press 【Config】→[IQ Capture]→[IQ Capture Off On], to
activate or deactivate IQ Capture function.

IQ Capture
Off
On

·[Start Capture]: press 【Config】→[IQ Capture]→[Start Capture], to start IQ
data capture and record function.

Start Capture

·[Capture Time]: press 【Config】→[IQ Capture]→[Capture Time], to set IQ
Capture Time. It should be noted that IQ Capture Time cannot exceed sweep time.

Capture time
1.000ms

·[Capture Type]: press 【Config】→[IQ Capture]→[Capture Type], to set IQ
Capture type as single or continuous.

Capture Mode
Single Cont

·[Sample Rate]: press 【Config】→[IQ Capture]→[Sample Rate], to pop up the
dialog box of sample rate and set the sample rate of IQ Capture as 12.5MHz,
5MHz, 1.25MHz, 500kHz, 125kHz or 50kHz.

Sample Rate
5.000MHz

·[Triggering]: press 【Config】→[IQ Capture]→[Triggering], to select [Free Run]
or [External]. In case of external trigger, it is allowed to set [Slope] or [Delay].

Triggering
>
[Free Run]

·[Save Name]: press 【Config】→[IQ Capture]→[Save Name], to set the name of
IQ Capture file.

Save Name
IQCapture
< Back
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10.3.12 ShortCut menu
ShortCut
Center Freq

·[Center Freq]: press 【ShortCut】→[Center Freq], press 【Freq】→[Center
Freq], to set the center frequency by using the number key on front panel, [GHz],
[MHz], [kHz] or [Hz] or 【↑】 or 【↓】 key and spinning wheel in frequency unit
menu.
·[Span]: press 【ShortCut】→[Span],press 【Freq】→[Span], to activate the span

Span

sub-menu by using number key, frequency unit or 【↑】 or 【↓】 key and spinning
wheel.

Tune&Listen
Off
On

·[Tune Listen Off On]: press【ShortCut】→[Tune&Listen Off On], to activate or
deactivate the tune listen function.

IQ Capture
Off
On

·[IQ Capture Off On]: press 【ShortCut】→[IQ Capture Off On], to activate or
deactivate IQ Capture function.

Start Capture

Peak Search

·[Start Capture]: press 【ShortCut】→[Start Capture], to start IQ Capture.
·[Peak Search]: press 【ShortCut】→[Peak Search], to set the current marker at
the maximum peak point of measuring trace and indicate the frequency and
amplitude of the marker.

Marker->
Center

·[Marker→Center Freq]: press 【ShortCut】→[Marker→Center Freq], to set the
center frequency as marker frequency. This function can quickly move the signal
to the center of screen.

Signal List
Off
On

·[List Off On]: press 【ShortCut】→[List Off On], to open or close the signal list.

10.3.13 File menu
Please refer to the file menu description under spectral analysis mode.
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Chapter XI Operating Principle
4024 series spectrum analyzers have four operating bands: 9kHz-20GHz, 9kHz-26.5GHz, 9kHz-32GHz
and 9kHz-44GHz, and various measurement functions such as spectrum measurement analysis, field
strength measurement, occupied bandwidth measurement, channel power measurement, adjacent channel
power measurement, tune listening and IQ capture. With options for interference analysis, AM-FM-PM
signal demodulation analysis and USB power measurement, the RF signal parameters such as the frequency
and amplitude can be measured. The functional block diagram of 4024 series spectrum analyzer is shown in
Fig. 11-1.

Keyboa
rd

CPU board
FPGA/
CPLD

External
trigger input

Interface
and display
drive

GPS

Battery
DC power

IF A/D

Gain control
and filtering
ARM core
module

LCD
Touch
screen
Power probe

IF channel board

Power
conversion and
management

IF Output

Microwave MMW
frequency conversion
module
Switch filtering and
frequency conversion
Program-controlled
attenuator

RF input

Frequency synthesizer
board
LO generation
Reference ring

10MHz
reference
input/output

Fig. 11-1 Overall Functional Block Diagram
System hardware can be divided into the microwave MMW frequency conversion module, frequency
synthesizer board, IF channel board, CPU board, display, keyboard, battery, etc.
The microwave MMW frequency conversion module includes two parts: 60dB program-controlled step
attenuator and switch filtering and frequency conversion part. The attenuation value of the
program-controlled step attenuator is automatically associated according to the reference level or manually
set by the user to provide the appropriate mixer level. The switch filtering and frequency conversion part is
used for band filtering and frequency conversion of RF input signals and output of IF signals to the IF
channel board.
The IF channel board is used for filtering IF signal input of the frequency conversion module. Gain control
is implemented based on bands so as to adjust the amplitude of AD sample signals and finally output
differential digital signals to FPGA after AD conversion, so as to achieve the functions of digital
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down-conversion, IF filtering, video filtering, etc.
The CPU board includes the power conversion and management circuit, interface and display circuit,
FPGA/CPLD control and digital signal processing circuit and ARM core module, and is used for DC/DC
conversion and operation management of the power supply of the whole instrument, digital signal
processing, logic circuit control, etc. Finally, digital signals in the sweep curve, spectrogram and other
forms, as test results are transmitted to the LCD display.
The frequency synthesizer board has the function of providing 10MHz reference input/output for the
outside, with the internal reference ring output signal as the LO frequency reference, and also providing
high-stability clock signals for AD sampling and FPGA. The LO generation circuit is used for providing
LO signals for the mixer in the microwave MMW frequency conversion module, and related to the
hardware sweeping speed, phase noise, sideband emission and other specifications of the whole instrument.
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Chapter XII Performance Characteristic Test
Sufficient test equipment and inspection facilities of appropriate accuracy and quality should be provided
according to the requirements of GB/T 6592-1996, and be calibrated by the measurement department and
within the validity of measurement. You may also use other instruments meeting the test requirements of
this standard. Refer to the table below for test instruments.
Table 12-1 Recommended Instruments for 4024 Series Spectrum Analyzer

S/N

Instrument name

Recommended
cable

Main technical indexes

Frequency range: 250kHz to 50GHz
Power output: -100dBm to +15dBm
signal Frequency accuracy: ±0.02%
1464C
Power level capable of being calibrated and saved
Or E8257D
With the functions of internal and external AM and
low-frequency output.

1

Synthesized
generator

2

Spectrum analyzer

Frequency range:
<-100dBm

3

Function generator

Waveform: Sine, triangle, square, etc.
Frequency range: 1μHz-80MHz
Amplitude range: 1mV to 10V

Agilent 33250A

4

Power meter

Power range: -70dBm to +20dBm
Calibrator frequency: 50MHz
Calibrator amplitude: 0dBm

Anritsu
ML2437A

5

Power probe

Frequency range: 10MHz~50GHz
Power range: -70dBm to +20dBm

Anritsu
MA2445D

6

Vector
Analyzer

Frequency range: 50MHz to 50GHz

N5247A or
36587A

7

Power divider

Frequency range: 50kHz to50GHz
Insertion loss: <8dB

81313 or
11667C

8

Frequency range: 300kHz to 4GHz; orientation:
RF directional coupler 35dB
70607
VSWR: <1.45

9

Directional coupler

10

Low-pass filter

11

Low-pass filter

12

Low-pass filter

13

Low-pass filter

14

50Ω adapter

Network

3Hz

to

26.5GHz,

DANL: 4051E or
E4440A

Frequency range: 2GHz to 50GHz; coupling: 16dB
Orientation: 14dB; flatness: 0.75dB
VSWR: <1.45; insertion loss: <1.3dB

70603

Cutoff frequency: 1.0GHz; insertion loss: <0.9dB;
SLP-1200
out-of-band suppression: >65dB
Cutoff frequency: 6.8GHz; insertion loss: <2dB;
81613
out-of-band suppression: >50dB
Cutoff frequency: 18GHz; insertion loss: <2dB;
FLP-1800
out-of-band suppression: >40dB
Cutoff frequency: 26.5GHz; insertion loss: <2dB;
FLP-2650
out-of-band suppression: >40dB
Impedance: 50Ω
70508

151

Chapter XIII Performance Characteristic Test

Table 12-2(continued) Recommended Instruments for 4024 Series Spectrum Analyzer

S/N

Instrument name

Main technical indexes

15
16
17
18
18
19
20
21

Adapter
Adapter
Adapter
Adapter
Adapter
Adapter
Adapter
Cable

2.4mm(f)-2.4mm(f)
3.5mm(m)-3.5mm(m)
2.4mm(f)-3.5mm(f)
2.4mm(m)-3.5mm(m)
3.5mm(f)-3.5mm(f)
BNC(f)-SMA(m)
BNC(m)-BNC(f)-BNC(m)
BNC(m)-BNC(m), two

22

Low-loss cable

2.4mm cable (m-m), two

23

Computer
Win XP or Win7 platform
Leakage
current
Leakage current: 0.5 mA ~ 20 mA; voltage: 242 V, 3
withstand
voltage
CJ2673
kV, 5 kV
tester
Variable-frequency
Frequency: 47 Hz ~ 400 Hz; voltage: 0 ~ 3,000 V
AFC-1kW
power supply
High/low-temperature
Temperature: -70°C to +150°C; humidity:
alternating temperature
ESL-10P
25-98%RH
& humidity chamber
High/low-temperature
temperature
& Temperature: -70°C to +80°C; humidity: 50-98%RH Y751C
humidity exchange box
Impact test bench
Maximum load: 100kg; acceleration: (50-400) m/s2 P-100
Maximum load: 500kg; maximum displacement:
Electrodynamics
51mm(p-p)
DC-3200-36
vibration generator
Rated thrust: 31.36kN; frequency range: 5-2500Hz
Leakage
current
Leakage current: 0.5 mA ~ 20 mA; voltage: 242 V, 3
withstand
voltage
CJ2673
kV, 5 kV
tester
Digital display megger FLUKE1508
FLUKE1508

24
25
26

27
28
29

30
31

The tester of the same performance characteristics can be used as a substitute,
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Recommended
cable
711120
71119
71125
71122
BNC/SMA-JK
BNC-KJK
Self-produced
11PA-11PA-PT
H147-1500-J
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This section provides the recommended method for testing of main technical specifications of 4024 series
spectrum analyzer, which can fully reflect the performance and status of this instrument. The following
indicator test of the spectrum analyzer must not be performed until no error prompt appears after at least 2h
storage in the stable operating environment and 15min warm-up.

Detailed operation procedures for each index test are prepared according
to test instrument in the diagram. If other equivalent test instrument is adopted,

Caution

refer to the instructions of the test instrument for operation procedures. Reset
instrument in test procedures refers to manufacturer's reset mode. If the
instrument is under reset state defined by user, change it into manufacturer's
reset state and then reset, ensuring original state of the instrument is known.

1. Frequency range
Description: The frequency range of the spectrum analyzer is tested with one 9kHz signal and one signal
with the frequency equal to the upper limit of the spectrum analyzer. The signals within the nominal
frequency range of 4024 series spectrum analyzer are generated by the signal generator of high frequency
stability and applied to test whether the frequency measurement capabilities of 4024 series comply with the
requirements.
a) Test equipment
Synthesized signal generator ....................................................................................................... 1464C
b) Adapters
Two 2.4mm(f)-2.4mm (f) adapters
One BNC(m)-3.5mm(f) adapter
One 2.4mm(f)-3.5mm(m) adapter
c) Cables
One BNC(m-m) cable
One 2.4mm(m-m) cable
d) Test steps
BNC cable
10MHz IN
Adapter

Adapter

10MHz output

Adapter
Synthesized signal generator

Adapter
2.4mm cable

Spectrum analyzer

Fig. 12-1Frequency Range Test
1) Connect the test equipment as shown by dotted lines in Fig. 12-1. Use 4024 series spectrum analyzer
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(hereinafter referred to as the spectrum analyzer) to provide the reference frequency for the synthesized
signal generator 1464C. Connect the low-frequency output port of the synthesized signal generator to the
RF input end of the spectrum analyzer (as shown by the dotted line in Fig. 12-1).
2) Set the synthesized signal generator as follows. 【Freq】 [Set LF generator] 【Freq】 9kHz, 【Ampt】
-10dBm, [Back], [LF Output Off On].
3) Set the center frequency of the spectrum analyzer as 9kHz, span as 1kHz, reference level as 0dBm,
resolution bandwidth as 10Hz and other items into the AUTO mode. Press 【Peak】 on the spectrum
analyzer. If the marker points at the maximum signal response, the marker amplitude is free from obvious
jitter and the signal is clear, the corresponding center frequency is the lower limit of the frequency range.
Compare this value and that of the corresponding test item in the Performance Test Schedule of Records of
4024 Series Spectrum Analyzer (hereinafter referred to as the Schedule of Records of 4024 Series Spectrum
Analyzer). Mark “√” if the comparison result complies with requirements of the records; otherwise, mark
“×”.
4) As shown by the solid lines in Fig. 12-1, connect the synthesized signal generator with the adapter and
cable, and then connect the RF output end of 1464C to RF input end of the spectrum analyzer. Set the
output frequency of the signal generator as the maximum frequency of the spectrum analyzer of the
corresponding model, disable the modulation function, and set the output power as -10dBm.
5) Set the center frequency of the spectrum analyzer as the maximum frequency of the corresponding
model, the span as 1kHz, reference level as 0dBm, resolution bandwidth as 10Hz and other items into the
AUTO mode. Press 【Peak】 on the spectrum analyzer. If the marker points at the maximum signal
response, the marker amplitude is free from obvious jitter and the signal is clear, the corresponding center
frequency is the upper limit of the frequency range. Compare this value and that of the corresponding test
item in the Performance Test Schedule of Records of 4024 Series Spectrum Analyzer (hereinafter referred
to as the Schedule of Records of 4024 Series Spectrum Analyzer). Mark “√” if the comparison result
complies with requirements of the records; otherwise, mark “×”.

2. Frequency readout accuracy
Description: The frequency accuracy represents the proximity of the frequency value measured by the
spectrum analyzer to the corresponding true value. The frequency value measured by sweeping of the
spectrum analyzer is affected by the reference frequency, sweep width, resolution bandwidth, etc. The
frequency readout accuracy, representing the difference between the measured value to true value, is tested
with an input signal of the known frequency. The smaller the difference is, the higher the accuracy is.
a) Test equipment
Synthesized signal generator ...................................................................................................... 1464C
b) Adapters
Two 2.4mm(f)-2.4mm (f) adapters
c) Cables
One 2.4mm(m-m) cable
d) Test steps
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2.4mm cable

Synthesized signal generator

Adapter

Adapter
Spectrum analyzer

Fig. 12-2 Block Diagram of Test of Frequency Readout Accuracy
1) As shown in Fig. 12-2, connect the test instrument, and then connect the RF output end of the signal
generator to RF input end of the spectrum analyzer.
2) Press 【Preset】 on the signal generator. According to the requirements in the “Frequency Readout
Accuracy” column in the Schedule of Records of 4024 Series Spectrum Analyzer, set the output frequency
of the signal generator as f0, power level as -10dBm, and enable the RF output.
3) Set the center frequency of the spectrum analyzer as f0, span as 500kHz, reference level as 0dBm and the
resolution bandwidth and sweep time into the AUTO mode.
4) Press 【Peak】 on the spectrum analyzer, and read the signal peak frequency fs with the marker.
5) Calculate the frequency readout error Δf by Formula (1):
Δf=fs-f0

(1)

6) Record Δf as the test result into the corresponding test item of the Schedule of Records of 4024 Series
Spectrum Analyzer.
7) Repeat Step 2 to 6 to all frequency and span combinations under the corresponding test items of the
Schedule of Records of 4024 Series Spectrum Analyzer.

3. Sweep width accuracy
Description: Use two synthesized signal generators to provide two signals of known frequency as the input
of the spectrum analyzer. Set the center frequency of the spectrum analyzer as the median of such two
frequencies. Measure the frequency difference of such two signals by the marker function. Calculate and
record the measured difference and the error percentage of the difference marker to span. The frequency
reference of both signal generation should be the same as that of the spectrum analyzer.
Note: It is allowed to use only one signal generator for test. At first, set the center frequency and span of the
spectrum analyzer. Set the frequency of the signal generators as that of the first signal generator. Set the
differential marker on the spectrum analyzer and then set the frequency of the signal generator as that of the
second signal generator. Read the differential marker of both signals on the spectrum analyzer, and record
it as the measured value. The reference frequency of the signal generators should be the same as that of the
spectrum analyzer.
a) Test equipment
Synthesized signal generator ....................................................................................................... 1464C
b) Adapters
Two 2.4mm(f)-2.4mm (f) adapters
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c) Cables
One BNC(m-m) cable
One 2.4mm(m-m) cable
d) Test steps

BNC cable

10MHz IN

Adapter

10MHz output

Synthesized signal generator
Adapter
2.4mm cable

Spectrum analyzer

Fig. 12-3 Setting for Bandwidth Accuracy Test
1) Connect the test instrument as shown in Fig. 12-3. The spectrum analyzer will provide the frequency
reference for the synthesized signal generator.
2) Set the center frequency f0 of the spectrum analyzer as 22GHz (10GHz for 4024 D series, 13.25GHz for
4024 E series and 16GHz for 4024 F series) and the reference level as 0dBm. Set the span according to the
requirements in the “Span Accuracy” column of the Schedule of Records of 4024 Series Spectrum
Analyzer.
3) Set the output frequency of the signal generator as f1 (f1= f0-0.4× span, where the span is the set span of
the spectrum analyzer), and the power as -10dBm. Enable the RF output.
4) Press 【Peak】, 【Marker】 and [Delta] in sequence on the spectrum analyzer.
5) Set the output frequency of the signal generator as f2 (f2= f0+0.4× span) and the output power as
-10dBm.
6) Press 【Peak】 on the spectrum analyzer, and set the differential marker as f2. After sweeping, read the
frequency difference Δf of both signals.
7) Record the frequency difference Δf, and calculate the span accuracy by the following formula:
Span accuracy=100×[Δf-(0.8× span) ]/(0.8× span)%

(2)

Record the results corresponding to the test items in the Schedule of Records of 4024 Series Spectrum
Analyzer.
8) Disable all markers. Respectively set the span of the spectrum analyzer and frequency of the signal
generator according to the span of the spectrum analyzer in the table of records, and repeat Step 3-8 until
all spans are tested.

4. Sweep time
Description: The AM signal will be displayed on the spectrum analyzer under zero span. Adjust the
frequency of the modulation signal until the peak interval is uniformly distributed on the screen. Count the
frequency of the modulation signal and calculate the actual sweep time. Compare the calculated value with
the specified time to obtain the sweep time accuracy. The sweep time accuracy is guaranteed in the design.
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In order to reduce the test time, the typical sweep time should be applied in testing and verification.
Note: The synthesized signal generator and function generator can be substituted by the synthesized signal
generator with the built-in AM option.
a) Test equipment
Synthesized signal generator ....................................................................................................... 1464C
Function generator Agilent ........................................................................................ Agilent 33250A
b) Adapters
Two 2.4mm(f)-2.4mm(f) adapters
c) Cables
Two BNC(m-m) cables
One 2.4mm(m-m) cable
d) Test steps

10MHz input

BNC cable
Adapter

10MHz output

Synthesized signal generator
Adapter
AM IN
2.4mm cable

Function generator

Spectrum analyzer

BNC cable

Fig. 12-4 Setting for Sweep Time Accuracy Test
1) Connect the test equipment as shown in Fig. 12-4. Connect the output of the function generator to the
AM input end of the signal generator, and the RF output of the signal generator to the RF input port of the
spectrum analyzer to be tested. The spectrum analyzer will provide the frequency reference for the
synthesized signal generator.
2) Set the center frequency of the spectrum analyzer as 4GHz, span as 0Hz and resolution bandwidth and
video bandwidth respectively as 10MHz. The sweep time can be set as min. 10μs and max. 600s. Mark “√”
if such settings comply with the requirements of the “Sweep Time Range (zero span)” in the Schedule of
Records of 4024 Series Spectrum Analyzer; otherwise, mark “×”. ”
3) Reset 1464C instrument, and finish the following settings: 4GHz frequency, -5dBm power, [Modulation]
[AM] [Amplitude Input], [External], [Back], [AM On Off]. Enable AM and RF output.
4) Finish the following settings with soft keys on Agilent 33250A: 【Ampt】, 1 [Vrms], [Offset] 0 [V],
[Output]. Set the output waveform as [RAMP].
5) Set the scale type of the spectrum analyzer as “Linear”, detector mode as “Peak”, resolution bandwidth
as 3MHz and video bandwidth as 3MHz.
6) Set 【Freq】10 [kHz] on Agilent 33250A. Set the spectrum analyzer: [Sweep time] 1[ms], [Sweep Type
Cont Single].
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7) Set the spectrum analyzer by pressing 【Peak】 and [Next Pk Left] or [Next Pk Right] to locate the
marker at the first peak on the left. Press 【Marker】 [Delta]. Then press 【Peak】 and [Next Pk Left] or
[Next Pk Right] to locate the marker on the ninth peak on the left. Read the differential marker and perform
the following calculation:
Sweep time error=100×((delta marker reading ×1.25-set sweep time ) /set sweep time)%

(3)

Record the calculation data corresponding to 1ms sweep time of the test items in the Schedule of Records
of 4024 Series Spectrum Analyzer.
8) Disable the marker and repeat Step 6 to 7 corresponding to other sweep time values in the table. Set the
modulation rate (frequency) in Step 6 according to the following formula:
Modulation rate = 10/set sweep time

(4)

5. Resolution bandwidth
Description: The resolution bandwidth represents the ability of the spectrum analyzer to clearly separate
two input signals. It is affected by the IF filter bandwidth, phase noise, sweep time, etc. Most of spectrum
analyzer are equipped with the LC filter, crystal filter, SAW and digital filter to achieve various resolution
bandwidths.
Connect the output of the synthesized signal generator to the RF input end of the spectrum analyzer. Set the
bandwidth of 4024 series approximately as twice of the current resolution bandwidth (-3dB for
conveniences in measurement). Reduce the output amplitude of the signal source by 3dB to achieve -3dB.
Set the marker reference; increase the output of the signal source by 3dB to the previous level, and start
sweeping. The marker difference is the measured value corresponding to 3dB bandwidth.
The reading of the 3dB bandwidth test function of 4024 series can be used as the test value. The span error
of 4024 series may result in some errors of the resolution bandwidth accuracy. Compared with the
resolution bandwidth error, the span error can be ignored.
a) Test equipment
Synthesized signal generator....................................................................................................... 1464C
b) Adapters
Two 2.4mm(f)-2.4mm(f) adapters
c) Cables
One BNC(m-m) cable
One 2.4mm(m-m) cable
d) Test steps
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10MHz input

BNC cable

Adapter
10MHz output
Synthesized signal generator
Adapter
2.4mm cable

Spectrum analyzer

Fig. 12-5 Setting for Resolution Bandwidth Accuracy Test
1) Connect the test equipment as shown in Fig. 12-5. The spectrum analyzer will provide the frequency
reference for the signal generator.
2) Set the synthesized signal generator as follows: frequency: 100MHz; power: -2dBm; power step: 1dB.
3) Reset the spectrum analyzer. Press 【Measure】 [OBW] to enable the occupied bandwidth measurement
function. Select the dBc method and change X into -3.01dB.
4) Set the spectrum analyzer as follows: center frequency: 100MHz span: 30MHz; amplitude scale:
1dB/division; resolution bandwidth; 10MHz; other items: default.
5) Adjust the output power of the synthesized signal generator until the signal level is 2-3 divisions less
than the reference level.
6) Make 4024 series instrument search the peak. Record the marker difference Δf-3dB corresponding to
3dB bandwidth. Calculate the resolution bandwidth accuracy δ by the following formula, and record the
calculation result under the corresponding test item in the Schedule of Records of 4024 Series Spectrum
Analyzer.



f 3dB  RBW
100%
RBW

(5)

7) Set the spectrum analyzer according to the resolution bandwidth listed under the “Resolution Bandwidth
Accuracy” item in the Schedule of Records of 4024 Series Spectrum Analyzer. Set the bandwidth
approximately as twice of the resolution bandwidth, and repeat Step 6 to 7 until all resolution bandwidth
values are tested.

6. Resolution bandwidth conversion uncertainty
Description: Connect the RF output of the synthesized signal generator to the input port of the spectrum
analyzer, and adjust the output signal amplitude until the signal level is 2-3 divisions less than the reference
level of the spectrum analyzer. Fix the amplitude of the synthesized signal generator and change the
resolution bandwidth of the spectrum analyzer. The difference is the uncertainty of resolution bandwidth
conversion. The resolution bandwidth step of 4024 series spectrum analyzer is 1-3.
a) Test equipment
Synthesized Signal generator ...................................................................................................... 1464C
b) Adapters
Two 2.4mm(f)-2.4mm (f) adapters
c) Cables
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One BNC(m-m) cable
One 2.4mm(m-m) cable
d) Test steps

10MHz output

10MHz input
Adapter

Synthesized signal generator
Adapter
2.4mm cable

Spectrum analyzer

Fig. 12-6 Setting for Resolution Bandwidth Conversion Uncertainty
1) Connect the test equipment as shown in Fig. 12-6. The spectrum analyzer will provide the frequency
reference for 1464C synthesized signal generator.
2) Finish spectrum analyzer settings as follows:
Center frequency ....................................................................................................................2000MHz
Span ...........................................................................................................................................10MHz
Logarithmic scale dB/division ....................................................................................................... 1 dB
Automatic resolution bandwidth ........................................................................................... Automatic
RBW/VBW ........................................................................................................................................ 10
SPAN/RBW ..................................................................................................................................... 100
3) In this case, the resolution bandwidth associated automatically with the spectrum analyzer will be
100kHz. Press 【Peak】 on the spectrum analyzer to set the marker at the peak. Enable the delta mode of
the marker.
4) Set the span of the spectrum analyzer according to the resolution of the corresponding test item in the
Schedule of Records of 4024 Series Spectrum Analyzer. Then set the ratio of the span to resolution
bandwidth as 100.
5) Search the peak and read the amplitude difference of the differential marker. Record it as the conversion
uncertainty of the current resolution bandwidth in the Schedule of Records of 4024 Series Spectrum
Analyzer.
6) Repeat Step 4 and 5 until all resolution bandwidth values are tested.

7. Sideband noise
Description: The sideband noise is an indicator representing the short-time stability of the LO signal
frequency of the spectrum analyzer.
Measure the sideband noise of the 1.0GHz and 0dBm reference signal under the carrier offset of 10kHz,
100kHz, 1MHz and 10MHz. Average the sideband noise of each frequency offset point by the noise marker
and video averaging function. In the case of any spurious response at the set frequency offset, make the
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marker deviated from the spurious response to ensure the accuracy of measurement.
a) Test equipment
Synthesized signal generator ....................................................................................................... 1464C
b) Adapters
Two 2.4mm(f)-2.4mm(f) adapters
c) Cables
One BNC(m-m) cable
One 2.4mm(m-m) cable
d) Test steps
BNC cable
10MHz input
Adapte

10MHz output

Synthesized signal generator
Adapter
2.4mm cable

Spectrum analyzer

Fig. 12-7 Schematic Diagram of Sideband Noise Test
1) Connect the test instrument as shown in Fig. 12-7. The spectrum analyzer will provide the frequency
reference for the synthesized signal generator.
2) Set the output frequency of the signal generator as 1GHz and output power as 0dBm.
3) Set 【Freq】1 [GHz], [Span] 30 [kHz], 【Ampt】 [Ref Level] 0 [dBm] on the spectrum analyzer.
4) Press 【Peak】【Marker】 [Delta] on the spectrum analyzer. Set the differential marker as 10kHz, and
enable the noise marker function.
5) Set the resolution bandwidth and video bandwidth as shown in Table 12-3. Enable the averaging
function, and perform averaging 10 times.
6) Record the amplitude of the differential marker as the sideband noise corresponding to the +10kHz
offset under the related test item in the Schedule of Records of 4024 Series Spectrum Analyzer.
7) Press 【Marker】-10[kHz] on the spectrum analyzer. Record the amplitude of the differential marker as
the sideband noise corresponding to the -10kHz offset under the related test item in the Schedule of
Records of 4024 Series Spectrum Analyzer.
8) Set the spectrum analyzer as shown in Table 12-3. Test the single-sideband noise corresponding to the
±100kHz, ±1MHz and ±10MHz offset. Record the amplitudes of the differential marker under the related
test item in the Schedule of Records of 4024 Series Spectrum Analyzer. Any spurious response at the
frequency offset should be avoided during marker reading in the test.
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Table 12-3 Setting for Sideband Noise Measurement

Frequency
Δf

offset

Span

Resolution

VBW and Average

Bandwidth

±10kHz

30kHz

300Hz

VBW 30Hz Average On

±100kHz

300kHz

3kHz

VBW 300Hz Average On

±1MHz

2.2MHz

10kHz

VBW 1kHz Average On

±10MHz

25MHz

100kHz

VBW 10kHz Average On

8. Display average noise level
Description: The display average noise level refer to the background noise observed on the spectrum
analyzer with no external noise or signal.
Connect the input end of the spectrum analyzer to the 50Ω adapter. Set the input attenuation as 0dB. In this
case, the normalized noise is the test value of the display average noise level.
a) Test equipment
50Ω adapter.................................................................................................................................. 70508
b) Test procedure
1) Connect the 50Ω adapter to the RF input port of the spectrum analyzer as shown in Fig. 12-8.
50Ω adapter

Spectrum analyzer

Fig. 12-8 Setting for Display Average Noise Level Test
Display average noise, pre-amplifier ON (2MHz-10MHz)
2) Finish spectrum analyzer settings as follows:
Starting frequency ........................................................................................................................2MHz
Ending frequency .......................................................................................................................10MHz
Reference level ....................................................................................................................... -50dBm
Marker.................................................................................................................................... [All Off]
Resolution bandwidth ............................................................................................................. 100kHz
Video bandwidth ....................................................................................................................... 30kHz
Pre-amplifier ................................................................................................................................... On
Detector................................................................................................................................ [Average]
3) Press 【Marker】 [Marker Noise Off On] and 【Peak】 [Max Search].
4) Press 【BW】 [Average On Off] 5 [OK], until the average 5/5 appears on the left side of the screen.
5) Read the marker peak, and record it as the display average noise level within 2MHz-10MHz (with the
pre-amplifier ON) under the corresponding test item in the Schedule of Records of 4024 Series Spectrum
Analyzer. Disable the noise marker and averaging function.
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Display average noise, pre-amplifier ON (10MHz-4GHz)
6) Set the starting frequency of 4024 series spectrum analyzer as 10MHz and stop frequency as 4GHz, and
keep other items unchanged.
7) Repeat Step 3 and 4.
8) Read the marker peak, and record it as the display average noise level within 10MHz-4GHz (with the
pre-amplifier ON) under the corresponding test item in the Schedule of Records of 4024 Series
Spectrum Analyzer. Disable the noise marker and averaging function.
Display average noise, pre-amplifier ON (4GHz-6GHz)
9) Set the starting frequency of 4024 series spectrum analyzer as 4GHz and stop frequency as 6GHz, and
keep other items unchanged.
10) Repeat Step 3 and 4.
11) Read the marker peak, and record it as the display average noise level within 4GHz-6GHz (with the
pre-amplifier ON) under the corresponding test item in the Schedule of Records of 4024 Series
Spectrum Analyzer. Disable the noise marker and averaging function.
Display average noise, pre-amplifier ON (6GHz-20GHz)
12) Set the starting frequency of 4024 series spectrum analyzer as 6GHz and stop frequency as 20GHz, and
keep other items unchanged.
13) Repeat Step 3 and 4.
14) Read the marker peak, and record it as the display average noise level within 6GHz-20GHz (with the
pre-amplifier ON) under the corresponding test item in the Schedule of Records of 4024 Series
Spectrum Analyzer. Disable the noise marker and averaging function.
Display average noise, pre-amplifier ON (20GHz-32GHz)
15) Set the starting frequency of 4024 series spectrum analyzer as 20GHz and stop frequency as 32GHz,
and keep other items unchanged.
16) Repeat Step 3 and 4.
17) Read the marker peak, and record it as the display average noise level within 20GHz-32GHz (with the
pre-amplifier ON) under the corresponding test item in the Schedule of Records of 4024 Series
Spectrum Analyzer. Disable the noise marker and averaging function.
Display average noise, pre-amplifier ON (32GHz-40GHz)
18) Set the starting frequency of 4024 series spectrum analyzer as 32GHz and stop frequency as 40GHz,
and keep other items unchanged.
19) Repeat Step 3 and 4.
20) Read the marker peak, and record it as the display average noise level within 32GHz-40GHz (with the
pre-amplifier ON) under the corresponding test item in the Schedule of Records of 4024 Series
Spectrum Analyzer. Disable the noise marker and averaging function.
Display average noise, pre-amplifier ON (40GHz-44GHz)
21) Set the starting frequency of 4024 series spectrum analyzer as 40GHz and stop frequency as 44GHz,
and keep other items unchanged.
22) Repeat Step 3 and 4.
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23) Read the marker peak, and record it as the display average noise level within 40GHz-44GHz (with the
pre-amplifier ON) under the corresponding test item in the Schedule of Records of 4024 Series Spectrum
Analyzer. Disable the noise marker and averaging function.
Display average noise, pre-amplifier OFF (2MHz-10MHz)
24) Set the starting frequency of 4024 series spectrum analyzer as 2MHz, stop frequency as 10MHz and
reference level as -20dBm, enable the OFF state of the pre-amplifier, and keep other items unchanged.
25) Repeat Step 3 and 4.
26) Read the marker peak, and record it as the display average noise level within 2MHz-10MHz (with the
pre-amplifier OFF) under the corresponding test item in the Schedule of Records of 4024 Series Spectrum
Analyzer. Disable the noise marker and averaging function.
Display average noise, pre-amplifier OFF (10MHz-4GHz)
27) Set the starting frequency of 4024 series spectrum analyzer as 10MHz, stop frequency as 4GHz and
reference level as -20dBm, enable the OFF state of the pre-amplifier, and keep other items unchanged.
28) Repeat Step 3 and 4.
29) Read the marker peak, and record it as the display average noise level within 10MHz-4GHz (with the
pre-amplifier OFF) under the corresponding test item in the Schedule of Records of 4024 Series Spectrum
Analyzer. Disable the noise marker and averaging function.
Display average noise, pre-amplifier OFF (4GHz-6GHz)
30) Set the starting frequency of 4024 series spectrum analyzer as 4GHz, stop frequency as 6GHz and
reference level as -20dBm, enable the OFF state of the pre-amplifier, and keep other items unchanged.
31) Repeat Step 3 and 4.
32) Read the marker peak, and record it as the display average noise level within 4GHz-6GHz (with the
pre-amplifier OFF) under the corresponding test item in the Schedule of Records of 4024 Series Spectrum
Analyzer. Disable the noise marker and averaging function.
Display average noise, pre-amplifier OFF (6GHz-20GHz)
33) Set the starting frequency of 4024 series spectrum analyzer as 6GHz, stop frequency as 20GHz and
reference level as -20dBm, enable the OFF state of the pre-amplifier, and keep other items unchanged.
34) Repeat Step 3 and 4.
35) Read the marker peak, and record it as the display average noise level within 6GHz-20GHz (with the
pre-amplifier OFF) under the corresponding test item in the Schedule of Records of 4024 Series Spectrum
Analyzer. Disable the noise marker and averaging function.
Display average noise, pre-amplifier OFF (20GHz-32GHz)
36) Set the starting frequency of 4024 series spectrum analyzer as 20GHz, stop frequency as 32GHz and
reference level as -20dBm, enable the OFF state of the pre-amplifier, and keep other items unchanged.
37) Repeat Step 3 and 4.
38) Read the marker peak, and record it as the display average noise level within 20GHz-32GHz (with the
pre-amplifier OFF) under the corresponding test item in the Schedule of Records of 4024 Series Spectrum
Analyzer. Disable the noise marker and averaging function.
Display average noise, pre-amplifier OFF (32GHz-40GHz)
39) Set the starting frequency of 4024 series spectrum analyzer as 32GHz, stop frequency as 40GHz and
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reference level as -20dBm, enable the OFF state of the pre-amplifier, and keep other items unchanged.
40) Repeat Step 3 and 4.
41) Read the marker peak, and record it as the display average noise level within 32GHz-40GHz (with the
pre-amplifier OFF) under the corresponding test item in the Schedule of Records of 4024 Series Spectrum
Analyzer. Disable the noise marker and averaging function.
Display average noise, pre-amplifier OFF (40GHz-44GHz)
42) Set the starting frequency of 4024 series spectrum analyzer as 40GHz, stop frequency as 44GHz and
reference level as -20dBm, enable the OFF state of the pre-amplifier, and keep other items unchanged.
43) Repeat Step 3 and 4.
44) Read the marker peak, and record it as the display average noise level within 40GHz-44GHz (with the
pre-amplifier OFF) under the corresponding test item in the Schedule of Records of 4024 Series Spectrum
Analyzer. Disable the noise marker and averaging function.

9. Second harmonic distortion
Description: The nonlinear device (such as the mixer, amplifier, etc.) will generate various harmonics of
the input signal if any. The useless second harmonic component of the signal is known as the second
harmonic distortion.
The synthesized signal generator can provide signals through the low-pass filter for the spectrum analyzer
to measure the second harmonic distortion. The low-pass filter is used for eliminating any harmonic
distortion caused by the signal source. The synthesized signal generator is locked at the 10MHz reference
of the spectrum analyzer.
a) Test equipment
Synthesized signal generator ....................................................................................................... 1464C
1.0GHz low-pass filter: 1
6.8GHz low-pass filter: 1
18GHz low-pass filter: 1
b) Adapters
One 2.4mm(f)-3.5mm(f) adapter
One 2.4mm(f)-3.5mm(m) adapter
One 3.5mm(f)-3.5mm(f) adapter
c) Cables
One BNC(m-m) cable
One 3.5mm(m-m) cable
d) Test steps
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BNC

10MHz IN

10MHz output

Synthesized signal generator
Adapter
3.5mm Cable

Spectrum analyzer

Low-pass
Adapter

Adapter

Fig. 12-9 Setting of Second Harmonic Distortion Test
Second harmonic distortion (4GHz)
1) Connect the test instrument as shown in Fig. 12-9. The spectrum analyzer will provide the 10MHz
frequency reference for the synthesized signal generator. Use the 1GHz low-pass filter.
2) Set the frequency of 1464C instrument as 900MHz and amplitude as -30dBm. Enable the RF output.
3) Finish spectrum analyzer settings as follows:
Center frequency ......................................................................................................................900MHz
Span ............................................................................................................................................ 10kHz
Reference level ....................................................................................................................... -30dBm
4) Press 【Peak】 on the spectrum analyzer. Adjust the power level of 1464C spectrum analyzer until its
reading is -30dBm0.1dB.
5) Press 【Marker】 [Delta] and set the center frequency as 1.8GHz.
6) Finish one new sweeping on the spectrum analyzer and press 【Peak】. Record the differential marker
reading as the second harmonic distortion value (4GHz) under the corresponding test item in the Schedule
of Records of 4024 Series Spectrum Analyzer.
Second harmonic distortion (4GHz-10GHz)
7) Connect the test instruments as shown in Fig. 12-9. Use the 6.8GHz low-pass filter.
8) Set the frequency of 1464C instrument as 6GHz and amplitude as -30dBm.
9) Finish spectrum analyzer settings as follows:
Center frequency .......................................................................................................................... 6GHz
Span ............................................................................................................................................ 10kHz
Amplitude ................................................................................................................................. -30dBm
Marker.................................................................................................................................... [All Off]
10) Press 【Peak】 on the spectrum analyzer. Adjust the power level of 1464C spectrum analyzer until its
reading is -30dBm0.1dB.
11) Press 【Marker】 [Delta], and set the center frequency as 12GHz.
12) Press 【Peak】 when sweeping is completed. Record the differential marker as the second harmonic
distortion value (4GHz-10GHz) under the corresponding test item in the Schedule of Records of 4024
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Series Spectrum Analyzer.
Second harmonic distortion (10GHz-22GHz)
13) Connect the test instruments as shown in Fig. 12-9. Use the 18GHz low-pass filter.
14) Set the frequency of 1464C instrument as 18GHz and amplitude as -30dBm.
15) Finish spectrum analyzer settings as follows:
Center frequency ...................................................................................................................... 18GHz
Span........................................................................................................................................... 10kHz
Amplitude............................................................................................................................. -30dBm
Marker ................................................................................................................................. [All Off]
16) Press 【Peak】 on the spectrum analyzer. Adjust the power level of 1464C spectrum analyzer until its
reading is -30dBm0.1dB.
17) Press 【Marker】 [Delta], and set the center frequency as 36GHz.
18) Press 【Peak】 when sweeping is completed. Record the differential marker as the second harmonic
distortion value (10GHz-22GHz) under the corresponding test item in the Schedule of Records of 4024
Series Spectrum Analyzer.

10. 3-order intermodulation distortion
Description: 3-order intermodulation distortion beacuase of device`s nolinear characteristic, it is the
useless spectrum component caused by two or more input signals interaction.
The two synthesized signal generators provide signals for measuring the third-order intermodulation
distortion, the two signals using sine wave and same powern and the frequency space is 100kHz, using
marker function can measure 3-order intermodulation distortion. Use the filter to filter the signal distortion
product that is closest to the signal measured. The spectrum analyzer provides 10MHz reference for the
synthesized signal generator.
Note: For different directional couplers, their isolations and standing waves are different, which may cause
interference between the two signal generators. If necessary, isolators in associated frequency bands can be
connected to the two input ports of the directional couplers.
a) Test equipment
Power meter ........................................................................................................................ ML2437A
Power probe ....................................................................................................................... MA2445D
Synthesized signal generator#1 ................................................................................................... 1464C
Synthesized signal generator#2 ......................................................................................................1461
Directional Coupler ......................................................................................................................70603
RF Directional Coupler ................................................................................................................70607
1.0GHz low-pass filter: 2
6.8GHz low-pass filter: 2
18GHz low-pass filter: 2
b) Adapters
Two 2.4mm(f)-2.4mm(f) adapter
Two 3.5mm(m)-3.5mm(m) adapter
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Two 2.4mm(f)-3.5mm(f) adapter
One 2.4mm(f)-3.5mm(m) adapter
One BNC(T) type(m)(f)(f)
c) Cables
Two BNC(m-m) cable
Two 3.5mm(m-m) cable
Two 2.4mm(m-m) cable
d) Test steps
BNC cable

BNC T Adapter

BNC cable

synthesized signal generator #1 10MHz IN synthesized signal generator #2
10MHz Out

Adapter

Adapter
3.5mm cable

Spectrum analyzer

3.5mm cable

low-pass filter

low-pass filter
Adapter

Adapter

Direct connect, not cable
Adapter RF Directional Coupler

probe
Power meter

Fig.12-10 Setting for 3-order intermodulation distortion Test（50MHz~4GHz）
Third-order Intermodulation Distortion (50MHz~4GHz)
1) Connect the test instrument as shown in Fig. 12-10. Using RF Directional Coupler, do not connect the
directional coupler to the spectrum analyzer.
2) Set the frequency of 1464C instrument as 900MHz and amplitude as 0dBm. Enable the RF output.
3) Set the frequency of 1461 instrument as 900.1MHz and amplitude as -110dBm. Turn off the RF output.
4) Connect ML2437A and MA2445D, and ZERO. Set the frequency of ML2437A as 900MHz.
5) Finish spectrum analyzer settings as follows:
Center frequency ......................................................................................................................900MHz
Step frequency .......................................................................................................................... 100kHz
Span .............................................................................................................................................. 1kHz
Reference level ....................................................................................................................... -10dBm
6) Using adpter to connect MA2445D and the output of the RF Directional Coupler, do not use cable.
7) Adjust the output amplitude of the synthesized signal generator 1464C to make the reading of the power
meter MA2445D to be -15dBm±0.1dB.
8) Connect RF Directional Coupler to the spectrum analyzer.
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9) Press 【Peak】, until sweep done, press 【Marker】[Detal], 【Freq】【↑】.
10) Set 1461 amplitude as -15dBm, enable the RF output.
11) Press 【Peak】.
12) Adjust the output amplitude of the synthesized signal generator 1461 to make the reading of the
spectrum analyzer to be 0dBm±0.1dB.
13) Press 【Marker】[Delta], 【Freq】
【↓】
【↓】, util sweep done, press 【BW】[Average Off On] 5 [Enter],
until video average 5 times done, press 【Peak】.
14) Record the delta marker reading of the spectrum analyzer as the high end product inhibition △A, then
calculate the 3-order intercept point by following formula using △A, (L0 mixer level ):

TOI  L0 

A
2

(6)

15) Press【Freq】【↑】【↑】【↑】, until sweep done, press 【Peak】.
16) Record the delta marker reading of the spectrum analyzer as the high end product inhibition, calculate
the 3-order intercept point by formula (6), compare the high 3-order intercept point and low 3-order
intercept point. Record the lower 3-order intercept point under the corresponding test item in the
Schedule of Records of 4024 Series Spectrum Analyzer
BNC cable

BNC T Adapter

synthesized signal generator #1

BNC cable

synthesized signal generator#2

10MHz IN

10MHz Out

Adapter

Adapter
3.5mm cable

Spectrum analyzer

3.5mm cable

low-pass filter

low-pass filter
Adapter

Adapter

Direct connect, not cable
Adapter Directional Coupler

probe
Power meter

Fig.12-11 Setting for 3-order intermodulation distortion Test（4GHz~44GHz）
Third-order Intermodulation Distortion (4GHz~13GHz)
17) Connect the test instrument as shown in Fig. 12-11. Using Directional Coupler, do not connect the
directional coupler to the spectrum analyzer.
18) Set the frequency of 1464C instrument as 6GHz and amplitude as 0dBm. Enable the RF output.
19) Set the frequency of 1461 instrument as 6.0001GHz and amplitude as -110dBm. Turn off the RF
output.
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20) Set the frequency of ML2437A as 6GHz.
21) Press 【Marker】[Normal], set center frequency to 6GHz.
22) Repeat Step 6~16.
Third-order Intermodulation Distortion (13GHz~44GHz)
23) Connect the test instrument as shown in Fig. 12-11. Using Directional Coupler, do not connect the
directional coupler to the spectrum analyzer.
24) Set the frequency of 1464C instrument as 15GHz and amplitude as 0dBm. Enable the RF output.
25) Set the frequency of 1461 instrument as 15.0001GHz and amplitude as -110dBm. Turn off the RF
output.
26) Set the frequency of ML2437A as 15GHz.
27) Press 【Marker】[Normal], set center frequency to 15GHz.
28) Repeat Step 6~16.

11.1dB Gain Compression
Description: Increasing input signal level will make device (such as the mixer, amplifier, etc.) work on
nearby saturation point, and the input signal level when output level under linear value 1dB as 1dB Gain
Compression.
This test uses two signals with 10MHz interval to measure the gain compression of the spectrum analyzer.
In the test, first input the low-level signal to the spectrum analyzer (lower than -10dBm). Then input the
specified high amplitude signal to the spectrum analyzer. The amplitude decrease of the first signal caused
by the second signal is the gain compression measured.
a) Test equipment
Power meter ........................................................................................................................ ML2437A
Power probe ........................................................................................................................ MA2445D
Synthesized signal generator#1................................................................................................... 1464C
Synthesized signal generator#2...................................................................................................... 1461
Directional Coupler...................................................................................................................... 70603
RF Directional Coupler ................................................................................................................ 70607
1.0GHz low-pass filter: 2
6.8GHz low-pass filter: 2
b) Adapters
Two 2.4mm(f)-2.4mm(f) adapter
One 2.4mm(f)-3.5mm(m) adapter
One BNC(T) type(m)(f)(f)
c) Cables
Two BNC(m-m) cable
Two 2.4mm(m-m) cable
d) Test steps
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Fig. 12-12 1dB Gain Compression Test
1dB Gain Compression(50MHz~4GHz)
1) Connect ML2437A and MA2445D, and ZERO.
2) Connect the test instrument as shown in Fig. 12-12. Using RF Directional Coupler, the spectrum
analyzer will provide the frequency reference for the synthesized signal generator.
3) Set the frequency of 1461 instrument as 2GHz and amplitude as 0dBm. Enable the RF output.
4) Set the frequency of 1464C instrument as 2.01GHz and amplitude as -10dBm. Turn off the RF output.
5) Finish spectrum analyzer settings as follows:
Center frequency .......................................................................................................................... 2GHz
Span............................................................................................................................................... 1kHz
Reference level ....................................................................................................................... -10dBm
Scale/Div ................................................................................................................................ 1dB/Div
6) Adjust the power level of the 1461 to make the signal at 2dB to 3dB (2 to 3 grids) down from the
reference level of the spectrum analyzer.
7) Press 【Peak】【Marker】[Delta] on 4024.
8) Enable the RF output of 1464C, Adjust the output power level of 1464C to make the spectrum analyzer
display reading at -1dB, then turn off the RF output of 1461.
9) Remove the spectrum analyzer from the RF directional coupler. Use connectors but not cable to connect
the RF directional coupler to the power probe. Set frequency of the power meter as 2GHz, Read the power
meter dispaly, and record it as the 1dB Gain Compression within 50MHz-4GHz

under the

corresponding test item in the Schedule of Records of 4024 Series Spectrum Analyzer. Disable the noise
marker and averaging function.
1dB Gain Compression(4GHz~13GHz)
10) Connect the test instrument as shown in Fig. 12-12. Using Directional Coupler, the spectrum analyzer
will provide the frequency reference for the synthesized signal generator, Set the frequency of 4024
instrument as 9GHz.
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11) Set the frequency of 1461 instrument as 9GHz and amplitude as 0dBm. Enable the RF output.
12) Set the frequency of 1464C instrument as 9.01GHz and amplitude as -10dBm. Turn off the RF output.
13) Set the frequency of power meter as 9GHz.
14) Repeat steps 6~8.
15) Remove the spectrum analyzer from the RF directional coupler. Use connectors but not cable to
connect the RF directional coupler to the power probe. Read the power meter dispaly, and record it as the
1dB Gain Compression within 4GHz-13GHz

under the corresponding test item in the Schedule of

Records of 4024 Series Spectrum Analyzer. Disable the noise marker and averaging function.
1dB Gain Compression(13GHz~44GHz)
16) Connect the test instrument as shown in Fig. 12-12. Using Directional Coupler, the spectrum analyzer
will provide the frequency reference for the synthesized signal generator, Set the frequency of 4024
instrument as 9GHz.
17) Set the frequency of 1461 instrument as 18GHz and amplitude as 0dBm. Enable the RF output.
18) Set the frequency of 1464C instrument as 18.01GHz and amplitude as -10dBm. Turn off the RF output.
19) Set the frequency of power meter as 18GHz.
20) Repeat steps 6~8.
21) Remove the spectrum analyzer from the RF directional coupler. Use connectors but not cable to
connect the RF directional coupler to the power probe. Read the power meter dispaly, and record it as the
1dB Gain Compression within 13GHz-44GHz

under the corresponding test item in the Schedule of

Records of 4024 Series Spectrum Analyzer. Disable the noise marker and averaging function.

12. Image, multiple and out-of-band response
Description: During frequency mixing, if two signals can mix with the LO signal with the same one to
generate IF signals of the same frequency and if one original signal has a frequency one IF lower than the
LO signal and the other original signal has a frequency one IF higher than the LO signal, then such two
original signals can be referred to as the image of each other. The input signal of each frequency of the LO
signal has an image and the frequency of the original signal and the image differs by two times of IF.
The image, multiple and out-of-band response should be tested within all bands. Apply the signal on the
input port of the spectrum analyzer, and measure the reference amplitude. Adjust the frequency of the
synthesized signal generator until the image, multiple or out-of-band response occurs. Measure and record
the amplitude displayed on the spectrum analyzer.
a) Test equipment
Synthesized signal generator....................................................................................................... 1464C
b) Adapters
Two 2.4mm(f)-2.4mm(f) adapters
c) Cables
One BNC(m-m) cable
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One 2.4mm(m-m) cable
d) Test steps

BNC cable
10MHz input
Adapter

10MHz output

Synthesized signal generator
Adapter
2.4mm cable

Spectrum analyzer

Fig. 12-13 Setting for Image, Multiple and Out-of-band Response Test
1) Connect the test instruments as shown in Fig. 12-13. The spectrum analyzer will provide the frequency
reference for the synthesized signal source.
2) Set the frequency of 1464C instrument as 2GHz and power as -20dBm.
3) Finish spectrum analyzer settings as follows:
Center frequency .......................................................................................................................... 2GHz
Span............................................................................................................................................. 10kHz
Reference level ......................................................................................................................... -10dBm
Resolution bandwidth ................................................................................................................... 10Hz
Video bandwidth ........................................................................................................................... 10Hz
4) Adjust the output power level of the synthesized signal generator until the signal peak is close to the
reference level of the spectrum analyzer.
5) Press 【Peak】【Marker】 [Delta] on the spectrum analyzer.
6) Set 1464C instrument at each frequency point where the image, multiple and out-of-band response may
occur corresponding to 2GHz under the related test item in the Schedule of Records of 4024 Series
Spectrum Analyzer. Set the reference level of the spectrum analyzer as -40dBm and resolution bandwidth
as 10Hz. Press【Peak】and record the amplitude of the differential marker as the response amplitude under
the corresponding test item in the Schedule of Records of 4024 Series Spectrum Analyzer.
7) Test the image, multiple and out-of-band response at all the other frequency points listed in the Schedule
of Records of 4024 Series Spectrum Analyzer according to the steps 2-6.

13. Residual response
Description: The residual response refers to the discrete response observed on the display of the spectrum
analyzer with no input signal.
a) Test equipment…………………………………………………………………….50 matched loads
b) Test steps
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50Ω adapter

Spectrum analyzer

Fig. 12-14 Setting for Residual Response Test
Residual response, 10MHz~20GHz (with the pre-amplifier ON)
1) Connect the test instruments as shown in Fig. 12-14. Connect the 50Ω adapter top the signal input port
of the spectrum analyzer and set the spectrum analyzer as follows:
Center frequency .................................................................................................................65MHz
Frequency step ..................................................................................................................100MHz
Span ..................................................................................................................................110MHz
Reference level ................................................................................................................. -50dBm
Pre-amplifier ............................................................................................................................ On
Resolution bandwidth .......................................................................................................... 10kHz
Video bandwidth .................................................................................................................... 3kHz
2) Enable the limit function, set the limit as -100dBm. The noise level should be at least 5dB less than the
limit. Otherwise, the noise level should be reduced by decreasing the resolution bandwidth and video
bandwidth.
3) Observe whether the residual response signal exists on the noise baseline of the spectrum analyzer. If
any, read the amplitude of residual response with the marker, and record the measurement result. The
amplitude of the residual response signal should be at least 10dB more than the display average noise level
in the test; otherwise, the display average noise level should be reduced by further decreasing the resolution
bandwidth.
4) Press 【Freq】 [Center Freq] 【↑】 to change the center frequency. Repeat Step 3 to check the residual
response under the frequency 20GHz. Record the measured maximum response into the measurement
result column of the corresponding test item in the Schedule of Records of 4024 Series Spectrum Analyzer.
Residual response, 20GHz-44GHz (with the pre-amplifier ON)
5) Finish spectrum analyzer settings as follows:
Center frequency ................................................................................................................. 20.055GHz
Frequency step .........................................................................................................................100MHz
Span .........................................................................................................................................110MHz
Reference level ....................................................................................................................... -50dBm
Pre-amplifier ................................................................................................................................... On
Resolution bandwidth ................................................................................................................. 10kHz
Video bandwidth ........................................................................................................................... 3kHz
6) Enable the limit function, set the limit as -95dBm. The noise level should be at least 5dB less than the
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limit. Otherwise, the noise level should be reduced by decreasing the resolution bandwidth and video
bandwidth.
7) Observe whether the residual response signal exists on the noise baseline of the spectrum analyzer. If
any, read the amplitude of residual response with the marker, and record the measurement result. The
amplitude of the residual response signal should be at least 10dB more than the display average noise level
in the test; otherwise, the display average noise level should be reduced by further decreasing the
resolution bandwidth.
8) Press 【Freq】 [Center Freq] 【↑】 to change the center frequency. Repeat Step 7 to check the residual
response under the frequency 44GHz. Record the measured maximum response into the measurement
result column of the corresponding test item in the Schedule of Records of 4024 Series Spectrum
Analyzer.
Residual response, 10MHz-13GHz (with the pre-amplifier OFF)
9) Finish spectrum analyzer settings as follows:
Center frequency ....................................................................................................................... 65MHz
Frequency step ........................................................................................................................ 100MHz
Span......................................................................................................................................... 110MHz
Reference level ....................................................................................................................... -20dBm
Pre-amplifier .................................................................................................................................. Off
Resolution bandwidth ............................................................................................................... 10kHz
Video bandwidth ........................................................................................................................... 3kHz
10) Enable the limit function, set the limit as -90dBm. The noise level should be at least 5dB less than the
limit. Otherwise, the noise level should be reduced by decreasing the resolution bandwidth and video
bandwidth.
11) Observe whether the residual response signal exists on the noise baseline of the spectrum analyzer. If
any, read the amplitude of residual response with the marker, and record the measurement result. The
amplitude of the residual response signal should be at least 10dB more than the display average noise level
in the test; otherwise, the display average noise level should be reduced by further decreasing the resolution
bandwidth.
12) Press 【Freq】 [Center Freq] 【↑】 to change the center frequency. Repeat Step 11 to check the residual
response under the frequency 13GHz (with the pre-amplifier OFF). Record the measured maximum
response into the measurement result column of the corresponding test item in the Schedule of Records of
4024 Series Spectrum Analyzer.
Residual response, 13GHz-20GHz (with the pre-amplifier OFF)
13) Finish spectrum analyzer settings as follows:
Center frequency ................................................................................................................. 13.055GHz
Frequency step ........................................................................................................................ 100MHz
Span......................................................................................................................................... 110MHz
Reference level ....................................................................................................................... -20dBm
Pre-amplifier .................................................................................................................................. Off
Resolution bandwidth ................................................................................................................. 10kHz
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Video bandwidth ........................................................................................................................... 3kHz
14) Enable the limit function, set the limit as -85dBm. The noise level should be at least 5dB less than the
limit. Otherwise, the noise level should be reduced by decreasing the resolution bandwidth and video
bandwidth.
15) Observe whether the residual response signal exists on the noise baseline of the spectrum analyzer. If
any, read the amplitude of residual response with the marker, and record the measurement result. The
amplitude of the residual response signal should be at least 10dB more than the display average noise level
in the test; otherwise, the display average noise level should be reduced by further decreasing the resolution
bandwidth.
16) Press 【Freq】 [Center Freq] 【↑】 to change the center frequency. Repeat Step 15 to check the residual
response under the frequency 20GHz (with the pre-amplifier OFF). Record the measured maximum
response into the measurement result column of the corresponding test item in the Schedule of Records of
4024 Series Spectrum Analyzer.
Residual response, 20GHz-44GHz (with the pre-amplifier OFF)
17) Finish spectrum analyzer settings as follows:
Center frequency ............................................................................................................... 20.055GHz
Frequency step........................................................................................................................100MHz
Span ........................................................................................................................................110MHz
Reference level ...................................................................................................................... -20dBm
Pre-amplifier ................................................................................................................................. Off
Resolution bandwidth .............................................................................................................. 10kHz
Video bandwidth ......................................................................................................................... 3kHz
18) Enable the limit function, set the limit as -80dBm. The noise level should be at least 5dB less than the
limit. Otherwise, the noise level should be reduced by decreasing the resolution bandwidth and video
bandwidth.
19) Observe whether the residual response signal exists on the noise baseline of the spectrum analyzer. If
any, read the amplitude of residual response with the marker, and record the measurement result The
amplitude of the residual response signal should be at least 10dB more than the display average noise level
in the test; otherwise, the display average noise level should be reduced by further decreasing the resolution
bandwidth.
20) Press 【Freq】 [Center Freq] 【↑】 to change the center frequency. Repeat Step 19 to check the residual
response under the frequency 44GHz (with the pre-amplifier OFF). Record the measured maximum
response into the measurement result column of the corresponding test item in the Schedule of Records of
4024 Series Spectrum Analyzer.

14. Reference level
Description: The location of the vertical scale calibrated on the screen of the spectrum analyzer is used for
reference in amplitude measurement. The reference level generally refers to the top division of the scale.
Switching of the reference level will cause the linkage of gain/attenuation. The reference level conversion
error is applied to examine the error of the ON/OFF gain of the spectrum analyzer.
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a) Test equipment
Signal generator ........................................................................................................................ 1464C
Power meter .......................................................................................................................... ML2437A
Power probe ......................................................................................................................... MA2445D
Power divider ...............................................................................................................................81313
b) Adapters
One 2.4mm(f)-2.4mm(f) adapter
c) Cables
One BNC(m-m) cable
One 2.4mm(m-m) cable
d) Test steps

BNC cable
10MHz IN

Power diveder
2.4mm cable

probe

10MHz OUT

Adapter

synthesized signal generator

spectrum analyzer

power meter

Fig. 12-15 Setting for Reference Level Uncertainty and Scale Fidelity Test
1) Connect ML2437A with MA2445D and ZERO, set calfactor frequency 50MHz.
2) Connect the test equipment as shown in Fig. 12-15. The spectrum analyzer will provide the frequency
reference for 1464C synthesized signal generator, connect the spectrum analyzer and power meter with
signal generator by power divider.
3) Set 【Ampt】 [Ref Level] with the knob or step keys 【↑】 and 【↓】 on 4024 series. The reference
level can be set as max. +30dBm and min. -120dBm according to the requirements. Mark “√” in the
corresponding result column in the Schedule of Records of 4024 Series Handheld Spectrum Analyzer if the
reference level complies with the requirements; otherwise, mark “×”.
4) Set the output frequency of 1464C instrument as 50MHz and amplitude as -3dBm0.05dB.
5) Set the spectrum analyzer as follows:
Center frequency ....................................................................................................................... 50MHz
Reference level ........................................................................................................................... 0dBm
Span............................................................................................................................................... 1kHz
Logarithmic scale dB/division ....................................................................................................... 1 dB
Resolution bandwidth ................................................................................................................... 10Hz
6) Adjust the output amplitude of 1464C instrument, until the signal level is 2-3 divisions below the
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reference level of the spectrum analyzer.
7) Press 【Peak】
【Marker】 [Delta] on the spectrum analyzer.
8) Press 【↓】 once on 1464C instrument.
9) Set the reference level of the spectrum analyzer as the value listed in the Schedule of Records of 4024
Series Spectrum Analyzer. Press 【Peak】 after sweeping is finished.
10) Record the amplitude reading of the differential marker of the spectrum analyzer, and perform the
following calculation: (amplitude reading of the differential marker of the spectrum analyzer - set reference
level). Record the calculated value as the uncertainty of the current reference level under the corresponding
test item in the Schedule of Records of 4024 Series Spectrum Analyzer.
11) Repeat the steps 7-9 to the other reference levels of the spectrum analyzer in the Schedule of Records of
4024 Series Spectrum Analyzer.

15. Scale fidelity
Description: The scale fidelity refers to the error between the vertical scale on the screen of the spectrum
analyzer and the theoretical value, and is applied to examine the linearity of the A/D converter of the
spectrum analyzer.
Test the fidelity under 10dB/division. Set the resolution bandwidth as 10Hz and the starting amplitude of
the input signal above the 0dBm reference level. When the signal amplitude is reduced, the displayed signal
amplitude is compared with the reference level. The spectrum analyzer will provide the 10MHz reference
for the signal generator.
a) Test equipment
Signal generator ........................................................................................................................ 1464C
Power meter .......................................................................................................................... ML2437A
Power probe ..........................................................................................................................MA2445D
Power divider ............................................................................................................................... 81313
b) Adapters
One 2.4mm(f)-2.4mm(f) adapter
c) Cables
One BNC(m-m) cable
One 2.4mm(m-m) cable
d) Test steps
1) Connect ML2437A with MA2445D and ZERO, set calfactor frequency 50MHz.
2) Connect the test equipment as shown in Fig. 12-15. The spectrum analyzer will provide the frequency
reference for 1464C synthesized signal generator; connect the spectrum analyzer and power meter with
signal generator by power divider.
3) Finish spectrum analyzer settings as follows:
Center frequency ........................................................................................................................50MHz
Reference level .......................................................................................................................... 0dBm
Marker............................................................................................................................................ Off
Span .............................................................................................................................................. 1kHz
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Resolution bandwidth ................................................................................................................. 10Hz
4) Set the frequency of 1464C instrument as 50MHz, amplitude as 6dBm and amplitude step as 0.05dB.
5) Press 【Peak】 on the spectrum analyzer.
6) Press 【Ampt】 on 1464C instrument and adjust the amplitude with the 【↑】 and 【↓】 key until the
accurate readout of the marker of the spectrum analyzer is 0dBm±0.05dB. Set the amplitude set as 10dB.
7) Press 【Peak】【Marker】 [Delta] on the spectrum analyzer.
8) Adjust the output level of the 1464C, until the signal level reading from power meter decrease
10dB0.05dB.
Press 【↓】 on 1464C instrument and wait for new sweeping of the spectrum analyzer. Press 【Peak】 and
read the amplitude of the differential marker.
9) Perform the following calculation: (amplitude of the differential marker of the spectrum analyzer power change of the signal source), and record the calculated value under the corresponding test item in the
Schedule of Records of 4024 Series Spectrum Analyzer. Repeat Step 8 and 9.

16. Total level uncertainty
Description: The total level uncertainty refers to the difference between the output power reading of the
synthesized signal generator (tested with the power meter) and the output reading of the signal generator
(tested with the spectrum analyzer).
a) Test equipment
Synthesized signal generator ....................................................................................................... 1464C
Power meter ........................................................................................................................ ML2437A
Power probe ....................................................................................................................... MA2445D
Power divider ...............................................................................................................................81313
b) Adapters
Two 2.4mm(f)-2.4mm(f) adapters
c) Cables
One BNC(m-m) cable
One 2.4mm(m-m) cable
d) Test steps
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BNC cable
10MHz IN

Power diveder
2.4mm cable

probe

10MHz OUT

Adapter

synthesized signal generator

spectrum analyzer

power meter

Fig. 12-16 Setting for Total Level Uncertainty Test
1) Connect the power meter and power probe and perform zero calibration.
2) Connect the test equipment a shown by the dotted line in Fig. 12-16. Connect the output of the signal
generator to the SUM port of the power divider, and PORT1 and PORT2 connect to the power meter and
spectrum analyzer.
Total level uncertainty（change attenuator）
3) Reset 1464C instrument and set the frequency as 50MHz and amplitude as -15dBm.
4) Finish spectrum analyzer settings as follows:
Center frequency ........................................................................................................................50MHz
Span .......................................................................................................................................... 100kHz
Reference level ....................................................................................................................... -10dBm
Resolution bandwidth ................................................................................................................. 1kHz
Video bandwidth ......................................................................................................................... 100Hz
5) Adjust output level of the signal generator, until the level reading from power meter is -25dBm.
6) Press 【Peak】, record the maker level L and the display level Lpower meter of the power meter, Calculate
the total level uncertainty △ L as follows:
(7)
Record the calculated △L as the test result of the total level uncertainty in the Schedule of Records of
4024 Series Spectrum Analyzer.
7) Repeat the steps 6, change the attenuator value of the spectrum analyzer to 10dB, 20dB, and Record the
calculated △L.
8) Set the Ref Level of the spectrum analyzer to 20dBm, change the output level of the signal generator
until the reading from the power meter is -5dBm.
9) Repeat the steps 6, change the attentor value of the spectrum analyzer to 30dB, 40dB, 50dB, and Record
the calculated △L.
10) Set frequency in the Schedule of Records of 4024 Series Spectrum Analyzer, and repeat step 5~9.
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Total level uncertainty（Frequency Respond）
11) Reset 1464C instrument and set the frequency as 500MHz and amplitude as -15dBm.
12) Set factor frequency of the power meter 500MHz, adjust the output level of the signal generator until
the level reading from the power meter is -25dBm.
13) Set the frequency of the spectrum analyzer as 500MHz, the ref level as -10dBm, attentor as 0dB, repeat
stet 6.
14) Set frequency in the Schedule of Records of 4024 Series Spectrum Analyzer, and repeat step 5~9.

17. Input attenuator
Description: The attenuation switching uncertainty is measured within the range (50dB) of the input
attenuator under the whole band in the test. The reference input of the synthesized signal generator is the
10MHz reference of the spectrum analyzer. Set the 0dB attenuator for switching uncertainty reference. The
attenuator in the signal generator is used as the measurement standard.
a) Test equipment
Synthesized signal generator ....................................................................................................... 1464C
b) Adapters
Two 2.4mm(f)-2.4mm(f) adapters
c) Cables
One BNC(m-m) cable (120cm)
One 2.4mm(m-m) cable (100cm)
d) Test steps

10MHz IN

BNC cable
10MHz output

Synthesized signal generator

Adapter
2.4mm
Spectrum analyzer

Fig. 12-17 Setting for Input Attenuator Switching Uncertainty Test
1) Connect the test equipment as shown in Fig. 12-17. The spectrum analyzer will provide the frequency
reference for the synthesized signal generator 1464C.
2) Set the output power level of the signal generator as -13dBm, output power as 100MHz.
3) Press 【Preset】 on the spectrum analyzer and finish the following settings:
Center frequency ..................................................................................................................... 100MHz
Span............................................................................................................................................. 100Hz
Reference level ....................................................................................................................... -10dBm
Attenuation .................................................................................................................................... 0dB
Resolution bandwidth ................................................................................................................. 10Hz
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4) After sweeping is finished, press 【Peak】, 【Marker】, [Delta]. Use the 0dB attenuation of the attenuator
as the reference.
5) Set the spectrum analyzer by pressing 【Ampt】 [Atten Auto Man]. Set the attenuation value of the
attenuator.
6) After sweeping is finished, press 【Peak】. Perform the following calculation: current input attenuator
error = amplitude difference of the differential marker - attenuation value.
7) Repeat the steps 5-6 until all attenuation values of the attenuator in the table are tested. Record test
results in the Schedule of Records of 4024 Series Spectrum Analyzer.

18. Input voltage standing wave ratio (VSWR) test
a) Test equipment
Network analyzer ................................................................................................................... N5245A
One 2.4mm calibration kit (including the open circuit, short circuit and load)
One 2.4mm(m-m) calibrating cable
b) Test procedure
Network analyzer

Spectrum analyzer

2.4mm Calibrating

Fig. 12-18 Voltage Standing Wave Ratio Test of Input Port
1) Set the appropriate frequency range and source output power of the vector network analyzer, and enable
the VSWR display mode.
2) Measure and calibrate the single port (including open circuit, short circuit and load calibration) of the
vector network analyzer at the end of the calibration cable.
3) After calibration, remove the calibration kit from the end of the calibration cable and connect it to the RF
input port of the spectrum analyzer, as shown in Fig. 12-18.
4) Press [Rest] on the spectrum analyzer. Wait for restart to enter the spectrum analyzer interface.
5) Read the maximum VSWR by the marker function of the vector network analyzer.
6) Record test results under the corresponding test item in the Schedule of Records of 4024 Series
Spectrum Analyzer.

19. Maximum safety input level
Connect 4024 series spectrum analyzer with the power supply. After normal start-up, set [Ref Level]
+30dBm. If the displayed reference level is +30dBm, no error prompt appear and the reference level
displayed on the left side of the spectrum analyzer is +30dBm, it indicates that the maximum safety input
level of the spectrum analyzer is normal.
182

Chapter XIII Performance Characteristic Test

The performance test item is guaranteed by the MMW DC block and program-controlled step attenuator in
the spectrum analyzer.

20. Display scale
Connect 4024 series spectrum analyzer with the power supply. After normal start-up, manually set the scale
as 0.1-10dB per divisions, with the step of 0.1dB (10-division). The display range of [Scale Type Log Lin]
is 10 divisions. [Units] provides five options: dBm, dBW, dBV, dBmV, dBμV, dBA, dBmA, dBμA, Volts,
Watts. This indicates that the display scale of the spectrum analyzer is normal.

21. Video bandwidth
Connect 4024 series spectrum analyzer with the power supply. After normal start-up, set the resolution
bandwidth as 10MHz. In this case, the video bandwidth is 10MHz. Press 【↓】. Once the resolution
bandwidth is changed, the corresponding video bandwidth will change and be automatically coupled with
the resolution bandwidth, with the minimum value of 1Hz and step of 1-3.
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Chapter XIII Troubleshooting and Repair
This chapter will introduce how to find out problems and receive the after-sales service. Interpretation of
internal errors of the spectrum analyzer is also included.
If you have any problem in operation of 4024 series spectrum analyzer or want to purchase related
components, options or accessories, we will provide complete after-sales services.
In general, the trouble is caused by failure of hardware/software or users' misuse. Please contact us
immediately in case of any trouble. If the warranty is valid, we will provide maintenance services free of
charge according to the commitment in the warranty; otherwise, we will charge costs.

Section 1 Fault Information Description
This section will help you to simply judge and deal with faults of 4024
series spectrum analyzer. If necessary, report the problems to us as
Description

accurately as possible so that we can solve the problems as soon as
possible.

You can check 4024 series instrument according to the following prompts in the case of any fault: Please
contact us if the failure cannot be removed.


If 4024 series cannot be started when the Power key is pressed, check whether the power supply is

normal, whether the adapter indicator is ON and whether the power supply battery is normal. If the above
items are normal, the instrument failure may occur. In this case, contact us for repair.


If the system or applicable program fails after start-up of 4024 series instrument, press 【Preset】 to

recover the known state. If 4024 still cannot work properly, an instrument failure may occur. In this case,
contact us for repair.


If the performance specifications of 4024 series are abnormal, check whether the test tools and test

environment conform to the requirements, whether the connector of the test port is damaged and whether
the performance specifications of the calibration kit are normal. If the above items are normal, instrument
failure may occur. In this case, contact us for repair.


If LAN communication of 4024 series fails. First check the IP address and the yellow indicator beside

the LAN interface on the top panel. If the indicator does not flicker, check the LAN cable and connections.
If all the above items are in good conditions, it indicates that the instrument may be faulty. Contact us for
repair.
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Section 2 Repair Method
If you cannot solve the problem of 4024 series, contact us by telephone or fax. If it is confirmed that repair
is required, please pack the instrument by the following steps:
1) Prepare one copy of paper file describing the instrument failure, and place it into the packing box
together with the tester.
2) Use the original packaging materials to pack the instrument properly to minimize damage.
3) Set pads in the four corners of the outer packing box, and place the instrument into the outer packing
box.
4) Seal the opening of the packing box with sticky tape and strengthen the packing box with nylon straps.
5) Mark “Fragile! No touch! Handle with care” on the packing case.
6) Ship this instrument as a precision instrument, and keep a copy of all the shipping documents.
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Appendix A Performance Characteristic Test Results
Schedule Performance Characteristic Test Results of 4024 Series Spectrum Analyzer
Instrument No.:
Test conditions:

Tester:
Testing date:

MM/DD/YY

Table A.1 Schedule of Records of 4024 D/E/F/G Spectrum Analyzer
S/N

1

2

3

4

5

Inspection item

Design and
structure

Function

Options

Frequency range

Frequency reading
accuracy

Unit

Standards

Test result

/

Structure type: Handheld

/

Appearance color: black

/

The instrument surface should be smooth with no burr, obvious
mechanical damage or coating damage. The structure should be
compete, with the controls installed properly and reliably and keys
flexible to operate and connectors easy to plug in place.

/

Spectrum measurement

/

Power kit measurement

/

Audio demodulation

/

IQ capture

/

Interference Analyzer

/

Analog demodulation analysis

/

USB power measurement

/

Channel Scanner

/

Field strength measurement

/

GPS function

/

secure option

/

signal analysis

/

Lower limit

/

Upper limit

9kHz±21Hz
Upper limit of
frequency±21Hz

kHz

3.0GHz(frequency span 500kHz):

±12.70

MHz

3.0GHz(frequency span 50MHz):

±1.03

MHz

3.0GHz(frequency span 500MHz):

±10.30

kHz

5.5GHz(frequency span 500kHz):

±14.70

MHz

5.5GHz(frequency span 50MHz):

±1.03

MHz

5.5GHz(frequency span 500MHz):

±10.30

kHz

7.0GHz(frequency span 500kHz):

±15.90

MHz

7.0GHz(frequency span 50MHz):

±1.03

MHz

7.0GHz(frequency span 500MHz):

±10.30

kHz

8.5GHz (frequency span 500kHz):

±17.10

MHz

8.5GHz (frequency span 50MHz):

±1.03

MHz

8.5GHz (frequency span 500MHz):

±10.30

kHz

10.0GHz (frequency span 500kHz):

±18.30

Note: This table applies to the normal temperature test of 4024D/E/F/G spectrum analyzer, and the contents may be modified
depending on the specific model and option configuration, so as to adapt to actual test and inspection needs.
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Table A.1 (continued 1) Schedule of Records of 4024D/E/F/G Spectrum Analyzer
S/N

5

6

Inspection item

8

Standards

Inspection result

MHz

10.0GHz (frequency span 50MHz):

±1.03

MHz

10.0GHz (frequency span 500MHz):

±10.30

kHz

12.0GHz (frequency span 500kHz):

±19.90

MHz

12.0GHz (frequency span 50MHz):

±1.03

MHz

12.0GHz(frequency span 500MHz) :

±10.30

kHz

15.0GHz(frequency span 500kHz) :

±22.30

MHz

15.0GHz(frequency span 50MHz) :

±1.04

MHz

15.0GHz(frequency span 500MHz) :

±10.31

kHz

19.0GHz(frequency span 500kHz) :

±25.50

MHz

19.0GHz(frequency span 50MHz) :

±1.04

MHz

19.0GHz(frequency span 500MHz) :

±10.31

kHz

24.0GHz(frequency span 500kHz) :

±29.50

MHz

24.0GHz(frequency span 50MHz) :

±1.04

MHz

24.0GHz(frequency span 500MHz) :

±10.31

kHz

29.0GHz(frequency span 500kHz) :

±33.50

MHz

29.0GHz(frequency span 50MHz) :

±1.05

MHz

29.0GHz(frequency span 500MHz) :

±10.32

kHz

34.0GHz(frequency span 500kHz) :

±37.50

MHz

34.0GHz(frequency span 50MHz) :

±1.05

MHz

34.0GHz(frequency span 500MHz) :

±10.32

kHz

43.0GHz(frequency span 500kHz) :

±44.70

MHz

43.0GHz(frequency span 50MHz) :

±1.06

MHz

43.0GHz(frequency span 500MHz) :

±10.33

/

1kHz

±2.0%

/

10kHz

±2.0%

/

100kHz

±2.0%

/

1MHz

±2.0%

/

10MHz

±2.0%

/

100MHz

±2.0%

/

1GHz

±2.0%

/

10GHz

±2.0%

/

10μs~600s（zero span）

/

1ms

±2.0%

/

10ms

±2.0%

/

100ms

±2.0%

/

1s

±2.0%

/

10s

±2.0%

/

10MHz

±20.0%

Resolution

/

3MHz

±10.0%

bandwidth accuracy

/

1MHz

±10.0%

/

300kHz

±10.0%

Frequency reading
accuracy

Span accuracy

Range

7

Unit

Sweep
time

Accuracy
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Table A.1 (continued 2) Schedule of Records of 4024D/E/F/G Spectrum Analyzer
S/N

8

9

10

11

12

190

Inspection item

Resolution bandwidth
accuracy

Unit

Standards

Inspection result

/

100kHz

±10.0%

/

30kHz

±10.0%

/

10kHz

±10.0%

/

3kHz

±10.0%

/

1kHz

±10.0%

dB

10MHz

±1.20

dB

3MHz

±1.20

dB

1MHz

±1.20

dB

300kHz

±1.20

/

100kHz

Reference

dB

30kHz

±1.20

Resolution

dB

10kHz

±1.20

BandwidthConversion

dB

3kHz

±1.20

uncertainty

dB

1kHz

±1.20

dB

300Hz

±1.20

dB

100Hz

±1.20

dB

30Hz

±1.20

dB

10Hz

±1.20

dB

3Hz

±1.20

dB

1Hz

±1.20

dBc/Hz

+10kHz

≤-102

dBc/Hz

-10kHz

≤-102

dBc/Hz

+100kHz

≤-106

Sideband noise

dBc/Hz

-100kHz

≤-106

(carrier 1GHz)

dBc/Hz

+1MHz

≤-111

dBc/Hz

-1MHz

≤-111

dBc/Hz

+10MHz

≤-123

dBc/Hz

-10MHz

≤-123

dBm

2MHz~10MHz（Pre-amplifier On）

≤-150

dBm

10MHz~20GHz（Pre-amplifier On）

≤-157

dBm

20GHz~32GHz（Pre-amplifier On）

≤-154

dBm

32GHz~40GHz（Pre-amplifier On）

≤-148

Display average noise

dBm

40GHz~44GHz（Pre-amplifier On）

≤-140

level

dBm

2MHz~10MHz（Pre-amplifier Off）

≤-135

dBm

10MHz~20GHz（Pre-amplifier Off）

≤-138

dBm

20GHz~32GHz（Pre-amplifier Off）

≤-135

dBm

32GHz~40GHz（Pre-amplifier Off）

≤-127

dBm

40GHz~44GHz（Pre-amplifier Off）

≤-120

dBc

<4GHz

<-60

dBc

4GHz~10GHz

<-60

dBc

10GHz~22GHz

<-60

Second harmonic
distortion
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Table A.1 (continued 3) Schedule of Records of 4024D/E/F/G Spectrum Analyzer
S/N

13

14

Inspection item
3-order
intermodulation

1dB gain

8GHz
Image,
multiple

15GHz

and
out-of-b
and
response

Standards

Inspection

dBm

50MHz~4GHz

≥+7

dBm

4GHz~13GHz

≥+6

dBm

13GHz~44GHz

≥+6

dBm

50MHz~4GHz

≥-2

dBm

4GHz~13GHz

≥-3

dBm

13GHz~44GHz

≥-3

dBc

Image frequency 15080.5MHz

<-65

dBc

Image frequency 2280.5MHz

<-65

dBc

Image frequency 2062.5MHz

<-65

dBc

Image frequency 11480.5MHz

<-65

dBc

Image frequency 8280.5MHz

<-65

dBc

Image frequency 8062.5MHz

<-65

dBc

Image frequency 21680.5MHz

<-65

dBc

Image frequency 15280.5MHz

<-65

dBc

Image frequency 15062.5MHz

<-65

dBc

Image frequency 40800MHz

<-60

dBc

Image frequency 20519.5MHz

<-60

dBc

Image frequency 24280.5MHz

<-60

dBc

Image frequency 24062.5MHz

<-60

dBc

Image frequency 21600MHz

<-60

dBc

Image frequency 38519.5MHz

<-60

dBc

Image frequency 42280.5MHz

<-60

dBc

Image frequency 42062.5MHz

<-60

dBm

10MHz~20GHz（Pre-amplifier On）

dBm

20GHz~ upper limit（Pre-amplifier On）

≤-95

dBm

10MHz~13GHz（Pre-amplifier Off）

≤-90

dBm

13GHz~20GHz（Pre-amplifier Off）

≤-85

dBm

20GHz~ upper limit（Pre-amplifier Off）

≤-80

compression

2GHz

15

Unit

24GHz

42GHz

16

Residual response

Log
Range

/
/

17

≤-100

type：-120dBm~+30dBm，1dB step

Linear scale: 22.36uV~7.07V，0.1%
0dBm

step
Reference

dB

-10dBm

±1.20

dB

-20dBm

±1.20

dB

-30dBm

±1.20

dB

-40dBm

±1.20

dB

-50dBm

±1.20

dB

-60dBm

±1.20

dB

-10dBm

±1.00

dB

-20dBm

±1.00

Referen
ce level

Convers
ion error

18

Scale fidelity
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Table A.1 (continued 4) Schedule of Records of 4024D/E/F/G Spectrum Analyzer
S/N

18

19

192

Inspection item

Unit

Standards

Inspection result

dB

-30dBm

±1.00

dB

-40dBm

±1.00

dB

-50dBm

±1.00

dB

-60dBm

±1.00

dB

50MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

50MHz（Atten 10dB，Input power -25dBm）:

±1.80

dB

50MHz（Atten 20dB，Input power -25dBm）:

±1.80

dB

50MHz（Atten 30dB，Input power -5dBm）:

±1.80

dB

50MHz（Atten 40dB，Input power -5dBm）:

±1.80

dB

50MHz（Atten 50dB，Input power -5dBm）:

±1.80

dB

6GHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

6GHz（Atten 10dB，Input power -25dBm）:

±1.80

dB

6GHz（Atten 20dB，Input power -25dBm）:

±1.80

dB

6GHz（Atten 30dB，Input power -5dBm）:

±1.80

dB

6GHz（Atten 40dB，Input power -5dBm）:

±1.80

dB

6GHz（Atten 50dB，Input power -5dBm）:

±1.80

dB

10GHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

10GHz（Atten 10dB，Input power -25dBm）:

±1.80

dB

10GHz（Atten 20dB，Input power -25dBm）:

±1.80

dB

10GHz（Atten 30dB，Input power -5dBm）:

±1.80

dB

10GHz（Atten 40dB，Input power -5dBm）:

±1.80

Total level

dB

10GHz（Atten 50dB，Input power -5dBm）:

±1.80

uncertainty

dB

15GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

15GHz（Atten 10dB，Input power -25dBm）:

±2.30

dB

15GHz（Atten 20dB，Input power -25dBm）:

±2.30

dB

15GHz（Atten 30dB，Input power -5dBm）:

±2.30

dB

15GHz（Atten 40dB，Input power -5dBm）:

±2.30

dB

15GHz（Atten 50dB，Input power -5dBm）:

±2.30

dB

20GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

20GHz（Atten 10dB，Input power -25dBm）:

±2.30

dB

20GHz（Atten 20dB，Input power -25dBm）:

±2.30

dB

20GHz（Atten 30dB，Input power -5dBm）:

±2.30

dB

20GHz（Atten 40dB，Input power -5dBm）:

±2.30

dB

20GHz（Atten 50dB，Input power -5dBm）:

±2.30

dB

25GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

25GHz（Atten 10dB，Input power -25dBm）:

±2.30

dB

25GHz（Atten 20dB，Input power -25dBm）:

±2.30

dB

25GHz（Atten 30dB，Input power -5dBm）:

±2.30

dB

25GHz（Atten 40dB，Input power -5dBm）:

±2.30

dB

25GHz（Atten 50dB，Input power -5dBm）:

±2.30

Scale fidelity
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Table A.1 (continued 5) Schedule of Records of 4024D/E/F/G Spectrum Analyzer
S/N

19

Inspection item

Total level
uncertainty

Unit

Standards

Inspection result

dB

32GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

32GHz（Atten 10dB，Input power -25dBm）:

±2.30

dB

32GHz（Atten 20dB，Input power -25dBm）:

±2.30

dB

32GHz（Atten 30dB，Input power -5dBm）:

±2.30

dB

32GHz（Atten 40dB，Input power -5dBm）:

±2.30

dB

32GHz（Atten 50dB，Input power -5dBm）:

±2.30

dB

40GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

40GHz（Atten 10dB，Input power -25dBm）:

±2.30

dB

40GHz（Atten 20dB，Input power -25dBm）:

±2.30

dB

40GHz（Atten 30dB，Input power -5dBm）:

±2.30

dB

40GHz（Atten 40dB，Input power -5dBm）:

±2.30

dB

40GHz（Atten 50dB，Input power -5dBm）:

±2.30

dB

500MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

1.5GHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

2.5GHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

3.5GHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

4.5GHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

5.5GHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

6.5GHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

7.5GHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

8.5GHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

9.5GHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

10.5GHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

11.5GHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

12.5GHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

13.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

14.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

15.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

16.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

17.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

18.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

19.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

20.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

21.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

22.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

23.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

24.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

25.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

26.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

27.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

28.5GHz（Atten 0dB，Input power -25dBm）:

±2.30
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Table A.1 (continued 6) Schedule of Records of 4024D/E/F/G Spectrum Analyzer
S/N

Inspection item

Total level
uncertainty

19

Range

Attenuat
or

20

Switchi
ng
uncertai
nty

21

Input voltage
Standing wave ratio

22

Maximum safety
input level

23

Display scale

24

Video Bandwidth

Unit

Inte
rfac
e

25

Freq. Ref.

others

26

29.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

30.5GHz）（Atten 0dB，Input power -25dBm）:

±2.30

dB

31.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

32.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

33.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

34.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

35.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

36.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

37.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

38.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

dB

39.5GHz（Atten 0dB，Input power -25dBm）:

±2.30

/

0~50dB，10dB Step

/

0dB Attenuation

dB

10dB Attenuation

dB

20dB Attenuation 0dB

±1.20

dB

30dB Attenuation

±1.20

dB

40dB Attenuation

±1.20

dB
/

50dB Attenuation

±1.20

/
/
/
/

Reference
±1.20

10MHz~20GHz

≤1.80：1

20GHz~ upper limit

≤2.20：1

+30dBm (automatic coupling of CW and input attenuator)
0.1-10dB per division, with the minimum step of 0.1dB(10 division
display)
Bandwidth range: 1Hz~ 10MHz (step: 1-3-10)

/

RF input port（depending on the interface type of the specific
model ）

/

USB interface：A type，two

/

USB interface：mini type，one

/

LAN interfce：RJ45 type

/

10MHz Input/Output port，BNC(f) type

/

GPS interface：BNC(f) type

/

Trig IN interface：BNC(f) type

/

IF Output interface：BNC(f) type

/

Anti-eletric strength AC 1500V，10mA/min；no breakdown、no
flashover。

/

242V，leakage Current：≤3.5mA，1min。
Insulation resistance between power in port and case must not
/
below100MΩ in standard atmospheric pressure and below 2MΩ in
wet environment.
1. “√” indicates that the function is normal or complies with the requirements, while “X” indicates that the function is
abnormal or does not comply with the requirements
2. “/” indicates that the item is not tested.
Safety

Descript
ion

Inspection result

dB

Test interface

Communicati
on Interface

Standards

Comprehensive judgment: Qualified □ Disqualified□
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Table A.2 Schedule of Records of 4024A/B/C Spectrum Analyzer
S/N

1

Inspection item

Unit
Structure type: Handheld

/

Appearance color: black
The instrument surface should be smooth with no burr, obvious
mechanical damage or coating damage. The structure should
be compete, with the controls installed properly and reliably
and keys flexible to operate and connectors easy to plug in
place.

Design and
structure

3

4

Function

Options

/

Spectrum measurement

/

Power kit measurement

/

Audio demodulation

/

IQ capture

/

Interference Analyzer

/

Analog demodulation analysis

/

USB power measurement

/

Channel Scanner

/

Field strength measurement

/

GPS function

/

secure option

/

tracking Generator

/

signal analysis

/

Lower limit

Frequency range

5

9kHz±21Hz

kHz

1.0GHz (frequency span 500kHz):

Upper limit of
frequency±21Hz
±11.10

MHz

1.0GHz (frequency span 50MHz):

±1.03

MHz

1.0GHz (frequency span 500MHz):

±10.30

kHz

3.0GHz (frequency span 500kHz):

±12.70

MHz

3.0GHz (frequency span 50MHz):

±1.03

MHz

3.0GHz (frequency span 500MHz):

±10.30

kHz

3.5GHz (frequency span 500kHz):

±13.10

MHz

3.5GHz (frequency span 50MHz):

±1.03

MHz

3.5GHz (frequency span 500MHz):

±10.30

kHz

4.5GHz (frequency span 500kHz):

±13.90

MHz

4.5GHz( (frequency span 50MHz):

±1.03

MHz

4.5GHz (frequency span 500MHz):

±10.30

kHz

6.0GHz (frequency span 500kHz):

±15.10

MHz

6.0GHz (frequency span 50MHz):

±1.03

MHz

6.0GHz (frequency span 500MHz):

±10.30

/

Frequency reading
accuracy

Test result

/

/

2

Standards

Upper limit

Note: This table applies to the normal temperature test of 4024A/B/C spectrum analyzer, and the contents
may be modified depending on the specific model and option configuration, so as to adapt to actual test and
inspection needs.
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Table A.2 (continued 1) Schedule of Records of 4024A/B/C Spectrum Analyzer
S/N

5

6

Inspection item

8

±15.90

MHz

7.0GHz (frequency span 50MHz) :

±1.03

Frequency reading

MHz

7.0GHz (frequency span 500MHz):

±10.30

accuracy

kHz

8.0GHz (frequency span 500kHz) :

±16.70

MHz

8.0GHz (frequency span 50MHz) :

±1.03

MHz

8.0GHzfrequency span 500MHz):

±10.30

/

1kHz

±2.0%

/

10kHz

±2.0%

/

100kHz

±2.0%

/

1MHz

±2.0%

/

10MHz

±2.0%

/

100MHz

±2.0%

/

1GHz

±2.0%

/

10μs~600s（zero span）

/

1ms

±2.0%

/

10ms

±2.0%

/

100ms

±2.0%

/

1s

±2.0%

/

10s

±2.0%

/

10MHz

±10.0%

/

3MHz

±10.0%

/

1MHz

±10.0%

/

300kHz

±10.0%

/

100kHz

±10.0%

/

30kHz

±10.0%

/

10kHz

±10.0%

/

3kHz

±10.0%

/

1kHz

±10.0%

Span accuracy

Sweep
time

Accuracy

Resolution bandwidth
accuracy

dB

10MHz

±1.20

dB

3MHz

±1.20

dB

1MHz

±1.20

dB

300kHz

±1.20

/

100kHz

Reference

dB

30kHz

±1.20

dB

10kHz

±1.20

dB

3kHz

±1.20

dB

1kHz

±1.20

dB

300Hz

±1.20

BandwidthConversion
uncertainty
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Test result

7.0GHz (frequency span 500kHz) :

Resolution
9

Standards

kHz

Range

7

Unit

Appendix A Performance Characteristic Test Results

Table A.2 (continued 2) Schedule of Records of 4024A/B/C Spectrum Analyzer
S/N

9

10

11

12

13

14

Inspection item

Standards

Inspection

dB

100Hz

±1.20

Resolution

dB

30Hz

±1.20

BandwidthConversion

dB

10Hz

±1.20

uncertainty

dB

3Hz

±1.20

dB

1Hz

±1.20

dBc/Hz

+10kHz

≤-108

dBc/Hz

-10kHz

≤-108

dBc/Hz

+100kHz

≤-112

Sideband noise

dBc/Hz

-100kHz

≤-112

(carrier 1GHz)

dBc/Hz

+1MHz

≤-118

dBc/Hz

-1MHz

≤-118

dBc/Hz

+10MHz

≤-129

dBc/Hz

-10MHz

≤-129

dBm

2MHz~10MHz（Pre-amplifier On）

≤-150

dBm

10MHz~3GHz（Pre-amplifier On）

≤-160

Display average noise

dBm

3GHz~9GHz（Pre-amplifier On）

≤-157

level

dBm

2MHz~10MHz（Pre-amplifier Off）

≤-135

dBm

10MHz~3GHz（Pre-amplifier Off）

≤-140

dBm

3GHz~9GHz（Pre-amplifier Off）

≤-138

dBc

<1.2GHz

<-65

Second harmonic

dBc

1.2GHz~2GHz

<-65

distortion

dBc

2GHz~2.6GHz

<-65

dBc

2.6GHz~4.5GHz

<-65

dBm

50MHz~2.4GHz

≥+10

3-order

dBm

2.4GHz~4GHz

≥+10

intermodulation

dBm

4GHz~5.2GHz

≥+10

dBm

5.2GHz~9GHz

≥+10

dBm

50MHz~2.4GHz

≥+2

dBm

2.4GHz~4GHz

≥+2

dBm

4GHz~5.2GHz

≥+2

dBm

5.2GHz~9.0GHz

≥+2

dBc

Image frequency 8680.5MHz

<-65

dBc

Image frequency 2280.5MHz

<-65

dBc

Image frequency 6980.5MHz

<-65

dBc

Image frequency 3780.5MHz

<-65

5GHz

dBc

Image frequency 5280.5MHz

<-65

7GHz

dBc

Image frequency 7280.5MHz

<-65

1dB gain compression

Image,

2GHz

multiple
15

Unit

and

3.5GHz

out-of-band
response
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Table A.2 (continued 3) Schedule of Records of 4024A/B/C Spectrum Analyzer
S/N

Inspection item

16

Residual response

Range

17

Referenc
e level

Convers
ion error

18

19

198

Scale fidelity

Total level
uncertainty

Unit

Standards

Inspection result

dBm

10MHz~9GHz（Pre-amplifier On）

≤-95

dBm

10MHz~9GHz（Pre-amplifier Off）

≤-82

/

Log type：-120dBm~+30dBm，1dB step
Linear scale: 22.36uV~7.07V，0.1% step

/

0dBm

Reference

dB

-10dBm

±1.20

dB

-20dBm

±1.20

dB

-30dBm

±1.20

dB

-40dBm

±1.20

dB

-50dBm

±1.20

dB

-60dBm

±1.20

dB

-10dBm

±1.00

dB

-20dBm

±1.00

dB

-30dBm

±1.00

dB

-40dBm

±1.00

dB

-50dBm

±1.00

dB

-60dBm

±1.00

dB

50MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

50MHz（Atten 10dB，Input power -25dBm）:

±1.80

dB

50MHz（Atten 20dB，Input power -25dBm）:

±1.80

dB

50MHz（Atten 30dB，Input power -5dBm）:

±1.80

dB

2000MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

2000MHz（Atten 10dB，Input power -25dBm）:

±1.80

dB

2000MHz（Atten 20dB，Input power -25dBm）:

±1.80

dB

2000MHz（Atten 30dB，Input power -5dBm）:

±1.80

dB

3000MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

3000MHz（Atten 10dB，Input power -25dBm）:

±1.80

dB

3000MHz（Atten 20dB，Input power -25dBm）:

±1.80

dB

3000MHz（Atten 30dB，Input power -5dBm）:

±1.80

dB

4000MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

4000MHz（Atten 10dB，Input power -25dBm）:

±1.80

dB

4000MHz（Atten 20dB，Input power -25dBm）:

±1.80

dB

4000MHz（Atten 30dB，Input power -5dBm）:

±1.80

dB

5000MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

5000MHz（Atten 10dB，Input power -25dBm）:

±1.80

dB

5000MHz（Atten 20dB，Input power -25dBm）:

±1.80

dB

5000MHz（Atten 30dB，Input power -5dBm）:

±1.80

dB

6000MHz（Atten 0dB，Input power -25dBm）:

±1.80

Appendix A Performance Characteristic Test Results

Table A.2 (continued 4) Schedule of Records of 4024A/B/C Spectrum Analyzer
S/N

19

Inspection item

Unit

Standards

Inspection result

dB

6000MHz（Atten 10dB，Input power -25dBm）:

±1.80

dB

6000MHz（Atten 20dB，Input power -25dBm）:

±1.80

dB

6000MHz（Atten 30dB，Input power -5dBm）:

±1.80

dB

7000MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

7000MHz（Atten 10dB，Input power -25dBm）:

±1.80

dB

7000MHz（Atten 20dB，Input power -25dBm）:

±1.80

dB

7000MHz（Atten 30dB，Input power -5dBm）:

±1.80

dB

8500MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

8500MHz（Atten 10dB，Input power -25dBm）:

±1.80

dB

8500MHz（Atten 20dB，Input power -25dBm）:

±1.80

dB

8500MHz（Atten 30dB，Input power -5dBm）:

±1.80

dB

350MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

650MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

950MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

1250MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

1550MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

1850MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

2150MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

2450MHz（Atten 0dB，Input power -25dBm）:

±1.80
±1.80

dB

2750MHz（Atten 0dB，Input power -25dBm）:

Total level

dB

3050MHz（Atten 0dB，Input power -25dBm）:

±1.80

uncertainty

dB

3350MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

3650MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

3850MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

4150MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

4450MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

4750MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

5050MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

5350MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

5650MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

5850MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

6150MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

6450MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

6750MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

7050MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

7350MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

7650MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

7850MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

8150MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

8450MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

8750MHz（Atten 0dB，Input power -25dBm）:

±1.80

dB

9000MHz（Atten 0dB，Input power -25dBm）:

±1.80
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Table A.2 (continued 5) Schedule of Records of 4024A/B/C Spectrum Analyzer
S/N

Inspection item

21

22

Inspection result

0~30dB，5dB Step

/

0dB Attenuation

Reference

dB

5dB Attenuation

±1.20

Switching

dB

10dB Attenuation

±1.20

uncertainty

dB

15dB Attenuation

±1.20

（50MHz）

dB

20dB Attenuation

±1.20

Atte

dB

25dB Attenuation

±1.20

nuat

dB

30dB Attenuation

±1.20

or

/

0dB Attenuation

Reference

dB

5dB Attenuation

±1.20

Switching

dB

10dB Attenuation

±1.20

uncertainty

dB

15dB Attenuation

±1.20

（6GHz）

dB

20dB Attenuation

±1.20

dB

25dB Attenuation

±1.20

dB

30dB Attenuation

±1.20

Input voltage

/

10MHz~5.2GHz

≤2.00：1

Standing wave ratio

/

5.2GHz~9GHz

≤2.00：1

Maximum safety

/

input level

23

Display scale

24

Video Bandwidth
RF

/

Inter
face

+27dBm (automatic coupling of CW and input attenuator)
0.1-10dB per division, with the minimum step of 0.1dB(10
division display)

/
/

interface

25

Standards

/

Range

20

Unit

Bandwidth range: 1Hz10MHz (step: 1-3-10)
type

N (f)

Communica

/

USB interface：A type，two

tion

/

USB interface：mini type，one

Interface

/

LAN interfce：RJ45 type

Freq. Ref.

/

10MHz Input/Output port，BNC(f) type

/

GPS interface：BNC(f) type

/

Trig IN interface：BNC(f) type

/

IF Output interface：BNC(f) type

/

Anti-eletric strength AC 1500V，10mA/min；no breakdown、

others

no flashover。
26

Safety

/

242V，leakage Current：≤3.5mA，1min。
Insulation resistance between power in port and case must

/

not below100MΩ in standard atmospheric pressure and
below 2MΩ in wet environment.

1. “√” indicates that the function is normal or complies with the requirements, while “X” indicates that the function
Descript
ion

is abnormal or does not comply with the requirements
2. “/” indicates that the item is not tested.

Comprehensive judgment: Qualified □ Disqualified□
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Table A.3 Schedule of Records of 4024 Spectrum Analyzer (tracking Generator option)
S/N

Inspection item

1

frequency Range

2

3

4

5

frequency accuracy

Unit

Standards

Inspection result

kHz

Lower limit

100kHz

GHz
Hz

Upper limit
100MHz

Upper limit of frequency
±80.00

kHz

1000MHz

±0.80

kHz

2000MHz

±1.60

kHz

4000MHz

±3.20

kHz

6000MHz

±4.80

kHz

9000MHz

±7.20

dBc/Hz

+10kHz

≤-90

dBc/Hz

-10kHz

≤-90

Sideband noise

dBc/Hz

+100kHz

≤-95

(carrier 1GHz)

dBc/Hz

-100kHz

≤-95

dBc/Hz

+1MHz

≤-110

dBc/Hz

-1MHz

≤-110

amplitude

Range

Amplitude accuracy

/

Range :0dBm~-40dBm， with the minimum resolution of
0.1dB

dB

50MHz，0dBm out

±2.50

dB

50MHz，-5dBm out

±2.50

dB

50MHz，-10dBm out

±2.50

dB

50MHz，-20dBm out

±2.50

dB

50MHz，-30dBm out

±2.50

dB

50MHz，-40dBm out

±2.50

dB

1200MHz，0dBm out

±2.50

dB

1200MHz，-5dBm out

±2.50

dB

1200MHz，-10dBm out

±2.50

dB

1200MHz，-20dBm out

±2.50

dB

1200MHz，-30dBm out

±2.50

dB

1200MHz，-40dBm out

±2.50

dB

2000MHz，0dBm out

±2.50

dB

2000MHz，-5dBm out

±2.50

dB

2000MHz，-10dBm out

±2.50

dB

2000MHz，-20dBm out

±2.50

dB

2000MHz，-30dBm out

±2.50

dB

2000MHz，-40dBm out

±2.50

dB

4000MHz，0dBm out

±2.50

dB

4000MHz，-5dBm out

±2.50

dB

4000MHz，-10dBm out

±2.50
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Table A.3 (continued 1) Schedule of Records of 4024 Spectrum Analyzer (tracking Generator option)
S/N

5

6

202

Inspection item

amplitude accuracy

harmonic distortion

Unit

Standards

Inspection result

dB

4000MHz，-20dBm out

±2.50

dB

4000MHz，-30dBm out

±2.50

dB

4000MHz，-40dBm out

±2.50

dB

6000MHz，0dBm out

±2.50

dB

6000MHz，-5dBm out

±2.50

dB

6000MHz，-10dBm out

±2.50

dB

6000MHz，-20dBm out

±2.50

dB

6000MHz，-30dBm out

±2.50

dB

6000MHz，-40dBm out

±2.50

dB

7500MHz，0dBm out

±2.50

dB

7500MHz，-5dBm out

±2.50

dB

7500MHz，-10dBm out

±2.50

dB

7500MHz，-20dBm out

±2.50

dB

7500MHz，-30dBm out

±2.50

dB

7500MHz，-40dBm out

±2.50

dB

9000MHz，0dBm out

±2.50

dB

9000MHz，-5dBm out

±2.50

dB

9000MHz，-10dBm out

±2.50

dB

9000MHz，-20dBm out

±2.50

dB

9000MHz，-30dBm out

±2.50

dB

9000MHz，-40dBm out

±2.50

dBc

100MHz，0dBm out

<-15

dBc

900MHz，0dBm out

<-15

dBc

1500MHz，0dBm out

<-25

dBc

2000MHz，0dBm out

<-25

dBc

4000MHz，0dBm out

<-25

dBc

6000MHz，0dBm out

<-15

dBc

8000MHz，0dBm out

<-15

